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Symbols and definitions

Documentation symbols

A

WARNING The warning statements in this manual identify conditions or practices that
could lead to illness, injury, or death. Warning statements appear with a grey background in
a black and white document.

A

CAUTION The caution statements in this manual identify conditions or practices that could
result in damage to the equipment or other property, or loss of data. This definition applies
to both yellow and black and white symbols.

7d

welchallyn.com

Follow instructions/directions for use (DFU) -- mandatory action.
A copy of the DFU is available on this website.

A printed copy of the DFU can be ordered from Welch Allyn for delivery within 7 calendar
days.

Power symbols

0

Power button ! Equipotential ground

(on the display) Power plug : : Battery absent or faulty

(on the monitor, green indicator) Battery charge level
Alternating Current power
present, battery fully charged

(on the monitor, amber Battery
indicator) Alternating Current D

power present, battery is

charging

| @] @] R

Alternating Current (AC) - Rechargeable battery
{+ <4
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Rated power input, DC

Rated power input, AC

Li-ion

Lithium-ion battery

Direct current (DC)

Connectivity symbols

o

Bluetooth®

Ethernet RJ-45

<

uSB

Nurse call

Wireless signal strength
Best (4 bars)

Good (3 bars)

Fair (2 bars)

Weak (1 bar)

No signal (no bars)
No connection (blank)

Miscellaneous symbols

!

Manufacturer

>

Defibrillation-proof Type BF
applied parts

Product Identifier

Serial number

Reorder number

XX

©|

China RoHS markings for control
of pollution caused by electronic
information products. XX
indicates Environmentally
Friendly Use Period in years.

Do not reuse

Recycle the product separate
from other disposables

Nonionizing electromagnetic
radiation

“ | 13

Call for maintenance
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_’Y\_ Light below Rx ONLY Prescription only
FCC ID The identification number ICID Industry Canada identification

assigned by the Federal Trade
Commission

number. The equivalent
governing body to the FCC in the
United States

This end up

—a

Fragile

European Community
Representative

Meets essential requirements of
European Medical Device
Directive 93/42/EEC

IPX1

|P = International Protection
Marking

X =No object ingress rating

1 =Protected against vertically
dripping water

Australian Regulatory
Compliance Mark

Intertek

Intertek ETL Listed Mark
indicating successful
independent safety testing

Recycle

Temperature range

Global Trade Identification
Number

e | S

Stacking limit by number

Keep dry

95%

15%

Humidity range

Screen symbol

Process indicator for activities like acquiring measurements and

connecting to a laptop
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Safety

All users of the monitor must read and understand all safety information presented in
this manual before using or repairing the monitor.

United States federal law restricts this device to sale, distribution, or use by or on the
order of a licensed medical practitioner.

Warnings and cautions

VAN

AN
AN
AN

> B

WARNING Safety risk. Make frequent electrical and visual checks on
cables, sensors, and electrode wires. All cables, sensors, and electrode
wires must be inspected and properly maintained and in proper working
order to allow the equipment to function properly and to protect patients.

WARNING Safety risk. Place the monitor and accessories in locations
where they cannot harm the patient should they fall from a shelf or mount.

WARNING Fire and explosion hazard. Do not operate the monitor in the
presence of a flammable anesthetic mixture with air, oxygen, or nitrous
oxide; in oxygen-enriched environments; or in any other potentially
explosive environment.

WARNING Inaccurate measurement risk. Dust and particle ingress can
affect the accuracy of blood pressure measurements. Use the monitor in
clean environments to ensure measurement accuracy. |f you notice dust or
lint build-up on the monitor’s vent openings, have the monitor inspected
and cleaned by a qualified service technician.

WARNING Defective batteries can damage the monitor. If the battery
shows any signs of damage or cracking, it must be replaced immediately
and only with a battery approved by Welch Allyn.

CAUTION Before disassembling the device or installing options,
disconnect the patient from the monitor, power down the device, and
disconnect the AC power cord and any attached accessories (for example,
SpO2 sensors, blood pressure hoses and cuffs, and temperature probes)
from the device.

CAUTION To ensure that the monitor meets its performance
specifications, store and use the monitor in an environment that maintains
the specified temperature and humidity ranges.
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& CAUTION The monitor may not function properly if dropped or damaged.
Protect it from severe impact and shock. Do not use the monitor if you
notice any signs of damage.

& CAUTION Do not connect more than one patient to a monitor or connect
more than one monitor to a patient.

& CAUTION Do not operate the monitor in the presence of magnetic
resonance imaging (MRI) or hyperbaric chambers.

General safety considerations

e |f the monitor detects an unrecoverable problem, it displays an error message. For
more information, see “Troubleshooting.”

e To ensure patient safety, use only accessories recommended or supplied by Welch
Allyn. (See the accessories list in the Appendix of the Directions for use or http://
www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-
devices.html.) Always use accessories according to your facility’s standards and
according to the manufacturer’'s recommendations and instructions. Always follow
the manufacturer’s directions for use.

¢ Welch Allyn recommends that only Welch Allyn service personnel or an authorized
repair center perform warranty service. Performing unauthorized service on a device
that is within warranty may void the warranty.

Electrostatic discharge (ESD)

A
Aia\

CAUTION ATTENTION

SENSITIVE ELECTRONIC DEVICES OBSERVE PRECAUTIONS

DO NOT SHIP OR STORE NEAR STRONG FOR HANDLING
ELECTROSTATIC, ELECTROMAGNETIC, ELECTROSTATIC
MAGNETIC OR RADIOACTIVE FIELDS. SENSITIVE DEVICES

& CAUTION Electrostatic discharge (ESD) can damage or destroy electronic
components. Handle static-sensitive components only at static-safe
workstation.

& CAUTION Assume that all electrical and electronic components of the
monitor are static-sensitive.

Electrostatic discharge is a sudden current flowing from a charged object to another
object or to ground. Electrostatic charges can accumulate on common items such as
foam drinking cups, cellophane tape, synthetic clothing, untreated foam packaging
material, and untreated plastic bags and work folders, to name only a few.

Electronic components and assemblies, if not properly protected against ESD, can be
permanently damaged or destroyed when near or in contact with electrostatically
charged objects. When you handle components or assemblies that are not in protective
bags and you are not sure whether they are static-sensitive, assume that they are static-
sensitive and handle them accordingly.

e Perform all service procedures in a static-protected environment. Always use
techniques and equipment designed to protect personnel and equipment from
electrostatic discharge.


http://www.welchallyn.com
http://www.welchallyn.com
http://www.welchallyn.com
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Remove static-sensitive components and assemblies from their static-shielding bags
only at static-safe workstations—a properly grounded table and grounded floor mat—
and only when you are wearing a grounded wrist strap (with a resistor of at least 1
megohm in series) or other grounding device.

Use only grounded tools when inserting, adjusting, or removing static-sensitive
components and assemblies.

Remove or insert static-sensitive components and assemblies only with monitor
power turned off.

Insert and seal static-sensitive components and assemblies into their original static-
shielding bags before removing them from static-protected areas.

Always test your ground strap, bench mat, conductive work surface, and ground
cord before removing components and assemblies from their protective bags and
before beginning any disassembly or assembly procedures.
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Overview

Purpose and scope

This service manual is a reference for periodic preventive maintenance and corrective
service procedures for the Welch Allyn Connex Spot Monitor. It is intended for use only
by trained and qualified service personnel.

Corrective service is supported to the level of field-replaceable units. These include
circuit-board assemblies and some subassemblies, case parts, and other parts.

& WARNING When performing a service procedure, follow the instructions
exactly as presented in this manual. Failure to do so could damage the
monitor, invalidate the product warranty, and lead to serious personal
injury.

& CAUTION No component-level repair of circuit boards and subassemblies
is supported. Use only the repair procedures described in this manual.

Find instructions for functional testing and performance verification in the Welch Allyn
Service Tool help files.

This manual applies only to this device. For servicing of any other vital signs monitor, see
the service manual for the specific device.

Service work not described in this manual must be performed by qualified service
personnel at the factory or at an authorized Welch Allyn service center.

Related documents

When using this manual, refer to the following:
e Connex® Spot Monitor Directions for use (on the user documentation CD)

e Welch Allyn Service Tool:
http://www.welchallyn.com/en/service-support/service-center/service-tool.html

e Welch Allyn Service Tool Installation and configuration guide:
http://www.welchallyn.com/en/service-support/service-center/service-tool.html

e Welch Allyn Braun ThermoScan® PRO 6000 Themometer Directions for use CD
e Welch Allyn Braun ThermoScan® PRO 6000 Charging Station Directions for use CD
e Welch Allyn 9600 Plus Calibration Tester Directions for use

e Welch Allyn website: http://www.welchallyn.com



http://www.welchallyn.com
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Technical support services

Welch Allyn offers the following technical support services:
e Telephone support

e |oaner equipment

e Service agreements

e Service training

¢ Replacement service parts

e Product service

For information on any of these services, go to this site:

http:// www.welchallyn.com/en/service-support.html.

Service loaners

For warranty or non-warranty repairs not covered under a support agreement, loaners are
available for a nominal charge, subject to availability. Payment is required prior to
shipment for all loaners not covered under a support agreement. The loaner fee can be
found on the Welch Allyn loaner price list.

Welch Allyn Service Centers that provide repair service for this product can, on request,
loan a device for use while the device is being repaired. Loaned devices are provided
free of charge for products repaired while under a support agreement that includes a
free loaner provision.

Service options

Partners in Care service agreements

While product warranties provide basic assurance of Welch Allyn hardware quality, they
may not include the full range of services and support you need. Welch Allyn offers
premium service and support through our Partners in Care program. Whether you
service your own devices and require a minimum of support or rely on us to service your
device, Welch Allyn provides a program that will meet your needs. For more information
visit our web site at http://www.welchallyn.com/en/service-support.html or call your
sales representative.

Warranty service

All repairs on products under warranty must be performed or approved by Welch Allyn.
Refer all warranty service to Welch Allyn Product Service or another authorized Welch
Allyn Service Center. Obtain a Return Material Authorization (RMA) number for all returns
to Welch Allyn Product Service from our website:

http://www.welchallyn.com/en/service-support/submit-a-repair.html.

& CAUTION Unauthorized repairs will void the product warranty.



http:// www.welchallyn.com/en/service-support.html
http://www.welchallyn.com
http://www.welchallyn.com
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Non-warranty service

Welch Allyn Product Service Centers and Authorized Service Providers support non-
warranty repairs. Contact any Welch Allyn regional service center for pricing and service
options.

Welch Allyn offers modular repair parts for sale to support non-warranty service. This
service must be performed only by qualified end-user biomedical/clinical engineers using
this service manual.

Service training is available from Welch Allyn for biomedical/clinical engineers. For
information, go to this site:

http://www.welchallyn.com/en/service-support/partners-in-care/education-services/
technical-training.html.

Repairs

A Welch Allyn Service Center or Authorized Service Provider must perform all repairs on
products under warranty unless you are a properly certified technician that has
successfully completed a Welch Allyn Technical Training course. More information on
Technical Training can be obtained from your sales representative or by visiting http://
www.welchallyn.com/en/service-support/partners-in-care/education-services/technical-

training.html.

& CAUTION Unauthorized repairs will void the product warranty.

Qualified service personnel or a Welch Allyn Service Center should repair products out of
warranty.

If you are advised to return a product to Welch Allyn for repair or routine maintenance,
schedule the repair with the service center nearest you.

Welch Allyn Technical Support

If you have a problem with the device that you cannot resolve, call the Welch Allyn
Technical Support Center nearest you for assistance. A representative will assist you in
troubleshooting the problem and will make every effort to solve the problem over the
phone, potentially avoiding an unnecessary return.

If your product requires warranty, extended warranty, or non-warranty repair service, a
Welch Allyn Technical Support representative will record all necessary information to
issue an RMA number. The support representative will provide you with the address of
the Welch Allyn Service Center to send your device to.

Technical support is available during local business hours.

Returning products

When returning a product to Welch Allyn for service, ensure that you have the following
information:

¢ Product name, model number, and serial number. This information may be found on
the product and serial number labels on the back housing.


http://www.welchallyn.com/support/technical/monitoring_suppt_training.htm
http://www.welchallyn.com/support/technical/monitoring_suppt_training.htm
http://www.welchallyn.com/support/technical/monitoring_suppt_training.htm
http://www.welchallyn.com/support/technical/monitoring_suppt_training.htm
http://www.welchallyn.com/support/technical/monitoring_suppt_training.htm
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éﬂﬂﬂﬂﬂﬂﬂ;

e A complete return shipping address.
e A contact name and phone number.
e Any special shipping instructions.

e A purchase-order number or credit-card number if the product is not covered by a
warranty.

e Afull description of the problem or service request.

1. Obtain an RMA number. Either contact Welch Allyn and request an RMA number or
visit us on the web:

http://www.welchallyn.com/en/service-support/submit-a-repair.html.

Note Welch Allyn does not accept returned products without an
RMA.

2. Ship the device to Welch Allyn, observing these packing guidelines:

a. Remove from the package the battery, all hoses, connectors, cables, sensors,
power cords, and other ancillary products and equipment, except those items
that might be associated with the problem.

Recommendations for returning Lithium-ion batteries
e Use ground transportation to return batteries.
e If returning multiple batteries, package each battery individually.
¢ Do not consolidate multiple batteries in a single package.
e Use packaging provided by Welch Allyn or the battery manufacturer.
¢ Do not pack a defective battery in checked or carry-on baggage if traveling
by air.
Packaging

e If you return the battery with the device, remove the battery, seal the battery
in an antistatic plastic bag, and place the battery in the position reserved for
the battery near the device in the original shipping carton.

e |f you return the battery separately, package the battery in the replacement
battery’s plastic bag and shipping box.


http://www.welchallyn.com/customer-self-service.htm

Service manual Overview 13

If the original shipping carton or replacement battery shipping box is unavailable,
consult the manufacturer website for information about shipping Lithium-ion
batteries:

http://www.iccnexergy.com/regulatory-updates/lithium-shipping

& WARNING Safety risk. Do not ship any battery that has
been physically damaged or shows signs of leakage
unless you receive specific instructions which meet the
requirements for the shipment of Lithium-ion batteries.
Dispose of damaged or leaking batteries in an
environmentally safe manner consistent with local
regulations.

Note In the United States, the applicable regulations can be
found in the Code of Federal Regulations (CFR). Refer to
49 CFR 173.185 for shipping Lithium-ion batteries by air
or ground. Use 49 CFR 172.102 sections A54 and A101
to find the special provisions for shipping Lithium-ion
batteries.

b. Clean the device.

Note To ensure safe receipt of your device by the service
center and to expedite processing and return of the
device to you, thoroughly clean all residues from the
device before you ship it to Welch Allyn. For
decontamination and cleaning requirements, see the
appendices.

If a returned device is found to be contaminated with
bodily fluids, it will be returned at the owner's expense.
United States federal regulations prohibit the processing
of any device contaminated with blood-borne pathogens.
Welch Allyn thoroughly cleans all returned devices on
receipt, but any device that cannot be adequately
cleaned cannot be repaired.

c. Putthe device, enclosed in a plastic bag with a packing list, into the original
shipping carton with the original packing materials or into another appropriate
shipping carton.

d. Write the Welch Allyn RMA number with the Welch Allyn address on the outside
of the shipping carton.


http://www.iccnexergy.com/regulatory-updates/lithium-shipping/
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Recommended service intervals

To confirm that the device is functioning within the design specifications, perform
periodic service as indicated in the following table. Customers who have the Standard
unlicensed edition of the Welch Allyn Service Tool can perform the basic functional
verification and calibration procedures referenced in the table by following the
instructions in this manual.

Component Service interval Service procedure
NIBP module Annually Basic functional verification
Sp02 module Annually Basic functional verification
SureTemp Plus Annually Basic functional verification
Braun ThermoScan PRO 6000 Annually’ Basic functional verification
Battery Annually? Replace the battery

1 In addition to this annual service interval, Welch Allyn recommends cleaning the contacts of the Braun thermometer
and dock every 4 months because debris that accumulates in the contacts can interfere with data transmission. See
"Clean the Braun ThermoScan PRO 6000 contacts” later in this manual.

2 Battery performance is a function of clinical use and charge/discharge patterns. Welch Allyn recommends replacing
the battery after 1 year or when its remaining capacity no longer meets workflow requirements

If you have the Gold edition of the service tool, use the tool to perform a complete
functional verification and calibration of the device in lieu of performing the basic tests.
Perform a complete functional verification and calibration of the device whenever any of
the following conditions exist:

e The device does not meet specifications (based on the basic functional verification)
e The device has been dropped or otherwise damaged

e The device is malfunctioning

e The case has been opened

e Aninternal part has been replaced (battery excluded)

Note For instructions on using the Gold edition, see the Service Tool help files.

Maintenance

For device maintenance information, see “Maintenance and service” in the device's
directions for use. This section covers the following topics:

e Perform periodic checks

e Replace the monitor battery

¢ Replace the APM work surface battery
e (Cleaning requirements

Note Service-related cleaning is addressed in the service manual as well.
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The Welch Allyn Service Tool

The Welch Allyn Service Tool is available in the following editions:

Standard unlicensed: Accompanies your device.

Gold: Required to perform complete functional verification and calibration. This
edition requires an additional license. For more information about acquiring this
license, contact Welch Allyn.

Note To qualify for the Gold license, you must attend the
Welch Allyn technical training course or complete online
training for the device.

Clinicians and technical service personnel can use the service tool to manage and
maintain supported Welch Allyn products. You can use the service tool to do the
following:

Review device information. \When connected to the device, the service tool lists
installed modules, installed firmware and hardware versions, warranty and repair
information, status, and usage history.

Receive notifications when periodic maintenance is needed. The service tool can
help you manage and maintain your entire inventory of supported Welch Allyn
products. Through the remote service function, the service tool can connect to
Welch Allyn Customer Service. With this functionality you can automatically receive
firmware updates and feature upgrades for your supported products, including
software upgrades for the service tool.

Install updates and upgrades. The service tool can read the firmware version for
each module and check for available updates or upgrades.

Note For the Welch Allyn Service Tool to support updates and
upgrades, adjust your firewall settings to permit access for
IP address 169.254.10.10 (the local feed server for the
software upgrade process).

Create a work list. The work list provides information about service actions—
referred to as work orders—that are waiting for you to perform on your maintained
devices. Work orders may include periodic calibrations, upgrades, or license
installations.

Schedule periodic maintenance. You can use the service tool to set the service
interval for each maintained device.

View and save logs. You can download and save log files from the device for
analysis to help diagnose and identify reported issues.

Create user accounts. Administrators can create user accounts and set permission
levels to control access to the features, allowing one group to perform administrative
tasks and another to perform service tasks. Restricting access prevents the service
tool from being used to make unauthorized changes on a connected device.

Perform functional verification and calibration. The service tool can check any
device requiring calibration and, if necessary, calibrate the device to match the
design specifications. This feature is not supported for all products and requires the
service tool, Gold edition, for each supported product.

Recover devices. In the rare case where a device can no longer boot because of
corrupted firmware, the service tool can connect the device to Welch Allyn Technical
Support to reinstall the firmware.
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e Extensible. The service tool software accepts new plug-ins to support future Welch
Allyn products.

Some of these features are enabled for any user (Standard unlicensed edition). Others
require special user account privileges or a Welch Allyn service contract (Gold edition). If
you require gold-level support for a Welch Allyn product, please contact Welch Allyn
technical support.

Battery performance

About the batteries

The device uses a rechargeable, 2-cell, Lithium-ion smart battery supplemented by an
optional, rechargeable, 9-cell Lithium-ion battery in the Accessory Power Management
(APM) work surface. Internal circuitry enables the batteries to report their condition to
the device and the APM work surface. The device displays the battery status via the LED
power indicator, icons on the screen, and status messages appearing in the Device
Status area of the display. The APM battery indicates the percent of total charge to user
on the front of the work surface as follows:

Number of LEDs Percent of total charge
1 0-19

2 20-39

3 40 -59

4 60-79

5 80-95

6 96 —-100

The battery status indicator on the device displays the remaining total charge of both
batteries combined if the configuration has both an internal battery and an extended
battery in the APM.

Battery information may be collected using the service tool.

New batteries are shipped from the manufacturer with a 40 percent charge to extend
shelf life. After installing a new battery in the device, you must plug the device into AC
power to wake up the battery. If AC power is not applied to the device, the new battery
appears discharged.

The Device Status area displays a low-battery status message when 30 minutes of
power remain and again when 5 minutes remain. The 30-minute message is a very low
priority technical alarm. The alarm message appears on a cyan background in the Device
Status area. This alarm is dismissable by the user, and all functions of the device remain
available. The 5-minute message is a high priority technical alarm that appears on a red
background in the Device Status area, is not dismissable, and prevents acquiring vitals
measurements or performing any other function until the device is plugged in to AC
power.
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If AC power is not applied to the device after it triggers the high priority technical alarm,
the device will shut down at or close to 0 minutes of remaining battery charge.

Battery charging is provided by the device's internal power supply. The power reserve
threshold is determined by the device's software.

For a complete list of battery specifications, see the device's directions for use.

Best practices

The following practices help to extend the life of the battery and the device.

& WARNING Safety risk. When handling and storing Lithium-ion batteries:
Avoid mechanical or electrical abuse. Batteries may explode or cause burns
if disassembled, crushed, or exposed to fire or high temperatures. Do not
short or install with incorrect polarity.

Whenever possible, keep the monitor plugged in to charge the battery.
Remove the battery when storing the device for an extended amount of time.
Replace batteries that trigger a low battery status message when fully charged.
Do not use damaged or leaking batteries.

Store batteries with a 30 to 50 percent charge.

Store batteries within the temperature range indicated for each period:

©  For storage less than 30 days: Maintain temperature between —4 °F and 122 °F
(=20 °C and 50 °C).

©  For storage between 30 days and 90 days: Maintain temperature between -4 °F
and 104 °F (=20 °C and 40 °C).

O For storage more than 90 days up to 2 years: Maintain temperature between —4
°F and 95 °F (=20 °C and 35 °C).

Recycle batteries where ever possible. In the United States call 1-877-723-1297 for
information about recycling your Lithium-ion battery or go to the Call2Recycle
website at http://www.call2recycle.org for additional information.

When recycling is not an option dispose of batteries in an environmentally safe
manner consistent with local regulations.

Factors affecting battery operating time

The following table presents settings and conditions that affect the battery operating
time and recommendations to maximize battery life.

Setting / Condition Recommended setting
Display brightness setting 5
Sleep mode setting 1 minute

Automatic power-down setting 15 minutes
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Controls, indicators, and connectors

Note Your model might not contain all of these features.

Front-Left view

No. Feature Description
1 LCD screen 7" color touchscreen provides a graphical user interface
2 Thermometry Configuration shown features SureTemp module

3 Battery charge and power-up status indicator The LED indicates the charging status when connected to AC
power:
e (Green: The battery is charged
e Amber: The battery is charging
e Flashing: The LED flashes during power-up

4 Power button Blue button on lower-left corner of the monitor
e Powers up the monitor
e Places into Sleep mode, except when an alarm condition is
active (brief press)
e Wakes up the monitor from Sleep mode
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Back-Bottom-Left view

Connex® Spot Monitor

No.

Feature

Description

Battery compartment (behind cover)

Houses the battery (captive screw secures cover to monitor)

2 NIBP Connects NIBP cable to monitor

3 USBclient port Provides a connection to an external computer for testing and
software upgrades

4 USB port Connects APM work surface or any accessory to the monitor

5  Power connection Connects APM work surface or external power supply to the
monitor

6  Ethernet RJ-45 Provides a hardwired connection to the computer network

7 Nurse call Provides a connection to a hospital nurse call system

8  Sp02 Connects chosen Sp02 system to monitor

9 Thermometry Configuration shown features SureTemp module and probe

connection port




Service manual Controls, indicators, and connectors 21

APM

This section applies only to devices with an Accessory Power Management (APM) stand.
The APM is an accessory stand with work surface, power supply for enhanced device
run time, and organizational bins to arrange sensors and cables for available parameters.

Front-Top-Left view

0

No. Feature Description
1 Battery compartment (behind cover) Houses the battery
2 Battery charge status indicator Indicates charge level of battery

3 Light power switch Powers light under APM work surface
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Back-Bottom-Right view

Connex® Spot Monitor

No. Feature Description

1 Printer port Connects a printer (future use)

2 USBports (2) Connect optional accessories

3 USBcable Connects APM work surface to monitor

4 APM power cable Connects APM work surface to monitor

5  Power connection Provides an external AC power connection

6  Ground lug (equipotential terminal) Provided for electrical safety testing and for connecting a
potential-equalization conductor

7 Recess for mounting Secures the APM work surface when it is mounted on the APM
stand (with 4 screws)

8  Battery cover screw Secures the APM work surface battery cover

9 APM light [lluminates accessory bins and path for APM stand
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Advanced settings

Advanced settings provide access to device settings and service menu information with
an access code. This section covers the following primary tabs:

General. Settings for system language as well as date and time, plus open source
software disclosure.

Parameters. Settings for physiological parameters, averaging, and intervals.

Network. Settings for the internal Ethernet and security, as well as WiFi radio and
Bluetooth subsystems.

Service. Settings and features that support installation and on-device
troubleshooting.

Note Changes made in Advanced settings take effect immediately, but they do

not change the configuration file and cannot be used to clone settings from
one device to another. Follow the instructions in "Device configuration and

setup" to create, edit, download, and install any settings you want available
on multiple devices.

Access Advanced settings

Note You cannot access Advanced settings if sensors or physiological alarms are

active or if vital sign measurements are displayed.

From the Home tab, touch the Settings tab.
Touch the Advanced vertical tab.
Enter 6345 as the access code and touch OK.

Note This access code is configurable and could be different at
your location.

The General tab appears.
Perform service tasks by making selections or touching other tabs.

Note Service tasks and how to do them are detailed in this
section.

When you are done, touch Exit.

The Home tab appears.
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General tab

Specify the language

When you first access Advanced settings, the General tab appears, displaying the
Language tab.

1. Select a language.
2. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify profile settings

Profiles support multiple clinical workflows.

the Office profile clears both patient information and current readings. Switching to another

CAUTION Switching from the Office profile drops the Bluetooth connection. Switching to
A profile retains patient information, but current readings are cleared.

1. In Advanced settings, touch the General > Profiles tabs.
2. Specify settings.

Setting Action/Description

Profile types Select the profile types to display: Intervals, Office, and
Spot.

Primary profile Select the primary profile.

Custom profile name If desired, modify the profile names.

3. Touch Apply.
4. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify date and time settings

In Advanced settings, touch the General > Date / Time tabs.
2. Specify settings.

Setting Action/Description

Date format Select a date format for display.

Time zone Displays UTC time zone (read only)

Use Network Time Protocol Enable the monitor to query the correct date and time

from a trusted time server. When enabled, manual date
and time entry on the Settings tab is disabled.

3. Touch Test network connection.

Test results appear for the Time sync test, IP address, and DNS query status.
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4. Touch OK.
5. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Review the open source software disclosure

In Advanced settings, touch the General > Open Source tabs.
2. Read Welch Allyn's disclosure about its use of "free" or "open source" software.
Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Parameters tab

Specify advanced NIBP settings

In Advanced settings, touch the Parameters > NIBP tabs.
2. Specify settings.

Setting Action/Description

Default view Select default primary and secondary views.

Unit of measure Select the NIBP unit of measure for display.

Tube type Select the number of tubes that are connected to the

NIBP cuff that is used with this monitor. If you select 1
tube, the device sets the algorithm to Step,
disabling other options.

Algorithm default Select the default algorithm used to determine NIBP
measurements.

Cuff inflation target Enter a default cuff inflation pressure for each type of
patient.

3. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced temperature settings

In Advanced settings, touch the Parameters > Temperature tabs.
2. Specify settings.
Setting Action/Description

Unit of measure Select primary units of measure for the temperature
display on the Home tab

Display temperature conversion Enable to display primary units of measure and
secondary units of measure for the temperature display
on the Home tah.

3. Do one of the following:
e To continue in Advanced settings, touch another tab.

25
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e To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced averaging interval settings

Averaging intervals are available in the Office profile.

In Advanced settings, touch the Parameters > Averaging tabs.

2. Specify settings.
Setting

NIBP averaging program

Readings to average

Delay to start (minutes)

Time between (minutes)

Keep if + or — (mmHg)

Summary display box

3. Do one of the following:

Action/Description

Select the averaging program to view or modify. You can
change the name of the averaging program.

Select which readings in a series to use for averaging
(and the number of readings to average as a result).

Enter the number of minutes to wait before the
averaging program starts (after touching "Start
intervals") and the start of the first reading.

Enter the number of minutes to wait between readings.

Enter the range that the program uses as criteria to
accept or reject readings and establish the baseline
reading. For more information about how this setting
affects the program, refer to the section "Excluded
readings" below.

Displays currently selected settings.

e To continue in Advanced settings, touch another tab.

e To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced program interval settings

In Advanced settings, touch the Parameters > Program tabs.

2. Specify settings.
Setting

Program

Intervals

3. Do one of the following:

Action/Description

Select the program to view or modify. You can change
the name of the program.

Specify up to five sets of interval readings for this
program. For each set, specify the number of minutes
between interval readings and the number of times that
each interval should run (repetitions) before proceeding
to the next set.

e To continue in Advanced settings, touch another tab.

e To exit Advanced settings and return to the Home tab, touch Exit.

Network tab

Specify radio settings

This task is applicable only to monitors that have a wireless radio installed. Devices can
be configured with a wireless or a Bluetooth radio.
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1. In Advanced settings, touch the Network > Radio tabs.

2. Specify settings.
Setting

Enable radio
ESSID

Radio mode

Dynamic Frequency Selection

Enable radio network alarms

Roaming

Regulatory
Update radio

3. Do one of the following:

Action/Description

Enable the radio for WiFi communications. When
disabled, the radio is not available.

Enter the service set identifier (SSID) for the enterprise.
Enter a maximum of 16 characters.

Select the radio band.

Enable to allow the site to transmit data on changing
frequencies for added security. This option applies most
frequently to military or government enterprises.

Activate radio network alarms when an wireless dropout
alarm condition occurs. When disabled, radio network
alarms are not available.

Select the type of roaming (only available with WPA/
WPA2 Enterprise).

Display the WiFi regulatory certification information.

Touch Update radio to activate all new radio
settings not selected previously.
Touch OK in the confirmation popup.

Note None of the changed radio settings
take effect until you touch Update radio.

e To continue in Advanced settings, touch another tab.

e To exit Advanced settings and return to the Home tab, touch Exit.

Specify security settings

1. In Advanced settings, touch the Network > Security tabs.

2. Select the encryption method to secure data transfer from the device.

Note Network server certificates are required for all EAP security
options. Use the Welch Allyn Service Tool to load these

certificates.

3. Specify settings.
Setting
Authentication type

WEP 64

WEP 128

WPA-Personal and WPA2-Personal

Action/Description

Select the preferred encryption option. Then specify any
additional settings that appear. The default is Open or
no encryption.

Select a WEP key and then enter a 10-character key in
the selected field. Repeat this process to create multiple
WEP keys. Then click Update radio.

Select a WEP key and then enter a 10-character key in
the selected field. Repeat this process to create multiple
WEP keys. Then click Update radio.

Enter a Passphrase (8 to 63 characters). The characters
you enter appear as asterisks. Then click Update
radio.
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WPA-Enterprise and WPA2-Enterprise

Anonymous identity

User name

Password

Enable server validation
EAP type

Option

Update radio

4. Do one of the following:

Connex® Spot Monitor

Specify the following settings and then click Update
radio.

Enable this option to disable the User name field.

Enter the EAP identity (maximum of 32 characters). This
is disabled EAP type TTLS.

Enter the EAP password (maximum of 32 characters).
This is disabled EAP type TLS.

Enable or disable server validation. This is disabled EAP
type PEAP-TLS.

Select the authentication protocol (TLS, TTLS, PEAP-
MSCHAPv2, PEAP-GTC, PEAP-TLS, EAP-FAST).

Select more specific EAP settings (Inner EAP Setting:
Auto or PAP, PAC Provisioning: Auto or Manual).

Touch Update radio to activate all new radio
settings not selected previously.
Touch OK in the confirmation popup.

Note None of the changed radio settings
take effect until you touch Update radio.

e To continue in Advanced settings, touch another tab.

e To exit Advanced settings and return to the Home tab, touch Exit.

Specify server settings

1. In Advanced settings, touch the Network > Server tabs.

2. Select the method used to identify the IP address of the server with which the

device will communicate.
3. Specify settings.

Setting

Network connectivity method

Data encryption

Server authentication
Host IP

NRS

DNS hostname

Action/Description
Select the preferred method to connect to the server.

Turn the security data encryption on or off, and enable or
disable the server authentication.

Turn the server authentication on or off.

Enable the device to connect to a host or other server at
a fixed IP address. In the IP address entry field, enter the
IP address. In the Port entry field and enter the port
number. The range of entry is 0 to 65535. Select either a
Welch Allyn host or a direct EMR connection.

Enable the device to connect to a Network Rendezvous
Service (NRS) at a fixed IP address. In the IP address
entry field, enter the IP address. In the Port entry field
and enter the port number. The range of entry is 0 to
65535.

Enable the device to connect to a Network Rendezvous
Service (NRS) by entering a hostname to be sent to a
Domain Name Server (DNS) to retrieve the NRS IP
address. In the Hostname field, enter the DNS name. In
the NRS Service Port entry field, enter the port number.
The range of entry is 0 to 65535.
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Note The DNS option is only available in the following
conditions:

e The version of the installed radio is 3.00.02 or greater
e The radio is disabled
e Noradiois installed

DHCP Enable the device to connect to a Network Rendezvous
Service (NRS) by entering a port number and then
connecting at a provided IP address. In the NRS Port
entry field, enter the port number. The range of entry is 0
to 65535. After successfully connecting to the server, the
NRS IP addresses and the Vendor class identifier appear
onscreen.

4. Touch Test network connection.
The status of the server connections appears.
5. Touch OK.
Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify Bluetooth settings

This task is applicable only to monitors that have a Bluetooth radio installed. Devices can
be configured with a wireless or a Bluetooth radio. A configuration must be loaded to
view regulatory information.

In Advanced settings, touch the Network > Bluetooth® tabs.

2. Specify settings.

Setting Action/Description

Allow Bluetooth configuration Enable the device to connect to a host or other server
with the Bluetooth radio.

Device name Enter the 8-character device name.

Regulatory Displays the WiFi regulatory certification information.

3. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify device IP settings

A radio card must be installed and operational to specify the device IP settings.

In Advanced settings, touch the Network > Device IP tabs.
2. Specify settings.

Setting Action/Description
Ethernet Select Use DHCP or Static ID.
IP address If Static ID is selected, specify these settings.

Subnet mask

Gateway
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DNS IP address Enter the IP address of the DNS server.

3. Touch Apply.
4. Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Specify Active Directory settings

Use the Active Directory settings to manage the device communication address and
access settings.

In Advanced settings, touch the Network > Active Directory tabs.
2. Select Enable Active Directory.

Specify settings.

Setting Action/Description

Domain name Enter the domain name.

Group Enter the domain name group.

User name Select the clinician ID type (user name, account name, or
employee ID.

Authentication user name Enter the user name.

Authentication password Enter the password.

4. Touch Test network connection.
The device displays the Active Directory test status.
5. Click OK.
Do one of the following:
e To continue in Advanced settings, touch another tab.
e To exit Advanced settings and return to the Home tab, touch Exit.

Service tab

Ethernet status

In Advanced settings, touch the Service > Ethernet status tabs. This Ethernet status
vertical tab displays read-only data about the Ethernet connection:

Network

e MAC address

e |P address

e Subnet mask

e (Gateway

e DHCP server

e DHCP lease time

Network statistics
e Rxbytes
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e Txbytes

e Rx packets

e Tx packets

e Rx multicast packets

Errors

e Rxerrors

e Txerrors

e Rx packets dropped
e Tx packets dropped
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Radio status

In Advanced settings, touch the Service > Radio status tabs. This Radio status vertical
tab displays the following read-only data about the WiFi or Bluetooth radio connection:
Network

e MAC address

e [P address

e Subnet mask

e Gateway

e DHCP server

e DHCP lease time

Network statistics

e Rxbytes

e Tx bytes

e Rx packets

e Tx packets

e Rx multicast packets

Errors

e Rxerrors

e Txerrors

e Rx packets dropped
e Tx packets dropped

Radio settings

e \Version

e Radio status string

e SSID

e Access point MAC

e Authentication type

e RSSI
e Radio band
e Channel

e Power mode
e FIPS mode

If the device cannot communicate with the radio through the internal radio IP address,
the radio error 35002c appears. A Mac address text field appears on the Radio status tab
approximately three to four minutes after the error message. Contact Welch Allyn for
assistance in entering the correct Mac address in this field.

Enter general device information

1. In Advanced settings, touch the Service > General tabs.
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Touch =====| 3nd enter up to 20 characters in the following data fields to support
device identification:

e Asset tag

e Device location

® Device location ID

If desired, select Allow Display Lock.

The display lock prevents clinician input, which may be useful when cleaning the
display.

Touch OK and repeat for each data field.
The General vertical tab appears.

Note You can enter general device information in the Welch Allyn
Service Tool as well.

To calibrate your touchscreen, touch Start in the right pane and follow the onscreen
prompts.

The Home tab appears.
To synchronize with the Service Monitor, touch Sync now.

If the software version is 1.30 or greater, the screen displays information about the
connection and whether a new configuration or firmware is available.

Touch Close.
To verify the NIBP pressure valve accuracy, touch Close Valve.

The pressure displays in the NIBP Pressure Verification field. If the software version
is 1.33 or greater, you can check the functionality of NIBP accuracy on the device
without use of the Welch Allyn Service Tool.

To stop the accuracy test, touch Open Value or navigate away from the screen.

Review and update configuration information

In Advanced settings, touch the Service > Config file tabs.
In the left pane, review the following configuration information:

e Configuration file

¢ Active Config file name
e Date of generation

¢ Date loaded to device

To load a new configuration from the network, touch Load in the right pane and
follow the onscreen prompts.

To save the current configuration to a USB drive, connect a compatible flash drive to
the USB port, touch Save to USB in the right pane, and follow the onscreen
prompts.

Note Not all flash drives are supported. See "USB flash drive
requirements” in the Appendix for details.
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Save service logs to a USB flash drive

This procedure enables you to save the last 14 active log files to a USB
flash drive.

Note The Welch Allyn Service Tool enables you to save only the 2 most recent
log files.

1. In Advanced settings, touch the Service > Log file tabs.
2. Connect a flash drive to the USB port.

Note Not all flash drives are supported. See "USB flash drive
requirements” in the Appendix for details.

3. Touch Save to USB and follow the onscreen prompts.

Copies of the service log files are saved to the drive.

Restore factory default settings

Note This process does not restore the monitor to a custom configuration
provided at delivery. Instead, it deletes all custom configuration data and
restores factory default settings.

In Advanced settings, touch the Service > System tabs.

2. Reset to defaults:
e To restore radio settings to factory default values, select Radio settings only.
e Torestore all current settings to factory default values, select All settings.

3. Touch Reset and follow the onscreen prompts.

The factory default settings are restored.

If you selected Radio settings only, the radio reboots, and the device remains
powered on.

If you selected All settings, the device reboots.

Review firmware status and load firmware from the network

In Advanced settings, touch the Service > System tabs.
2. In the right pane, review the firmware status information.

Note If the firmware is up-to-date, take no further action.
3. To update the firmware, touch Load and follow the onscreen prompts.

Note You can also load new firmware by rebooting the device.
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Power-up sequence

Overview

The system performs a power-on self test (POST) of the software and internal hardware
each time the device is powered on. Specific tests performed include the following:

e CVC-PIC tests

e LED power tests

e  eMMC (memory) tests

e EEPROM tests

If all tests are successful, the system completes power up and the user interface screen

for the default configuration appears (either the Home tab or a login/profile selection
screen), and the system is ready for operation.

If the self-check fails, an error message and an error code appear in the system status
area at the top of the screen to aid service personnel and engineers in diagnosing the
problem. If a fault that could adversely affect the product is detected, the system enters
a safe mode and stops all monitoring functions. The system remains in safe mode until it

is turned off by pressing O) or until the device shuts down automatically after a period of
inactivity.
To perform the POST:

Disconnect any patient cables connected to the system.
2. Insert a fully charged battery into the system.

Upon each power up, confirm the following:

a. The buzzer generates a sound.

b. A startup screen appears briefly and then disappears.

c. The power button flashes until the Ul is ready.

d. A beep sounds, followed by one chime.

Note If no chimes sound, replace the speaker as specified in
“Remove the speaker.”

e. The Home tab or the login/profile selection screen appears.
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Wireless radio technology

This section provides information wireless client certificates and wireless client
certificates supporting server authentication for products using the Welch Allyn 802.11 a/
b/g/n radio card.

Certificates must:

® use a supported certificate format and specified file name

¢ include embedded code for deployment on a device

e adhere to the x.509 standard

To upload wireless certificates, use the Welch Allyn Service Tool (WAST).

Wireless radio security credentials

The Newmar radio allows for the installation of OEM security credentials and a set of
customer security credentials. Use the Welch Allyn Service Tool to install server
certificates to the device.

File Format Customer file name’
CA certificate chain PEM cacert.pem
or or
DER cacert.der
Client cert / key PKCS#122 client.p12
or or
PEM client.pem
EAP-FAST PAC file Proprietary pacfile.pac
EAP-FAST password Plain text pacpassword

1 You must enter the customer file names exactly to install server certificates to your device.

2The Newmar radio automatically converts a PKCS#12 file to the PEM format during installation.
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Welch Allyn device certificate requirements

Certificate Extended usage extension Format
Server Server authentication (1.3.6.1.5.5.7.3.1) PEM

or

DER
Client Client authentication (1.3.6.1.5.5.7.3.2) PKCS#12

or
PEM

Common certificate fields

Field

Description

Serial Number

A unique number used to identify the certificate within a
CA's systems and to track revocation information.

Subject The entity a certificate belongs to: a machine, an individual,
or an organization.

Issuer The entity that verified the information and signed the
certificate.

Not Before The earliest time and date on which the certificate is valid.
Usually set to a few hours or days prior to the moment the
certificate was issued, to avoid clock skew problems.

Not After The time and date past which the certificate is no longer
valid.

Key Usage The valid cryptographic uses of the certificate's public key.
Common values include digital signature validation, key
encipherment, and certificate signing.

Extended Key Usage The applications in which the certificate may be used.
Common values include TLS server authentication, email
protection, and code signing. (Server extension is required
for server authentication. Client extension is required for
client authentication).

Public Key A public key belonging to the certificate subject.

Signature Algorithm The algorithm used to sign the public key certificate.

Signature A signature of the certificate body by the issuer's private

key.

About the waclientcert.pim file

The Welch Allyn Service Tool (WAST) only loads certificates to the CSM radio if they are
in the waclientcert.pim file format. This .pim file is a Welch Allyn specific container that
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contains the customer certificates, commands, and information on how the certificates
are loaded, and what folders the certificates are written to on the radio file system.

Note You cannot re-name an existing customer client certificate or ca certificate

to waclientcert.pim and upload it because the certificate lacks information
on where the certificates need to be deployed on the radio and how the
product should handle the file. The waclientcert.pim file must be created
using a Welch Allyn process.

Create a waclientcert.pim file using the WAST

The Welch Allyn Service Tool (WAST) can create the waclientcert.pim file using a CA
certificate alone (server verification only) or a CA certificate and client certificate (for
client authentication).

1.

I

Create a folder on the PC or thumb drive and save the CA certificate there. If the
client certificate is needed, save it in the same folder.

Connect a CSM to the PC running the WAST and allow it to come up to a usable
state.

In the WAST device list, select the CSM.
Click Configure and Current Settings / Change.
Click Network Policy Server Certificate.

Under Generate, click Browse and select the folder where the customer certificate
or certificates are saved.

The Select Certificate Folder field displays the path to the folder.

If creating a client authentication certificate, such as EAP-TLS, enter the password
created for the client certificate in the Network Policy Server Certificate field and in
the Confirm Password field.

Note: If the folder does not have a CA certificate and a client certificate, these fields
are grayed out. The WAST does not verify the client password.

Click Generate Network Policy Server Certificate Package. Under Load, click
Browse to select the destination for the waclientcert.pim file. Click OK.

In the Certificate package is successfully generated dialog box, click OK.

The waclientcert.pim file is loaded in the destination folder along with the raw
certificate files.

Load a waclientcert.pim file to the CSM

© 0 N s~ -

Disconnect the USB link between the PC and the CSM.

Launch the WAST on the PC.

Restart the CSM and allow it to come up to a usable state.

Connect the USB link from the PC to the CSM.

Select the CSM from the WAST device list.

Click Configure.

Click Current Settings / Change.

Click Network Policy Server Certificate.

Under Load, click Browse to locate the destination of the waclientcert.pim file.
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10.

11.

12.

13.

14.

15.

The Select existing package field displays the path to the waclientcert.pim file.
Click Load Network Policy Server Certificate.

A message box displays the installation progress. The process should take a
maximum of three minutes.

If the message box displays for more than six minutes, begin the process again from
step 1.

If the message box displays a message indicating the installation is successful, click
OK.

Close the WAST application.
Disconnect the USB connection.

Restart the CSM.

You can now configure the CSM to use certificates on the wireless network.

Verify the certificate is loaded to the device

There is no on-screen verification that a certificate has been loaded to the device.

Reset the radio settings of the device to factory default.
Restart the device.
Configure the following network settings:

Setting Description
> Radio > Enabled
> Authentication Type > WPA2 Enterprise

Configure the network settings for the certificate you are verifying:

e |f you are verifying that a CA certificate is loaded:
EAP Type: PEAP-MSCHAPv2

Enable Server Validation: Checked

e |f you are verifying that a client certificate is loaded:
EAP Type: EAP-TLS

Enable Server Validation: Unchecked

If the error for Invalid Configuration 350018 appears, the certificate is not loaded.



41

Bluetooth® wireless technology

Bluetooth wireless technology is available in the Office profile.

Bluetooth status

A monitor with Bluetooth wireless technology displays the status between the monitor
and the laptop in the Status area.

Image Description

No image Bluetooth radio is OFF

Bluetooth icon appears in Status area Bluetooth radio is ON

Bluetooth icon is blinking on / off slowly The monitor is pairing with the laptop

Bluetooth icon is blinking on / off quickly The monitor is connecting with the laptop
Bluetooth icon appears with a border around the icon in The monitor and the laptop are connected and the
the Status area monitor is ready to transmit data

In order to transmit data, you must first pair and then connect the monitor and the
laptop.

Enable Bluetooth pairing

You can pair a device and a PC configured with Bluetooth wireless technology.

1. In Advanced settings, touch the Network > Bluetooth tabs.
2. Touch Allow Bluetooth® configuration to enable pairing.

Pair devices with Bluetooth wireless technology

When a monitor with Bluetooth wireless technology powers on and there are laptops
already paired with the monitor, a pop-up screen appears showing the laptops available
for connection with the monitor. Follow the directions below to pair an additional device
with the monitor.

1. Touch
2. Touch Add new device.
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In your Bluetooth program manager on your laptop task bar, select the monitor from
the list of available devices.

A message appears indicating that the monitor has been discovered and displays a
confirmation number on both the laptop and monitor screens.

Confirm that the numbers match on the laptop and on the monitor, and then touch
Accept.

A message appears indicating that the monitor and laptop are paired.
Touch OK.

A screen appears that allows you to change the laptop name to a preferred name.
Enter the preferred name, and then touch Save.

The new name appears in the list of paired devices.

Connect Bluetooth devices and download data

In the Bluetooth connection screen, select a laptop from the list of paired devices.

The Bluetooth icon in the Device Status area blinks on and off quickly as the monitor
and laptop are connecting.

When the monitor and the laptop connect, an information message appears briefly
that names the connected laptop. When the message disappears, the name of the
connected laptop appears on the top left of the screen, and the Bluetooth connected
icon (Bluetooth icon with a border around it) appears in the connection area.

As the laptop downloads data, observe the progress indicator spin in the connection
area.

The Bluetooth connection remains active until the download is complete. After a
successful download, the system clears data from the monitor and disconnects the
monitor from the laptop.

Repeat the process as needed, or touch Cancel to dismiss the Bluetooth connection
screen.

Rename a laptop

You can rename a paired laptop from a system or generic name to a specific name.

1.

Select the arrow button to the right of the laptop name you want to edit in the paired
list.

A screen appears that allows you to change the laptop name to a preferred name.
Enter the name, and then touch Save.

The new name appears in the list of paired devices.
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Disassembly and repair

These procedures provide instructions for device disassembly and board removal, as
well as component replacement and reassembly.

Each part’s disassembly instructions might include one or both of the following:

e Reassembly notes: This subsection contains information specific to reassembly. At
a minimum, these notes indicate whether or not reassembly is the reverse of
disassembly. The notes also list service kits of replacement parts where applicable.

¢ When replacing the component. This subsection contains additional instructions
related to installing a new option or replacement part.

Each disassembly step includes drawings that illustrate the components to be removed.
The reassembly notes could be as short as one or two lines when reassembly is the
reverse of disassembly. When reassembly is more complicated, these notes alert you to
any special care required to complete the repair or installation and sometimes introduce
separate reassembly instructions. Line drawings appear in the reassembly notes only
when they differ from the drawings in the disassembly instructions.

AN
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> B >

WARNING Electrical shock hazard. Disconnect AC power before opening
the device. Disconnect and remove the battery before proceeding with
disassembly. Failure to do this can cause serious personal injury and
damage to the device.

WARNING Risk of fire, explosion and burns. Do not short-circuit, crush,
incinerate, or disassemble the battery pack.

WARNING Safety risk. Do not attempt to service the device when the
device is connected to a patient.

CAUTION Before disassembling the device or installing options,
disconnect the patient from the monitor, power down the device,
disconnect the AC power cord and any attached accessories (for example,
SpO2 sensors, blood pressure hoses and cuffs, and temperature probes)
from the device.

CAUTION If your device is configured with a SureTemp module, remove
the probe well before disassembly.

CAUTION Perform all repair procedures at a static-protected station.

CAUTION When the device case is opened, regard all parts as extremely
fragile. Execute all procedure steps with care and precision.



44 Disassembly and repair Connex® Spot Monitor

& CAUTION Observe screw torgue specifications, especially with screws
that secure directly into plastic standoffs.

& CAUTION To avoid mismatching screws and holes, keep the screws for
each piece with that piece as you remove modules and circuit assemblies.
It is possible to mistakenly install machine screws in locations intended for
plastite screws. Plastite screws have a Torx-pan head.

Required tools and equipment

e Phillips #1 screwdriver
e T-10 Torx screwdriver
e 3mm hex key

Torque value table

Use this table to determine how much torque to apply to screws by type and location
when reassembling the device.

Description Torque specification Bit type Where used

SCR,4-20X.31 PLASTITE PH TORX 45 +/-0.5 in-lbs Torx Chassis and Sp02 Insert to Main
CSM PCA. Radio/Bluetooth PCBA
to Chassis

SCREW 4-40 .250 PAN PHILLIPS 45+/-05in-Ibs Phillips Sp02 boards

STEEL ZINC

SCREW, M2 X 6 INTERNAL TOOTH 254+/-0.25 in-lbs Phillips Radio PCA to Radio Interface PCA

SEMS PHP

SCREW, M4 X 10 PAN HEAD W 7.54/-05 in-Ibs Phillips Front to Back Housing and

NYLOC Temperature Module/Dock

SCR, M4 PAN HD, PHD, SHOULDER 45 +/-0.5 in-lbs Phillips Battery Door
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Connector types

Disassembly and repair procedures require that you disconnect and reconnect the
following connector types inside the device:

Locking (squeeze-release): Locking connectors use a latching mechanism to
prevent accidental disconnection during assembly and use. The latch is located on
one end of a tab so it may flex and lock into place when coupled with its matching
connector. The tab provides a lever to release the latch. Some connectors have
multiple latches that require you to press multiple tabs to release.

To remove a locking connector, squeeze the tab(s) to release the latch(es) and
remove the cable.

To connect a locking connector, push the mating pieces together until the latch(es)
lock in place.

Friction: Friction connectors use a spring mechanism to create friction between the
contacts.

To remove a pressure connector, grasp each connector mating half and pull the
halves apart.

& CAUTION Do not use excessive force to disconnect the
connector. Excessive force may result in pulling the mounted
connector off the circuit board.

To connect a friction connector, grasp each connector mating half and insert one half
into the other.
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ZIF (zero insertion force): The device uses flex cables and ZIF flex cable
connectors. Flex cables and ZIF connectors require special care when handling.

ZIF connectors use a sliding outer piece that latches and unlatches to secure and
release the flex cable. ZIF cables cannot be successfully connected or disconnected
without properly unlatching and latching the sliding outer piece.

& CAUTION Do not use excessive force when releasing
pressure on the connector. Excessive force may result in
breaking the sliding outer piece.

To remove a ZIF connector

& CAUTION Remove a flex cable only after the ZIF latch is
open.

1. Using a suitable tool (for example, a paper clip, small flat-head screwdriver, or
needle-nose pliers), slide the latching piece of the connector away from the
connector body.

|- |

—

2. Remove the cable.

To connect a ZIF connector
1. Slide the latching piece of the connector away from the connector body.

2. Insert the flex cable into the connector. This may require using a suitable tool to
keep the latching piece elevated.

3. Slide the latching piece toward the connector body until it locks into place.

10
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Coaxial: Coaxial connectors, a type of pressure connector in this case, are
components attached to the ends of a coax cable—they make it possible to connect
to other devices. The connector has a wire conductor in the center, surrounded by
an outer conductor, and an insulation between the two. In this device, the coaxial
connector connects the antenna to the wireless radio board.

Note This connector is labeled PB because of its location on the
wireless radio board.

To remove a coaxial connector, lift the connector away from the board.

To connect a coaxial connector, align the connector over the mount on the board and
press to snap it into place.
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Disassembly overview

The following flow chart provides an overview of the complete disassembly of the
device. Most disassembly activities require that you complete a subset of the steps
detailed here. The flow chart indicates the steps which must be completed in sequence
to remove a particular component. Because a different sequence of preliminary steps is
required to remove certain components, you should use this flow chart as a reference at
the start of every disassembly and component replacement procedure.

Power Down
Remove Monitor

from Stand (Replacing Kit 105933 only) -
¢ —————————————— »| Remove Nonin Board

|

|

Remove Battery |
¢ : ------------ |  Remove Speaker

|

Remove Back Housing | - - —~ — — e - -

(Replacing Kit 105936,
105937, 105938 only)

Remove Braun

Remove Bluetooth
Board

Configuration L 3| Remove Wireless
with ! Radio Board
Temperature :
Module? Remove SureTemp |
- >

Remove Speaker |«

v

Separate PCAfrom Ly | Remove Sp02 Insert
Front Housing

v

Remove Bezel

v

Remove Power Switch

Remove Nonin Board

Configuration Remove Masimo Board

with
Sp02?

Remove Nellcor Board

Remove Wireless
Radio Board

Remove Bluetooth
Board

Remove LCD

12

Remove Pump Assembly




Service manual

Disassembly and repair 49

Note After performing any of these procedures and before returning the device
to service, you must use the service tool, Gold edition, to complete the full
suite of functional tests to ensure that all systems are operating within the
design specifications. For more information about these tests and the
service tool, see “Functional verification and calibration.” If you do not have
the service tool, you can download it from welchallyn.com.

Power down the monitor

You can power down the device as follows: 1) by briefly pressing the power button on
the housing and then following the onscreen prompts, or 2) by using onscreen controls
alone.

Option 1. Press the power button. An onscreen dialog opens with the following options:
¢ Power down. Device behavior is the same for all profiles.

e Sleep. The Sleep button clears the display and puts the device into Display power-
saving mode.

e Cancel. The Cancel button dismisses the dialog.

Touch Power down and complete the power-down procedure as described in Option 2,
steps 3 and 4.

Option 2. Use onscreen controls alone to power down the device:

Touch the Settings tab.
2. Touch the Device tab.
Touch Power down.

4. Select the desired option and then touch Power down.
The Power-down options dialog

The buttons in this dialog produce varied effects, as noted below:

e Power down. The device clears all data onscreen and performs a complete software
shutdown.

e Cancel. This button dismisses the dialog and returns you to the previous screen.
Note If your monitor is configured with a Braun thermometer, avoid powering

down the monitor between patient measurements to help maintain an
adequate charge to the Braun dock.
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Remove the monitor from the stand

Disconnect the power cord from the wall.

2. If the system has an APM, disconnect the power and communication cables from
the monitor. If the system has an external power supply, disconnect the power
supply from the monitor.

3. Remove the 4 Phillips screws from the back of the stand mount to remove the
monitor from the stand.

Note This artwork features the APM stand. Other stand mounts
look slightly different.

Reassembly notes: Reassembly is the reverse of disassembly.
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Exploded view diagram

The drawing below shows individual components of the device and their relationships to
one another.
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Remove the battery

Before removing the battery, power down the monitor as described in this manual.

1. Place the unit face down on the table as shown.
2. Loosen the captive Phillips screw to remove the battery door.

Reassembly notes

Kit item:
e 105973, Battery pack

Note Reassembly is the reverse of disassembly.

& WARNING Defective batteries can damage the monitor. If the battery
shows any signs of damage or cracking, it must be replaced immediately
and only with a battery approved by Welch Allyn.
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Remove the back housing

Remove the 6 Phillips screws on the back of the device to remove the back housing.

1.

Lift the back housing straight up off the device.

2.

3. Remove end cap on the right by pulling it out of its slot.
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Reassembly notes

Kit items:
e 105939, End cap

e 105923, Back housing (includes battery, speaker foam, 6 screws, and labels)

Note The back housing is not available for direct purchase. Welch Allyn limits
availability of certain parts to Authorized Service Personnel only. These
limitations are required to maintain product safety or maintain current
regulations.

Note Reassembly is the reverse of disassembly.

Remove the temperature module or housing

The monitor is configured with either a SureTemp or Braun ThermoScan
PRO 6000 temperature module. Proceed witih the disassembly steps that
apply to your device.

Remove the SureTemp module

1. Disconnect the ribbon cable by lifting the connector.
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Remove the Phillips screw that holds the module in place.

2.

3. Lift the module out of the left side slot.

Reassembly notes

Kit item:

105940, SureTemp Plus module

Reassembly is the reverse of disassembly.

Note
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Remove the Braun ThermoScan PRO 6000 module

Disconnect the ribbon cable by lifting the connector.

1.

Remove the Phillips screw that holds the module in place.

2.
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3. Lift the module out of the left side slot.
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Reassembly notes

Kit item:
e 105941, Braun ThermoScan PRO 6000 dock

Note Reassembly is the reverse of disassembly.

Disassemble the main PCA board

Remove the speaker

1. Disconnect the speaker wire.

2.

Reassembly notes

Kit item:
e 105942, Speaker

Note Reassembly is not the reverse of disassembly.
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When replacing the speaker

While holding the speaker, guide the wire through the hole in the pump assembly

and drop the speaker into place.

1.

Connect the speaker wire to the main PCA board.

Separate the main PCA board from the front housing

2.

Disconnect the power switch flex cable from the main PCA board.

1.

Lift the antenna board straight up out of its slot and let it hang.

2.
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3. Remove the main PCA board from the front housing.

Reassembly notes

Note Reassembly is the reverse of disassembly.
Remove the Sp02 insert

1. Turn over the main PCA board and remove the 2 T-10 Torx screws attaching the
sensor insert to the main PCA board.

P
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2. Turn over the main PCA board again so that the SpO2 board is facing you; then
disconnect the power harness from the main PCA board.

3. Todisconnect the insert from the pump manifold, hold the black pump manifold with
one hand and tilt the top of the insert away from the main PCA board with the other
hand.

4. Remove the 2 T-10 Torx screws from the power harness, and remove the power
harness from the SpO2 insert.
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Reassembly notes

SpO2 insert options are Masimo, Nellcor, Nonin, or none.

Kit items:
e 105926, Masimo insert only
e 105927, Nellcor insert only
e 105929, Nonin insert only
e 105928, No SpO2 insert only

Note Reassembly is not the reverse of disassembly, but it is the same for each
insert.

When replacing the SpO2 insert
1. First complete the following steps:

e Attach the power harness to the SpO2 insert. (See "Attach the power harness to the
insert.")

¢ Install any new SpO2 board, if applicable. (See the reassembly notes in "Remove the
Sp02 board.")

Attach the power harness to the insert

Align the power harness with the insert and secure it with 2 T-10 Torx screws (see
the Torque Value Table).

S5
?\%x
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Attach the Sp02 insert to the main PCA board

1. Align the insert with the edge of the main PCA board. Connect the pump tubing to
the insert as shown and press firmly. Adjust the insert to fit snugly along the side of
the board.

2.

3. Turn over the board and secure the insert to the main PCA board with 2 T-10 Torx
screws.
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Remove the Sp02 board

Masimo, Nellcor, Nonin, or none. Proceed witih the disassembly steps

The monitor is configured with one of the following SpO2 boards:
that apply to your device.

Remove the Masimo board

Remove the 2 Phillips screws from the SpO2 board.

1.

Lift the SpO2 board to remove it from the adapter board.

2.

3. Remove the 2 Phillips screws that hold the adapter board to the main PCA board.
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Firmly grasp the adapter board and lift it straight up to disconnect the pins.

4.

Remove the Nellcor board

Remove the 2 Phillips screws from the SpO2 board.

1.

Lift the SpO2 board to remove it from the adapter board.

2.
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3. Remove the 2 Phillips screws that hold the adapter board to the main PCA board.

4. Firmly grasp the adapter board and lift it straight up to disconnect the pins.

Remove the Nonin board

Remove the 2 Phillips screws that attach the SpO2 board to the main PCA board.

1.
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2. Remove the board.

Reassembly notes

SpO2 board options are Masimo, Nellcor, and Nonin.

Kit items:
e 105931, adapter board, Masimo board, and 2 Phillips screws (4-40 0.250 pan steel
zinc)
e 105932, adapter board, Nellcor board, and 2 Phillips screws (4-40 0.250 pan steel
zinc)

e 105933, Nonin board and 2 Phillips screws (4-40 0.250 pan steel zinc)

Note Reassembly is the reverse of disassembly for each board.

Remove the communications board

The monitor is configured with one of the following communications
boards: wireless radio, Bluetooth wireless technology, or none. Proceed
witih the disassembly steps that apply to your device.

Remove the wireless radio board from the main PCA board

1. Remove the 2 T-10 Torx screws from the wireless radio board attached to the pump
assembly.
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2. Pull the board straight out to disconnect the mini USB connector.

Reassembly notes

Kit items:

e 105936, Wireless radio board, antenna, and 2 T-10 Torx screws
e 105938, Antenna board

Note Reassembly is the reverse of disassembly.

Remove the Bluetooth board from the main PCA board

1. Remove the T-10 Torx screw from the Bluetooth radio board.
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2. Pull the board straight out to disconnect the mini USB connector.

Reassembly notes

Kit items:
e 105937, Bluetooth board and a T-10 Torx screw

Note Reassembly is the reverse of disassembly.
Remove the LCD from the main PCA board

1. Carefully separate the LCD flex cable from its connector on the main PCA board by
pulling the cable straight up.

2. Turn over the main PCA board so that the notch on the board faces you.
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3. On the side of the main PCA board with the notch, carefully lift the LCD past the
tabs, and tilt the LCD upward.

4. Remove the Gaff tape from the ferrite and LCD flex and set it aside for reassembly.




70 Disassembly and repair Connex® Spot Monitor

5. Carefully lift the bale (locking mechanism) of the LCD flex cable connector on the
main PCA board and remove the LCD.

Reassembly notes

Kit item:
e 105924, LCD, touchscreen, and ferrite
Note Reassembly is not the reverse of disassembly.
Note Use the Gaff tape set aside during disassembly to reassemble the LCD.

Attach the LCD to the main PCA board

1. With the LCD frame facing up, carefully insert the LCD flex cable into the connector.

>z
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2. With two fingers, press down the bale to secure the LCD flex cable.

3. Apply the Gaff tape (removed during disassembly) to the ferrite and the LCD flex to
hold the ferrite in place. Crease the tape along the side of the ferrite.

Note Do not allow the tape to touch the board or the ferrite to
touch the end of the flex cable when assembled.
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4. Insert the small touchscreen flex cable into the hole on the main PCA board.

N\A

&

5. Place the LCD at an angle under the tabs on the flex cable side of the LCD.

6. Lower the LCD into place and carefully move the tabs on the opposite side just
enough to catch and secure the LCD in the frame.

Note Ensure that the tabs hold the LCD securely.

7. Turn over the main PCA board.
8. Insert the flex cable into its connector.
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Remove the pump assembly

1. Remove the pump manifold from the main PCA board transducers.

2.
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4. Separate the pump assembly from the main PCA board.

Reassembly notes

Kit items:
e 105920, Pump assembly and 2 T-10 Torx screws

Note Reassembly is not the reverse of disassembly.

Attach the pump assembly to the main PCA board

1. Place the pump manifold onto the main PCA board transducer. Ensure that the pump
manifold is fully seated on the transducer.

(See "Remove the pump assembly," step 1.)
2. Connect the pump to the main PCA board.
(See "Remove the pump assembly," step 2.)

3. Turn over the main PCA board.

4. Secure the pump assembly to the main PCA board with 2 T-10 Torx screws (see the
Torque Value Table).

(See "Remove the pump assembly," steps 3 and 4.)

Replace the main PCA board

Replace the main PCA board as needed after removing all other components.

Note New PCA boards must be prepared for first use after installing them.
Perform an NIBP board initialization during the full device functionality and
calbration using the Welch Allyn service tool, Gold edition. See "Initialize
the NIBP board" in the "Full functional verification and calibration" section.
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Disassemble the front housing
Remove the bezel from the front housing

Lift the rubber bezel up and over the power switch cable and the 6 bosses on the
housing.

g
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Reassembly notes

Kit items:
e 105922, Bezel
e 105921, Front housing (housing, power switch, and 6 Phillips screws)

Note Reassembly is not the reverse of assembly.

Attach the bezel to the front housing

1. Align the bezel with the front housing and feed the power switch flex cable through
the slot in the bezel.

2. Place the bezel onto the 6 bosses on the housing.
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Remove the power switch

1. Turn over the front housing.
2. Peel off the power switch button from the front housing (it is very sticky).

3. Unthread the power switch flex through the front housing.

X

Reassembly notes

Kit item:
e 105944, Power switch

Note Reassembly is not the reverse of disassembly.

When replacing the power switch
1. First complete the following steps:
e Remove the rear housing.
e Separate the main PCA board from the front housing.
¢ Disassemble the front housing.
e Attach the power switch.
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Attach the power switch

1. Clean the pocket for the power switch on the front housing with 91 percent alcohol.
Use air to dry if necessary.

%

P

2. On the back of the power switch, remove the liner covering the adhesive by pulling
the tab. Be sure to remove the liner under the flex.

L0

3. Thread the power switch flex through the front housing.

CL);
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4. Insert the left edge of the power switch into the left side of the pocket then lower
the power switch into place, centering the switch within the pocket.

(’.‘V)L%

5. Press down to secure the switch to the front housing.
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Accessory Power Management (APM) work surface

This section applies only to devices with an APM stand.

Remove the APM work surface from the stand

Before removing the APM work surface, power down the monitor, disconnect the power
and communication cables from the monitor, and disconnect the power cord from the

wall.
1. Using a 3mm hex key, remove the 4 screws from the stand bracket and put them
aside.

Note Save the screws for reassembly.

2. Lift the APM work surface off the stand.

3. If replacing the APM, remove the battery and put aside for reassembly.

Reassembly notes

Kit item:
e 105943, APM work surface

Note Reassembly is the not the reverse of disassembly.
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Attach the APM work surface to the stand

1. Take the 4 screws used to attach the APM work surface to the stand and partially
screw them into the APM work surface with your fingers. Do not tighten.

2. Lower the screws into the stand bracket keyholes.

3. Slide the APM work surface backward on the stand bracket.
4. Tighten the 4 screws using a 3mm hex key.
5. Insert the battery.

Remove the APM work surface battery

Before removing the APM work surface battery, power down the monitor and
disconnect the power cord from the wall.

Note You do not have to remove the APM work surface from the stand to
remove the APM work surface battery.
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1. Loosen the captive screw on the bottom of the APM work surface that secures the
battery door.

2. Remove the battery door and put it aside.

3. Gently lift the latch with one hand and pull the tab on the top of the battery with your
other hand to remove the battery from its slot.
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Reassembly notes

Kit items:
e Batt99, 9-cell Lithium-ion battery, single pack
e 105972, APM work surface, battery door (if needed)

Note Reassembly is the reverse of disassembly.
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MS3

This section applies only to devices with a Classic (MS3) stand.

Remove the power supply from the MS3 stand

Before removing the power supply, power down the monitor, disconnect the power
cable from the monitor, and disconnect the power cord from the wall.

1. With one hand holding the power supply, remove the 2 Phillips screws inside the
basket that hold the power supply in place and put them aside.

Note Save the screws for reassembly.

2. Pull the power supply down and away from the stand.

Reassembly notes

Kit item:
e 7000-PS, Connex Spot 35 Watt Power Supply

Note Reassembly is the reverse of disassembly, but you need to thread the
power cable through one of the spaces next to the pole to reach the

monitor.

83
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Field replaceable units

This listing includes only field-replaceable service parts. Product accessories—including
patient sensors, probes, cables, batteries, probe covers, and other consumable items—
are listed separately in the accessories list in the Appendix of the Directions for use or at
http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-
devices/connex-spot-monitor/parts-and-accessories.html.

This section begins with an illustration of the entire device followed by lists of service
kits.

Repair parts/kits can be purchased through Welch Allyn sales channels.

Note Welch Allyn may limit availability of certain parts to Authorized Service
Personnel only. These limitations are required to maintain product safety,
or maintain current regulations. After the End of Manufacturing (EoM) date,
repair and service parts will be provided for 5 years or until parts are no
longer available. The Expected Service Life, per IEC60601-1 3rd Edition
Sub-clause 4.4, is defined as a period of 5 years.


http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/parts-and-accessories.html
http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/parts-and-accessories.html
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Device serial number and model label

The model number and serial number can be found on a label on the back housing.
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Serial number and format code

Serial number

MMMMXXXXWWYY

MMMM Manufacturing plant
XXXX Sequential number
Ww Week of manufacture
YY Year of manufacture

About 4th Edition Service kits

The table describes the components of the device and APM and the associated service

kits for replaceable parts for devices manufactured per IEC60601-1 4th Edition from

2019 and later. To determine which year your device was manufactured in, refer to the

serial number. The year of manufacture is listed as the last two digits of the serial

number.

Future revisions of a part might not always be backwards compatible with a legacy part.

List of 4th edition service kits

To determine the correct replacement part for your unit, always provide the serial
number and model when ordering.

Service Kit Material Description

Number Number

1 105945 Srv Kit CSM, Battery Door

2 Batt22 Srv Kit, BATTERY PACK, 2S1P, 7.2V
3 105923 Srv Kit CSM, Back Housing*

4 105939 Srv Kit CSM, End Cap

5 105942 Srv Kit CSM, Speaker

6 105920 Srv Kit CSM, NIBP Pump Assembly

7 105933 Srv Kit CSM, Nonin Sp02 PCBA

8 105931 Srv Kit CSM, Masimo Sp02 PCBA

9 105932 Srv Kit CSM, Nellcor Sp02 PCBA

10 105925 Srv Kit CSM, Main PCA, and LCD Frame
1 105930 Srv Kit CSM, Power Harness

12 105938 Srv Kit CSM, Newmar Antenna PCBA
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Service Kit Material Description

Number Number

13 105936 Srv Kit CSM, Newmar Radio PCBA

14 105937 Srv Kit CSM, Bluetooth Radio PCBA

15 105926 Srv Kit CSM, Masimo Sp02 Insert

16 105927 Srv Kit CSM, Nellcor Sp02 Insert

17 105928 Srv Kit CSM, No Sp02 Insert

18 105929 Srv Kit CSM, Nonin Sp02 Insert

19 105924 Srv Kit CSM, LCD with Touchscreen

20 105922 Srv Kit CSM, LCD Bezel

21 105921 Srv Kit CSM, Front Housing

22 105944 SRV Kit CSM, Power Switch

23 105941 Srv Kit CSM, Braun ThermoScanPRO 6000 Module
24 105940 Srv Kit CSM, Sure Temp Plus Module

25 105943 SRV Kit CSM, APM Work Surface

26 Batt99 9 CELL LITHIUM ION BAT SINGLE PACK

27 105972 SRV Kit CSM, APM Work Surface, Battery Door
28 7000-PS Connex Spot 35 Watt Power Supply

* Not available for direct purchase.

About 3rd Edition service kits

The tables describes the components of the device and APM and the associated service
kits for replaceable parts for devices manufactured per IEC60601-1 3rd Edition from
2015 through 2018. To determine which year your device was manufactured in, refer to
the serial number. The year of manufacture is listed as the last two digits of the serial
number.

Future revisions of a part might not always be backwards compatible with a legacy part.
To determine the correct replacement part for your unit, always provide the serial
number and model when ordering.

To repair a 3rd edition device component, you might need to use a service kit to upgrade
the component. To determine whether you need to use an upgrade kit to replace a
component for the first failure, consult the 3rd edition service kits for the first
component failure table to locate the correct service kit to use with your device.

Note Upgrading a component does not make the device 4th edition compliant.
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If the device encounters a failure after you upgrade a device component, consult the 3rd
edition service kits for subsequent component failure table to determine which service
kit to use.

3rd edition service kits for first component failure

Use this table to determine the correct part to order for the first component failure.

Device Main SureTemp Masimo Nellcor Nonin Braun Braun
Model Board Plus Dock  Thermomet
Number er
7*CE 107156 - - 107156 - 107156 107156
7*CT 107155 107155 - 107155

7*CX 107162 - - 107162

7*ME 107157 - 107157 - - 107157 107157
7*MT 107154 107154 107154

7*MX 107158 - 107158

T*XE 107153 - - - - 107153 107153
7*XT 107152 107152

7*XX 107163

7*WE 107153 - - - 105933 107153 107153
T*WT 107152 107152 - - 105933

7*WX 107163 - - - 105933

*Varies depending on the model number of your device.
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3rd edition service kits for a subsequent component failure

Use this table to determine the correct part to order if you encounter a component
failure after upgrading using the components in the 3rd edition service kit for first
component failure.

Note

Device
Model
Number

7*CE
7*CT
7*CX
7*ME
T*MT
7*MX
T*XE
T*XT
7*XX
T*WE
T*WT

T*WX

For a first component failure, refer to the 3rd edition service kits for a first
component failure table.

Main SureTemp Masimo  Nellcor Nonin Braun Braun

Board Plus Dock  Thermomet
er

105925 105940 105931 105932 105933 105941 105948

*Varies depending on the model number of your device.

List of 3rd edition service kits

To determine the correct replacement part for your unit, always provide the serial
number and model when ordering.

Service Kit Material Description

Number Number

1 105945 Srv Kit CSM, Battery Door

2 Batt22 Srv Kit, BATTERY PACK, 2S1P, 7.2V
3 105923 Srv Kit CSM, Back Housing*
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Service Kit Material Description

Number Number

4 105939 Srv Kit CSM, End Cap

5 105942 Srv Kit CSM, Speaker

6 105920 Srv Kit CSM, NIBP Pump Assembly

7 105933 Srv Kit CSM, Nonin Sp02 PCBA

8 105931 Srv Kit CSM, Masimo Sp02 PCBA

9 105932 Srv Kit CSM, Nellcor Sp02 PCBA

10 105925 Srv Kit CSM, Main PCA, and LCD Frame
1 105930 Srv Kit CSM, Power Harness

12 105938 Srv Kit CSM, Newmar Antenna PCBA
13 105936 Srv Kit CSM, Newmar Radio PCBA

14 105937 Srv Kit CSM, Bluetooth Radio PCBA

15 105926 Srv Kit CSM, Masimo Sp02 Insert

16 105927 Srv Kit CSM, Nellcor Sp02 Insert

17 105928 Srv Kit CSM, No Sp02 Insert

18 105929 Srv Kit CSM, Nonin Sp02 Insert

19 105924 Srv Kit CSM, LCD with Touchscreen

20 105922 Srv Kit CSM, LCD Bezel

21 105921 Srv Kit CSM, Front Housing

22 105944 SRV Kit CSM, Power Switch

23 105941 Srv Kit CSM, Braun ThermoScanPRO 6000 Module
24 105940 Srv Kit CSM, Sure Temp Plus Module
25 105943 SRV Kit CSM, APM Work Surface

26 Batt99 9 CELL LITHIUM ION BAT SINGLE PACK
27 105972 SRV Kit CSM, APM Work Surface, Battery Door
28 7000-PS Connex Spot 35 Watt Power Supply

* Not available for direct purchase.
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Cleaning requirements

This section presents procedures for cleaning the Connex Spot Monitor (including the
monitor, stand, APM work surface, accessories, and accessory basket and bins).

Welch Allyn has validated these instructions to be capable of preparing your Connex
Spot Monitor devices and above accessories for re-use. Clean on a routine basis
according to your facility's protocols and standards or local regulations. If the monitor is
on, lock the display.

& WARNING Patient injury risk. Clean all accessories, including cables and
tubes, before storing the accessories on the device or stand. This helps
reduce the risk of cross contamination and nosocomial infection.

& WARNING Electric shock hazard. Before cleaning the monitor, disconnect
the AC power cord from the mains outlet and the power source.

& WARNING Electric shock hazard. DO NOT immerse or autoclave the
monitor or accessories. The monitor and the accessories are not heat-
resistant.

& WARNING Liquids can damage electronics inside the monitor. Prevent
liquids from spilling on the monitor.

& CAUTION Do not sterilize the monitor. Sterilizing the monitor could harm
the device.

If liquids are spilled on the monitor:

PoON =

oo

Power down the monitor.

Disconnect the power cord from the mains outlet and the power source.
Remove battery pack from the monitor.

Dry off excess liquid from the monitor.

Note If liquids possibly entered the monitor, remove the monitor
from use until it has been properly dried, inspected, and
tested by qualified service personnel.

Reinstall battery pack.
Reconnect the power cord.
Power on the monitor and verify that the monitor functions normally before using it.
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Prepare to clean the equipment

& CAUTION Some cleaning agents are not appropriate for all components of
the device. Use only approved cleaning agents, and observe restrictions
noted for some components in the following table. Using unapproved
cleaning agents may cause damage to components.

& CAUTION Do not use bleach solutions of any kind when cleaning metal
electrical contacts. They will damage the device.

Select a cleaning agent from the following table.

Section 1. Approved for all Connex Spot Monitor components

Cleaning agent Additional information

Accel INTERVention

Accel TB

CaviWipes

Clinell® Universal Wipes

Oxiver TB

Sani-Cloth® Plus

Super Sani-Cloth®

70 percent isopropyl alcohol solution Applied to a clean cloth

Section 2. Not approved for all Connex Spot Monitor components

Note The following cleaning agents are NOT approved for cleaning Connex Spot
Monitors equipped with the Braun ThermoScan PRO 6000.

Cleaning agent Additional information

Cleancide

Clorox HealthCare Bleach Germicidal Cleaner

Sani-Cloth® Bleach Not approved for cleaning the display

Super HDQ® L10 Dilution rate of %2 oz per gallon of water (1:256) applied to a clean
cloth

Tuffieb Cleaning Wipes

Virex Il (256) Dlilurt]ion rate of J2 oz per gallon of water (1:256) applied to a clean
clot

10 percent bleach solution (.5% - 1% sodium hypochlorite) applied to a clean cloth
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Remove liquid spills from the monitor

Liguids can damage electronics inside the monitor. Follow these steps if liquids spill on
the monitor.

I T o

7.

Power down the monitor.

Disconnect the power cord from the mains outlet and the power source.

Remove battery pack from the monitor.

Dry excess liquid from the monitor.

Reinstall battery pack.

Reconnect the power cord.

Power on the monitor and verify that the monitor functions normally before using it.

If liquids possibly entered the monitor, remove the monitor from use until it has been
properly dried, inspected, and tested by qualified service personnel.

Clean the equipment

The screen lock blocks the display of patient information and prevents any input, which
may be useful when cleaning the display.

Follow the cleaning agent manufacturer's instructions to prepare solution, if applicable,
and clean all exposed surfaces of the monitor, APM work surface, accessory bin(s) and
basket, cords and cables, and stand. Wipe all surfaces until no visible soil remains.
Change the wipe or cloth throughout the cleaning procedure as needed.

o

© © N o O

& WARNING Electric shock hazard. Do not open the monitor or attempt
repairs. The monitor has no user-serviceable internal parts. Only perform
routine cleaning and maintenance procedures specifically described in this
manual. Inspection and servicing of internal parts shall only be performed
by qualified service personnel.

& CAUTION Sterlizing the monitor could damage the device.

Disconnect the AC power cord from the mains outlet.
Wipe the top of the monitor.
Wipe the sides, front, and rear of the monitor.

Avoid residual film buildup on the LCD screen. After cleaning and disinfecting, wipe
the LCD screen with a clean cloth dampened with water, and then wipe the screen
dry with a dry clean cloth.

Wipe the bottom of monitor.

Wipe the APM work surface.

Wipe the accessory bins or basket.

Wipe the AC power cord and the APM work surface power/USB cable assembly.
Wipe the stand from top to bottom.

Dry the equipment

1.
2.

Allow all components except the LCD screen to air dry.
Wipe the LCD screen dry with a clean cloth.
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Store the device

Store the device according to facility guidelines to keep the device clean, dry, and
ready for service.

Cleaning accessories

Accessories include components like blood pressure cuffs and hoses, SpO2 sensors and
cables, thermometers, and the barcode scanner. Follow accessory manufacturer’'s
instructions for cleaning and disinfection.

For the Braun ThermoScan PRO 6000 thermometer, use only the approved cleaning
agents published in the manufacturer's instructions for cleaning. Unapproved
cleaning agents can damage the device and interfere with data transmission.

Clean the Braun ThermoScan PRO 6000 contacts

Debris that accumulates on the Braun ThermoScan PRO 6000 electrical contacts can
interfere with data transmission. Welch Allyn recommends cleaning the contacts on the
thermometer and the dock once every 4 months to maintain optimal performance.

& CAUTION Do not use bleach solutions of any kind when cleaning metal
electrical contacts. They will damage the device.
1. Slightly dampen a cotton swab with 70% isopropy! alcohol.

2. Remove the thermometer from the dock and clean the metal electrical contacts on
the thermometer with the cotton swab.

3. Place the thermometer aside for 1 minute, allowing the contacts to air dry.
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4. Clean the metal electrical contacts on the device dock with the cotton swab.

()

5. Allow the contacts to air dry for 1 minute.

6. Return the Braun thermometer to the dock.

Decontamination and cleaning requirements for returns

As a general safety precaution, the monitor must undergo decontamination before being
returned to Welch Allyn for service, repair, inspection, or disposal. Cleaning is an
essential prerequisite for effective disinfection or decontamination. Follow the cleaning
instructions presented earlier in this section.

Note Contaminated items must not be returned without prior, written
agreement.
Note Decontaminate the monitor according to your facility’s procedures and local

regulations.
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Device configuration and setup

Configuration overview

A configuration file can be created that specifies preferences for all Connex Spot Monitor
options. When powered on, the monitor recognizes all available options and features and
applies the associated configuration file preferences.

If no customized configuration file has been loaded onto the device, the device applies
factory defaults to all available options. See "Factory defaults" in the Appendix.

In addition to creating or modifying a configuration file, it is possible to change some
settings by navigating to Advanced settings. Changes made in Advanced settings take
effect immediately on the device, but they do not change the configuration file.

Note The device does not support configuration filenames that include

parentheses. If these are present in the filename, the device will not
recognize the file. This is a common issue if you've downloaded the same
file multiple times from your web browser. For example, the web browser
may automatically rename "MyFile.config" to "MyFile.config(2)" if you
download it a second time. If this happens, rename the file by deleting the
parentheses; then it will appear in the list on the CSM.

The remainder of this section instructs you how to do the following:

Edit a configuration file

Copy a configuration file

Download a configuration file to install on another device
Create a new configuration file

Install a configuration file

Edit a configuration file

To edit a saved configuration file, complete the following steps:

1.
2.

Access the Configuration Tool at http://config.welchallyn.com.

Log in with a username and password.

3. Click List Configurations on the navigation bar.

\)
4. Locate the configuration file to be edited in the list, and click the L’ on the right

side of the table to launch the editor.


http://config.welchallyn.com
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5. Under Progress Summary, locate the section you want to edit (Clinical, Informatics,
IT, or Biomed) and click the specific step you want to edit.

Review the selections in each step and modify them as desired.

Click SAVE AND CONTINUE to accept the changes or BACK to return to the
previous screen without saving.

Clicking SAVE AND CONTINUE automatically moves you to the next step in that
section of the Progress Summary. When you reach the last step in a section,
cllicking SAVE AND CONTINUE returns you to the Progress Summary.

8. Repeat steps 5 through 7 until you complete all desired edits.

Click List Configurations on the navigation bar to see a new date stamp in the
Updated column for your configuration file.

Copy a configuration file

To copy a saved configuration file, complete the following steps:

Access the Configuration Tool at http://config.welchallyn.com.

2. Log in with a username and password.
Click List Configurations on the navigation bar.

4. Locate the configuration file to be copied in the list, and click the L on the right
side of the table.

5. Either accept or enter a new name for the copied file in the Copy Configuration
dialog, then click Copy.

6. Observe your new configuration file on the List Configurations tab.

Download a configuration file to install on another device

To download a saved configuration file, complete the following steps:
From the Configuration Tool

Access the Configuration Tool at http://config.welchallyn.com.

2. Log in with a username and password.
Click List Configurations on the navigation bar.

4. Locate the configuration file to be downloaded in the list, and click the @ on the
right side of the table.

The configuration file downloads to the tray on your PC.

5. Using the dropdown menu on the right side of the downloaded file, select Show in
folder.

Windows Explorer opens the Downloads folder with the most recent download
selected.

6. Copy the downloaded configuration file to a USB flash drive.

See "Install a configuration file" for instructions to load this configuration on another
device.


http://config.welchallyn.com
http://config.welchallyn.com
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Create a new configuration file

To create a new configuration file, complete the following steps:

o -

10.
11.

Access the Configuration Tool at http://config.welchallyn.com.

Log in with a username and password.

Click New Configuration on the navigation bar.

Select Connex Spot Monitor as the product you would like to configure.
Enter a user-friendly name for your configuration, then click CONTINUE.

The Configuration Tool advances to the Product Use Location screen.
Select your location type, then click SAVE AND CONTINUE.

The Progress Summary screen appears.
Under Progress Summary, click the first step you want to configure.
Review the selections in each step and modify them as desired.

Click SAVE AND CONTINUE to accept the selections or BACK to return to the
previous screen without saving.

Clicking SAVE AND CONTINUE automatically moves you to the next step in that
section of the Progress Summary. When you reach the last step in a section,
cllicking SAVE AND CONTINUE returns you to the Progress Summary.

Repeat steps 7 through 9 until you configure each section.

When you are finished, click List Configurations on the navigation bar to see your
configuration file.

Install a configuration file

To install a configuration file, you must first download the configuration file to a USB
flash drive. If you have not done so already, complete the steps in "Download a
configuration file to install on another device," then complete the following steps:

1. Insert the flash drive into the device which needs to have the configuration loaded
onto it.

A pop-up dialog appears listing the configuration file(s) on your flash drive.
2. Select the desired configuration file and touch Load.
Repeat this process on as many devices as you wish.


http://config.welchallyn.com
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Functional verification and calibration
overview

Functional verification tests

The functional verification tests help to confirm the proper operation of the device and its
options. The tests may also be useful as a diagnostic tool to help isolate a malfunction. It
is not necessary to disassemble the device to perform these tests.

For periodic service, you can—at a minimum—perform the basic functional verification
tests described in this manual. If you have the Gold edition of the service tool, you have
the additional capabillity to perform a complete functional verification and calibration of
the device, but this is not required for minimal periodic service.

In contrast, any time you open the device case, you must use the service tool, Gold
edition, to perform a complete functional verification and calibration of the device before
returning the device to service.

Note For instructions on using the Gold edition, see the service tool help files.

About the Welch Allyn Service Tool

The service tool is required to complete functional verification and calibration tests. The
service tool is available in the following editions:

e Standard unlicensed edition: Enables NIBP functional verification tests to satisfy
the recommended annual service. If any Standard unlicensed edition testing shows
an out-of-specification result, use the Gold edition to perform a full calibration.

¢ Gold edition: Checks the functionality and calibration of the device. As it checks the
device, the Gold edition also performs any needed calibration to bring the device
within specifications. This full suite of tests is required to complete a repair. Each
time you open the case, you must use the Gold edition to test the device before
returning the device to normal use.

For information about the service tool, see the following:

e Forinstructions on installing and using the service tool, see the Welch Allyn Service
Tool Installation and Configuration Guide.

e To use the Standard unlicensed edition to test the NIBP module, follow the
instructions in this service manual.

e Forinstructions on using the Gold edition, see the service tool help files.
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Standard unlicensed edition service tool tests performed

The service tool performs the following functions on the host device and installed

options.
Test Description NIBP Temp Sp02 Host APM
Reads firmware Displays the firmware version V4 V4 V4 J J
Firmware upgrade Loads the latest firmware into the module 4 J
Leak test Verifies leaks using 100 cc volume V4
Accuracy test (NIBP) Checks the accuracy of transducers across the N4

pressure range
Overpressure test Verifies the maximum cuff pressure for adults V4

and neonates
Charge LED Verifies the LED V4
Bin light Verifies on/off light V4

Gold edition service tool tests performed
The service tool tests the host device and installed options as listed in the following

table.
Test Description NIBP Temp Sp02 Host APM
POST Performs the power-on self test (POST)' V4 V4 V4 V4
Firmware version Checks the firmware version N4 v v 4 J
Firmware upgrade Loads the latest firmware into the module J V4
Leak Verifigs leaks using 100 cc volume V4
AD noise Checks noise on the pressure channel V4
Calibration Calibrates pressure transducers N4
Accuracy (NIBP) Checks the accuracy of transducers across the 4

pressure range
Dump Checks dump valves V4
Pump inflation Verifies the pneumatic pump

Overpressure Verifies pump limits
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Test Description NIBP Temp Sp02 Host
Probe detect Verifies the operation of the probe detect

switch?
Accuracy (Temp) Verifies the accuracy of the thermometer across

range

Temperature functional  Verifies temperature module with cal-key?
check

Sp02 functional check  Verifies module operation with an Sp02

simulator

Display Verifies video output J
Back light interface Verifies display LED back light 4
Touchscreen interface  Verifies touchscreen calibration 4
LED Verifies the LED V4
Beeper Verifies the buzzer V4
Nurse call relay Verifies the nurse call relay V4
Battery operation Verifies the internal battery V4
Speaker Verifies the speaker V4
USB hos_t port Verifies the USB ports J
communication

Ethernet communication  Verifies the Ethernet port 4
Wireless communication  Verifies the wireless radio 4

Bluetooth communication Verifies the Bluetooth radio

Charge LED Verifies LED

Bin light Verifies on/off light

T POST testing checks the following:

e NIBP: ROM, RAM, A/D channels, calibration, and user configuration.

e Temperature: ROM, RAM, calibration, and heater.
e Sp02: ROM and RAM, and connection to the SpO2 board.

2 SureTemp Plus only.

3 Normal mode.
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Electrical safety testing

Welch Allyn recommends performing ground continuity and leakage current tests after
all open-case repairs and dielectric strength testing is not recommended.

Note Perform dielectric strength testing only if there is a reason to doubt the
integrity of the electrical insulation (e.g. multiple trips of a residual-current
device or liquid ingress of a saline solution). If you determine this test
should be performed, return the device to Welch Allyn for service.

These recommendations trace to EN/IEC 60601-1 — Medical Electrical Equipment — Part
1: General Requirements for Basic Safety and Essential Performance or EN/IEC 62353 -
Medical Electrical Equipment — Recurrent Test and Test After Repair of Medical Electrical
Equipment.

Because of the variability of test equipment in the field, Welch Allyn does not include
specific instructions to perform electrical safety tests. When performing electrical safety
tests, refer to your test equipment manuals for detailed instructions to ensure proper
test equipment setup that aligns with the appropriate standard. The following table
provides connections and test limits to assist you in performing these tests.

Test Limits

Ground continuity (see Note above) Ground continuity from EP stud (equipotential terminal)* to the Gnd pin of the
IEC power connector shall be no greater than 0.1 ohms.

Leakage current (see Note above) Leakage current shall be less than 500 pA from EP stud* to mains (Line and
Neutral pins of the IEC power connector).

Insulation resistance Dielectric strength shall be 500 V (DC) EP stud* to IEC mains (Line and Neutral
pins of the IEC power connector), and insulation resistance is measured.

*To locate the equipotential terminal, see “Controls, indicators, and connectors."

Devices with an External Power Supply

The power bricks are CB Certified and UL Listed; they meet ALL of the requirements
that the Medical Device standard requires for power supplies. The manufacturer is
required to perform 100% electrical safety testing on all of their power bricks prior to
shipment. Welch Allyn does not perform nor recommend testing on these external
power bricks because additional testing would put undue stress on the insulation system
and possibly cause premature failures in the field. Open case repairs of devices with
external power supplies are only dealing with DC circuitry and robust isolation circuits
built into the printed circuit boards. No additional after-servicing testing is required in that
instance. The patient isolation systems within the device (Temperature Probe, SpO2
sensor, CO2 sensor, ECG sensor, etc.) all have visible isolation gaps built into the printed
circuit board. The quality control on the PCB and the thorough type-testing performed by
the testing agency (ETL) eliminates the need for further testing on the devices that are
downstream from the mains isolation device.

Devices with an Internal Power Supply

The internal power supplies are CB Certified and UL Registered. These power supplies
are an open frame style (no protective enclosure). Therefore, the products that contain
an internal power supply require electrical safety testing. Open case repairs of devices
with an internal power supply require the recommended testing because those devices
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contain the open frame power supply, and the testing involves the manipulation of wiring
that carries 120 or 240 volts AC. Welch Allyn does not recommend HiPot / Dielectric
Withstand testing because of a potential stress on the insulation system, which could
cause premature failures.

Ground stud connector

The Connex Spot Monitor and the APM work surface are equipped with a ground stud
(equipotential terminal) for electrical safety testing, and to connect a potential
equalization conductor. To ensure use of the proper connector for safety testing, the
ground studs are recessed into the device and APM work surface housings. Do not use
“alligator” style clamps or connectors. The mating electrical connector requires self
assembly by crimping it to appropriate connecting leads.

The mating connector (Type POAG-KBTBDIN, order number 15.0010) consists of the
right-angled socket and insulator, as shown in the next figure. You can purchase the
mating connector and the crimping pliers from the manufacturer, Multi-Contact (http:/
www.multi-contact.com).

I
® ©)

Item Description Type Order no.
(®  The mating electrical connector, a right-angled socket made of nickel- ~ POAG-WB6DIN 01.0404
plated brass with Multilam™ made of gold-plated, hard-drawn copper
alloy.
@  Insulator T-POAG6 15.5004-24
Crimping pliers with mandrel crimp for 4 mm2 and 6mm?2 flexible POAG-PZ-N 14.5009
conductors.

Basic functional verification

Basic functional verification checks

Note Calibration is available only with the service tool, Gold edition.

These tests verify basic functionality of the NIBP, SpO2, and thermometry parameters.
These tests support the requirements of routine preventive maintenance. However, they
are not a substitute for the complete functional tests available with the service tool, Gold
edition. Welch Allyn recommends using the service tool, Gold edition, to perform
preventive maintenance and verification of the device when completing a repair.

Basic functional verification tools

The list of tools below is what Welch Allyn uses to perform a basic device functionality
check. Most facilities use a device simulator or equivalent products to perform this test.


http://www.multi-contact.com
http://www.multi-contact.com
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Material no. Description Qty Component

407672 BP test volume repair fixture 113670 1 NIBP

N/A Sp02 simulator 1 Sp02

DOC-10 Nellcor Sp02 extension cable 1 Nellcor Sp02

06138-000 Cal-key, assembly, M690/692 1 SureTemp
Thermometry
Module

N/A Pressure meter (must include at least two decimal points and be accurateto 1 NIBP

within £0.5 mmHg)
6000-30 Single-tube blood pressure hose, 5 feet 1 NIBP
N/A PC running Windows XP SP3, Windows 7, or Windows 8 1 Al

web download

Welch Allyn Service Tool

NIBP, Software

welchallyn.com/en/service-support/service-center/service-tool.html updates
N/A Blood Pressure Y-tube 1 NIBP
620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 NIBP

NIBP test setup

For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment
shown below. Connect the manifold to the volume repair fixture as indicated by the
service tool or the test procedure.

No. Item No. Item
1 Test volume repair fixture with test manifold, 4 Device
bulb, and valve
2 Pressure meter (must include at least two 5 USB 2.0/5-pin type A to mini-B cable

decimal points and be accurate to within £0.5
mmHg)



http://welchallyn.com/en/service-support/service-center/service-tool.html
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No. Item No. Item

3 Blood pressure Y-tube 6 PC

Create a blood pressure Y-tube

=

The blood pressure Y-tube is a piece of custom test equipment that connects the device
to the test setup. The Y-tube is composed of a modified blood pressure hose and a Y-
type fitting. Follow these instructions to create a Y-tube.

1. Cut a 4500-30 blood pressure hose approximately 6 inches from the connector that
connects to the device.

2. Split the end of the dual-lumen hose to create two separate hoses. Make sure not to
puncture either hose.

3. Insert one end of the Y-type fitting into each end of the hose.

NIBP tests

For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment
according to the test setup diagram for your configuration presented earlier in this
section. Connect the manifold to the volume repair fixture as indicated by the service
tool or the test procedure.

NIBP leak test (Standard unlicensed edition)

The NIBP leak test is performed automatically using the service tool. The leak test
pressurizes the system with a start pressure (Pg) of 250 mmHg + 10 mmHg. After 15

seconds (Ty) the end pressure (Pg) is measured. The leak rate is calculated using the
formula L = (Pg — Pg)/ Ti. The test fails if the leak rate exceeds 5 mmHg in 15 seconds.

Perform an NIBP leak test

Set up the test equipment.
Launch the service tool on the PC.
If the simplified interface is active, choose the Service option.

Ao -

Log on with your user ID and password or with ADMIN as the user ID and leave the
password field blank.

Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

Click Leak Test in the NIBP Sensor pane on the right side of the window.
. Follow the prompts until the test completes.

0. Click Close.

= © 0 N O o
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11. To view the results, open the active log file by selecting File > View Log File >
Active log file > Ok.

12. To record the results of your test, go to “Service record.”

NIBP overpressure test (Standard unlicensed edition)

The NIBP overpressure test is performed automatically using the service tool. The
overpressure test verifies that the NIBP system will prevent the pressure from
exceeding 329 mmHg in adult mode and 164 mmHg in neonate mode. To pass this test,
the device must shut down the pump and open the valves when the pressure is
between 280 mmHg and 329 mmHg in adult mode, or 130 mmHg to 164 mmHg in
Neonate mode.

Perform an NIBP overpressure test

Note If you are performing this test after performing the NIBP leak test, skip to
step 7.

1. Set up the test equipment.

2. Launch the service tool on the PC.

3. If the simplified interface is active, choose the Service option.

4. Log on with your user ID and password or with ADMIN as the user ID and leave the

password field blank.

Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

In the NIBP Sensor pane on the right side of the window, click Over Pressure Test.
Follow the prompts until the test completes.

0. Click Close.

1

. To view the results, open the active log file by selecting File > View Log File >
Active log file > Ok.

12. To record the results of your test, go to “Service record.”

oS 00N oo

NIBP accuracy check (Standard unlicensed edition)

The NIBP accuracy check is performed manually using the service tool to control the
valves. The accuracy check compares the reading from the primary transducer pressure
shown in the service tool window with the reading from an external calibrated digital
pressure meter. The results of this check are not recorded in the service tool log file. To
record the results for your records, copy the table in the service record section of the
service manual. If a calibration is required, run the NIBP calibration included with the
Gold edition of the service tool.

& WARNING Patient safety risk. If the primary transducer fails, the system
might not identify an overpressure condition at the right limit, causing injury
when the device is re-connected to a patient. To ensure patient safety,
Welch Allyn recommends that a qualified service technician perform a full
functional verification and calibration on an annual basis.
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& CAUTION Equipment calibration error can occur. This accuracy check
verifies only the accuracy of the primary transducer. If the safety
transducer is out of calibration, a calibration error can occur due to the
pressure difference between the primary transducer and the safety
transducer. To avoid equipment calibration errors, Welch Allyn
recommends that a qualified service technician perform a full functional
verification and calibration on an annual basis.

Perform an NIBP accuracy check

Note If you are performing this test after performing a previous NIBP check, skip
to step 7.

1. Set up the test equipment.

2. Launch the service tool on the PC.

3. If the simplified interface is active, choose the Service option.

4. Log on with your user ID and password or with ADMIN as the user ID and leave the

© N o O

9.

10.
11.
12.

13.

14.

15.

16.

17.

18.

19.

20.
21.

password field blank.

Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

Click Accuracy Check in the NIBP Sensor pane on the right side of the window.
Connect the 500 CC volume.

Turn on the pressure meter and zero if necessary.

Check the accuracy at 0 mmHg.

Record the reading on the pressure meter and the service tool and compare the
results.

Using the hand bulb, pressurize the NIBP system to 50 mmHg + 5 mmHg and allow
10 seconds for the pressure to stabilize.

Record the reading on the pressure meter and the service tool and compare the
results.

Using the hand bulb, pressurize the NIBP system to 150 mmHg = 5 mmHg and
allow 10 seconds for the pressure to stabilize.

Record the reading on the pressure meter and the service tool and compare the
results.

Using the hand bulb, pressurize the NIBP system to 250 mmHg + 5 mmHg and
allow 10 seconds for the pressure to stabilize.

Compare the reading on the pressure meter to the service tool reading and record
the results.

Click Open valve to open the NIBP valves. Verify that the pressure on the meter and
service tool change to zero.

Click Done to complete the check.
To record the results of your test, go to “Service record.”

Perform an NIBP accuracy test without the Welch Allyn Service Tool

The following tools are required to perform this test:

CSM with SWF ver. 1.33.00-X0006 or greater
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SpO02 tests

Blood Pressure Bulb
Pressure Meter

Dual Lumen Pressure Tubing
Pressure Test Box

Navigate to the Advanced tab.
In the Advanced settings code box, enter 6345.

Navigate to Service > General.

The NIBP Pressure Verification feature is located in the bottom right of the screen.
Connect the dual lumen tubing to the device.

Connect one end of the tubing to the pressure meter and the other end to the test
box. Ensure each end is connected tightly and there are no leaks.

To initiate the verification process, touch Close Valve.

Use the blood pressure bulb to adjust the pressure to each threshold of
20/50/100/150/250 mmHg.

Compare the pressure displayed on the NIBP Pressure Verification screen and the
pressure meter.

Select the procedure here that applies to your configuration to test the device's SpO2
function. Connect the test equipment according to the test setup diagram for your
configuration presented here.

SpO02 test setup

For the SpO2 test, connect the test equipment shown below.
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No. Item

1 Connex Spot Monitor
2 Sp02 simulator

3 Power supply

Perform an SpO2 test

Use this procedure to test only the device SpO2 function.

6.

Power on the device.
Connect the SpO2 functional simulator to the SpO2 input connector.

Note In the following tests, if the simulator defaults are outside
the device alarm limits, adjust the limits or silence the
alarms.

Adjust the simulator settings as follows:

For Nonin and Nellcor configurations, set the simulator SpO2 saturation to 90% and
pulse rate to 60 bpm.

For Masimo configurations, set the simulator SpO2 saturation to 81% and pulse rate
to 60 bpm.

Give the device up to 30 seconds to stabilize.

Verify the displayed saturation and pulse rate as follows:

For Nonin and Nellcor configurations, saturation should be 90% +1 sat point, and
pulse rate should be 60 £1 bpm.

For Masimo configurations, saturation should be 81% +3 sat point, and pulse rate
should be 60 £1 bpm.

Disconnect the simulator.

Thermometry tests

Thermometry test setup

For the thermometry test, connect the test equipment shown below.

Note The drawing shows a SureTemp Plus configuration, but the setup for a

Braun ThermoScan PRO 6000 configuration is identical minus the Cal-key.
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No. Item No. Item
1 Connex Spot Monitor 3 Tester, calibration, 9600 Plus
2 Power supply 4 Cal-key, assembly, M690/692

(used only with SureTemp)

SureTemp temperature system test

The SureTemp temperature system test is performed using a calibration key (cal-key).
The calibration key tests the system using a fixed resistance to display a temperature of
97.3+0.2°F (36.3 £ 0.1 °C).

Note If your facility requires you to test the temperature probes, you will also
need to have heaters at three temperature settings to test the probes. See
"SureTemp temperature probe and system test."

Perform a SureTemp temperature system test

1. With the system power on and the temperature probe in the well, disconnect the
probe cable from the temperature input connector on the front of the device.

2. Connect the calibration key to the temperature input connector.
. Remove the probe from the well.
4. Verify that the displayed temperature is 97.3 + 0.2 °F (36.3 =0.1 °C).
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SureTemp temperature probe and system test

Use this procedure to test the temperature function while verifying the temperature
probe. To achieve accurate results, you must perform this test with the device in Direct
mode.

Test each probe at the low, medium, and high set points on the tester. Repeat the
procedure for each thermometer and temperature to test.

Set up the 9600 Plus calibration tester
Place the tester on a level surface away from sunlight, drafts, and other sources of heat
or cold.

The tester takes approximately 20 minutes to heat to the lowest set point.

To expedite testing, Welch Allyn recommends the following practices:

e To eliminate waiting for the tester to heat to the next set point, use three testers,
each set to one of three different set points.

e When using only one tester to test several thermometers at all three temperatures,
test all thermometers at one set point before proceeding to the next set point.

e To eliminate waiting for the tester to cool down, start at the lowest set point.
Because the tester does not have an internal fan, it requires more time to cool down
than to heat up.

Change the 9600 Plus set point
To scroll from one set point to the next, press and hold the Temperature Selection
button until a beep sounds.

The new set point appears in the upper left corner of the display. The device's current
temperature appears, flashes, and continues flashing until the cavity reaches equilibrium
at the new set point. The 9600 Plus beeps when the set point is reached.

Perform a SureTemp temperature probe and system test
1. Set the 9600 Plus to the desired set point and wait for the display to stop flashing.

2. Insert the temperature probe, without a probe cover, into the thermistor device port
on the tester.

When appears on the display, touch it to switch to Direct mode.
Wait for up to two minutes for the temperature reading to stabilize.
Record the results in the temperature service record.

Return the temperature probe to the probe well on the device.

N o o s~

Repeat the procedure as necessary until all thermometers are tested at each
temperature.

To record the results of your test, go to "Service record."

Braun ThermoScan PRO 6000 thermometer test

This explains how to perform a functional verification on the Braun ThermoScan PRO
6000 thermometer using the 9600 Plus Calibration Tester.
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Note

Use this procedure with the Welch Allyn Service Tool version 1.8.0.0 and
later.

& CAUTION Before the test, place thermometers and tester in the same

room for approximately 30 minutes so that they adjust to the ambient
temperature.

For more information, see the Welch Allyn 9600 Plus Calibration Tester Directions for

use.

Perform a Braun ThermoScan PRO 6000 functional verification test
Complete the preliminary checks as described in step 1, then test each thermometer at
the low, medium, and high set points on the tester. After placing the thermometer in
calibration mode, repeat the procedure from step 4 for each thermometer and
temperature to be tested.

1. Before testing the thermometer verify the following:

a.

e.

The sensor (probe tip) is functional. Check the position of the sensor with a
magnifying glass if necessary. If the sensor is displaced, the unit is damaged and
must be replaced. There should be no visible gap between the bezel and the
lens.

The sensor is clean. Clean the sensor using a Q-tip lightly moistened with
isopropyl alcohol, using a minimum amount of pressure to avoid displacing the
sensor. Use a d:ry Q-tip to remove any excess alcohol. Allow 5 minutes for any
remaining alcohol to evaporate.

The room temperature is within the range of 65.0°F (18.3°C) to 80.0°F (26.7°C).

The thermometer is allowed to reach the ambient room temperature. Remove
the thermometer from the product packaging and wait at least 30 minutes
before beginning the test.

The thermometer is fully charged.

2. Place the thermometer from sleep mode into calibration (CAL) mode as follows:

a.
b.

Remove the device from the dock.

Wait for 20 seconds for the device to go into sleep mode (the display goes
blank).

Press and release the C/F button.

When the self check/startup display appears, press and hold the C/F and Mem
buttons for 5 to 7 seconds.

When the device beeps, release the C/F and Mem buttons.

If the device is in CAL mode, the display will alternate between the '- -’ lines and
“CAL".

If the device doesn't enter CAL mode, wait for the device to return to sleep
mode and repeat from substep c.

3. Apply a new probe cover. Place the probe firmly into the Ear Device Port.

4. Wait approximately 3 seconds, and then press the thermometer Measure button.

The ExacTemp light flashes.

Leave the thermometer in the tester until a long beep sounds.

Remove the thermometer from the tester and read the temperature in the
thermometer’s display. If the temperatures are within £0.2 °C (£0.4 °F) of the
tester’s set point, the thermometer is within calibration.
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Record the results in the thermometer service record.
Press the Measure button once to clear the previous reading.

Wait 1 minute, and then take another reading with the same thermometer. Repeated
measurements in short sequence might cause higher readings.

Note If using only one tester, test all available thermometers for
calibration verification at the current set point, before raising
the set point.

10. Repeat the procedure from step 3 as necessary until all thermometers are tested at
each temperature.

11. Exit CAL mode using one of the following methods:

¢ Press and hold the C/F and mem buttons until you hear the beep and the display
is blank.

e Wait and don't press any buttons for 10 minutes. The thermometer
automatically exits CAL mode.

To record the results of your test, go to “Service record.”
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Service record

Connex® Spot Monitor

Date: Time:
Device name: Serial number:
Technician: Service tool version:

NIBP tests

Leak test

Specification

Actual reading Pass Fail

Max: 5

Overpressure test

Mode

Specification

Actual reading

Adult mode:

Neonate mode:

NIBP accuracy check
Target pressure + 5 mmHg Pressure meter  Service tool Specification Pass Fail
0 mmHg mmHg +1 mmHg
50 mmHg mmHg +3 mmHg
150 mmHg mmHg +3 mmHg
250 mmHg mmHg +3 mmHg
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SpO02 tests

Masimo SpO2 tests

Test Specification Actual reading Pass Fail
Sp02 heart rate Pulse rate 60 +1 bpm bpm

60 bpm 59 to 61 bpm

Sp02 saturation Saturation 81% +3% sat point %

81% 78 t0 84%

Nonin or Nellcor SpO2 and pulse rate test

Test Specification Actual reading Pass Fail
Sp02 pulse rate Pulse rate 60 +1 bpm bpm

60 bpm 59t0 61 bpm

Sp02 saturation Saturation 90% +1 sat point %

90% 8910 91%
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Thermometry tests

Calibration key temperature test for SureTemp Plus

Temperature test Specification + 0.2°F (+ 0.1°C) Actual reading Pass Fail

97.3 °F (36.3°C) 97.110 97.5°F 36.2 to 36.4°C °For°C

SureTemp Plus test

Temperature tested  Specification + 0.2 °F (+ 0.1 °C) Actual reading Pass Fail
96.8 °F (36.0 °C) 96.6°Ft097.0°F  359°Ct036.1°C °For°C
101.3 °F(38.5 °C) 101.1°Ft0 101.5°F 38.4°Ct038.6 °C °For°C
105.8 °F (41.0 °C) 105.6 °F to 106.0 °F 40.9°Cto 41.1°C °For°C

Braun ThermoScan PRO 6000 test

Temperature tested Specification + 0.4 °F (+ 0.2 °C) Actual reading Pass Fail
96.8 °F (36.0 °C) 96.4°Ft097.2°F  358°Ct036.2°C °For°C
101.3 °F (38.5 °C) 100.9°Ft0 101.7 °F 38.3°Ct038.7 °C °For°C

105.8 °F (41.0 °C) 105.4 °Ft0 106.2 °F 40.8°Cto41.2°C °For°C
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Full functional verification and calibration

Functional verification test setup

Connect the test equipment to your device as shown in these drawings to complete the
functional tests described in this section.

Option 1. Configurations with Accessory Power Management (APM)

@
O
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J 1
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Option 2. Configurations without Accessory Power Management (APM)

@)
SRt
@

e.@

NIBP e<> || =% & Sp02
B |

@@w .

Required Welch Optional Welch
Allyn purchase Allyn purchase

Item Material
No. No. Description aty (see Notes)
1 Varies Connex Spot Monitor 1 X
2 N/A Wireless router, a/b/g or equivalent 1
3 N/A Ethernet cable 1
4 N/A Ethernet cable 1
5 N/A PC running the Welch Allyn Service 1
Tool on Windows XP SP3, Windows
7, or Windows 8
6 N/A Sp02 simulator 1
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Required Welch Optional Welch
Allyn purchase Allyn purchase

Item Material
No. No. Description Qty (see Notes)
7 Doc-10 Nellcor Sp02 extension cable 1 X
8 Varies APM (configurations with Accessory 1 X
(Option 1) Power Management)
8 Varies Power supply (configurations with no 1 X
(Option 2)
9 106270 Service test box 1 X
10 106275 Micro USB cable 1 X
" N/A Pressure meter (must include at least 1
two decimal points and be accurate
to within 0.5 mmHg)
12 407672 Test volume repair fixture (113670) 1 X
with test manifold, bulb, and valve
13 N/A Blood pressure Y-tube 1 See instructions for creating the Y-tube in
the Basic functional verification section.
14 01802-110 Tester, calibration, 9600 Plus, 3 X
SureTemp
15 06138-000 Cal-key, assembly, M690/692 1 X
Note All items listed in this table are required to complete a full functional verification and calibration. If
Welch Allyn does not make an item available for purchase, you must provide it yourself.
Note You may substitute items marked as an optional Welch Allyn purchase with comparable OEM

products.

Full functional verific

ation check and calibration tools

The list of tools below is what is required to perform a full device functionality check and
calibration. The tools are used in conjunction with the Welch Allyn service tool, Gold

license, to perform a device calibration.

Material no. Description Qty Component

01802-110 Tester, calibration, 9600 Plus 3 Braun
ThermoScan
PRO 6000 &
SureTemp Plus
probes

407672 BP test volume repair fixture 113670 1 NIBP
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Material no. Description Qty Component

N/A Sp02 simulator 1 Sp02

06138-000 Cal-key, assembly, M690/692 1 SureTemp Plus
Thermometry
Module

N/A Pressure meter (must include at least two decimal points and be accurateto 1 NIBP

within 0.5 mmHg)

DOC-10 Nellcor Sp02 extension cable 1 Nellcor Sp02

106270 Service test box 1 Nurse Call, USB
ports

N/A Ethernet cable 1 Ethernet Test

106275 Micro USB cable 1T Al

6000-30 Single tube blood pressure hose, 5 feet 1 NIBP

N/A Wireless router, a/b/g or equivalent 1 Wired &
Wireless Test

N/A PC running Windows XP SP3, Windows 7, or Windows 8 1 Al

1001120 Welch Allyn Service Tool Gold license 1 NIBP, Software

updates

web download

Welch Allyn Service Tool
welchallyn.com/en/service-support/service-center/service-tool.html

NIBP, Software
updates and

calibration
4500-30 Blood pressure hose, 5 ft. 1 NIBP
620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 NIBP

Initialize the NIBP board

Functional verification and calibration must be performed each time the device is
disassembled or more frequently if your facilty's procedures require a full calibration on a
specified basis. If you have just replaced a Main PCA board, your first step before
performing a full verification and calibration is to initialize the NIBP Board.

Set up the equipment for full functional verification as shown earlier in this section.

2. Log in to the Welch Allyn Service Tool, highlight your device in the Device list, and
click Select.

This action opens the Connex Spot Monitor > Device information subtab.
Depending on your configuration, it could take 30-45 seconds to populate this

subtab.

3. Select the Verify and calibrate subtab.

Select NIBP sensor in the Device field.
5. Click Calibrate.


http://welchallyn.com/en/service-support/service-center/service-tool.html
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This opens the Verify and calibrate NIBP Sensor dialog.

Click Begin.

A list of tests appears in the left pane of the dialog along with three controls in the
right pane.

Click Initialize NIBP Board in the right pane.

A confirmation window appears with the message, "Are you sure you want to reset
the calibration offsets of the NIBP Board?"

Click Yes.

This action places two tests in the queue for initialization: the Power Calibration Test
— Primary/Safety and the Pressure Calibration — Primary/Safety.

Note A message appears in the right pane to indicate the first test
is in progress. If the test passes, a green check appears to
the left of the test name, and the second test begins. If the
test fails, a red check appears to the left of the test name,
followed by a prompt to rerun the test. You cannot proceed
to the second test until the first test passes.

Rerun the Power Calibration Test as needed until the test passes.

. If you did not set up your equipment for a full calibration intially, connect the 500cc

volume to the device when prompted and then click Next.

Note Your cannot initialize the board without setting up the
equipment for the Pressure Callibration test.

Observe the pressure calibration messages onscreen and follow the onscreen
prompts to manually adjust device pressure with the hand bulb to 250 + 5 mmHg.

Once you reach the targeted pressure, enter the exact value on the pressure meter
in the Meter pressure field, then click Next to record this value.

If the test passes, a green check appears to the left of the test name. If the test fails,
a red check appears to the left of the test name, followed by a prompt to rerun the
test.

Rerun the Pressure Calibration test as needed until the test passes.
If the second test passes, click Close.

The NIBP board is now initialized.
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Options and upgrades

Welch Allyn supports option and software upgrades for all models.

Note Software in the Braun ThermoScan PRO 6000 is not upgradable in the field
when installed in the Connex Spot Monitor. To upgrade the Braun
ThemoScan PRO 6000 software, return the monitor to a service center.

Option upgrades for devices still under warranty that require any installation inside the
device must be performed by a Welch Allyn service center unless you participate in the
Partners in Care Biomed Partnership Program. If you want to install the options, we
recommend you attend either the classroom or online technical training course for the
device. The training is required to be eligible to receive the Welch Allyn Service Tool Gold
edition. The Gold edition is required to verify that the device is functioning correctly after
it has been serviced. Although all of the option upgrades are calibrated and tested before
leaving the factory, Welch Allyn recommends performing a complete functional test
whenever the device is serviced.

Note For the Welch Allyn Service Tool to support updates and upgrades, adjust
your firewall settings to permit access for IP address 169.254.10.10 (the
local feed server for the software upgrade process).

Software upgrades, when available, can be purchased or provided at no charge if your
device is covered by a Welch Allyn Service Agreement. The upgrades can be installed by
either a Welch Allyn service center or by using the service tool, Standard unlicensed or
Gold edition.

If you choose to install software upgrades on your own, you will receive the software
through the internet. When ordering software, provide the serial number of the device
you want to install the software on.

Note The device must be plugged in to AC power and have at least 15 minutes
of battery charge remaining to execute software upgrades. You can
download software upgrades on battery power, but you cannot implement
them without AC power.
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Available options

The following options can be added to each model’s base configuration.

& CAUTION Before installing any option, disconnect the patient from the
monitor and power down the device.

Options
Model 7100 7300 7400 7500
Masimo X O [ ] -
Nonin O O X @
Nellcor OxiMax X O [ ] @
SureTemp Plus O O O O
Braun ThermoScan PRO 6000 O O O O
Wireless radio X X O [ )
Bluetooth radio X o X X
" This configuration comes with either Masimo or Nellcor.
2 This configuration comes with either Masimo, Nonin, or Nellcor.
@ Standard with this model. O software upgrade available X No software upgrade available for this

for this model. Hardware upgrade model. Hardware upgrade available only on
available only on a case-by-case @ case-by-case basis.
basis.

Install options

All internal option installations entail opening the device case and performing some
disassembly. Because this process requires disconnecting internal components, \Welch
Allyn requires that the device undergo a full functional test after reassembly and before
placing the device back in service.

Before installing a new option, read information about removing the option in
"Disassembly and repair.” After familiarizing yourself with the process, follow the
instructions in the disassembly section.

Upgrading software with the Welch Allyn Service Tool

The Connex Spot Monitor and the Welch Allyn Service Tool (WAST) interact through
Ethernet over USB technology, enabling the monitor to function as a USB device with
both a network and an IP address. This connection separates logically into two distinct
interfaces: a generic USB serial connection and a Remote Network Driver Interface
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Specification (RNDIS) network interface, which is a Microsoft Windows driver. Most
interactions between the WAST and the Connex Spot Monitor take place over the
generic USB serial connection. In contrast, software upgrades require the RNDIS
interface for the device to connect the WAST and download the firmware.

During software upgrade, the Ethernet over USB interface with the WAST is auto-
configured with the specifications noted in the table below. When the Connex Spot
Monitor reaches out to the WAST for the firmware package, it uses TCP port XXXX. Be
prepared to modify any firewall(s) that prevent incoming connections to allow this traffic.
The WAST attempts to configure the Windows firewall by opening this specific port on
the RNDIS interface. If administrative controls such as a Group Policy Object (GPO) or
third-party software have been implemented to prevent this change, the WAST attempts
to diagnose the problem and then inform you of possible remediation steps. Work with
your IT staff or Network Administrator as needed to enable this functionality.

Interface specifications IP address Network mask
Device Ethernet over USB interface 169.254.10.10 255.255.255.255
WAST RNDIS interface 169.254.10.1 255.255.255.255

At the start of a software upgrade, the Welch Allyn Service Tool creates a local HTTP
server and uses the USB connection to transfer necessary file package to the Connex
Spot Monitor. Once the file package is on the device, it launches the installation of host
controller firmware and reboots the device immediately following the installation. When
the device auto-reboots, the software upgrade of individual modules and sensors (NIBP,
Sp02, and/or Temperature) is complete.

Software rollback capability

The Connex Spot Monitor utilizes a primary and secondary software structure. In the
final step of the software upgrade, the device rolls the previous firmware package to a
secondary image and identifies the newly installed firmware as its primary image. This
structure allows rollback to previous versions as needed. For example, if you performed
a software upgrade and then determined that it didn't meet your expectations or
conform to your workflow, you can execute a software rollback in seconds and limit
device downtime. To roll back your software, follow these steps:

1. Connect the device to your laptop and open the Welch Allyn Service Tool.
Click the Configure tab.

In the Current settings window, click Change....

Click the Device Software Rollback tab.

Click Rollback.

6. Inthe Confirm Device Software Rollback dialog, click Yes to confirm.

ok~ W

In addition, because the software upgrade is already loaded on your device, you can use
the rollback capability at a later time to implement the upgrade and complete the
associated setup activities. Follow the same steps presented above to activate the new
firmware
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Partners in Care service and support agreements

Comprehensive support agreements

Material no. Item

S1-CSM CSM, Comprehensive partnership program, 1 year

S1-CSM-2 CSM, Comprehensive partnership program, 2 years

S1-CSM-5 CSM, Comprehensive partnership program, 5 years

S1-CSM-C CSM, Comprehensive partnership program, 1 years + Calibration
S1-CSM-2C CSM, Comprehensive partnership program, 2 years + Calibration
S1-CSM-5C CSM, Comprehensive partnership program, 5 years + Calibration

Biomed support agreements

Material no. Item

S2-CSM CSM, Biomed partnership program, 1 year
S2-CSM-2 CSM, Biomed partnership program, 2 years
S2-CSM-5 CSM, Biomed partnership program, 5 years

Preventive protection support agreements (available only in selected

international countries)

Material no. Item

S4-CSM CSM, Warranty Extension, 1 year
S4-CSM-2 CSM, Warranty Extension, 2 years
S4-CSM-5 CSM, Warranty Extension, 5 years

Service and repair training

Note Required to be eligible to receive the service tool, Gold edition.

Material no. Item

CSMREP-TRN CSM repair training
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Material no. Item

CSMREPW-TRN CSM repair web training
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Specifications

Physical specifications

Protection classifications, all monitor configurations

Characteristic Specification

Electrical rating 100 —240V AC, 50 — 60 Hz, 0.8X—15A
Duty cycle Continuous operation

Type of protection against electric shock Class | internally powered

Degree of protection against electric shock, for parts Type BF defibrillator proof

applied to patients IEC EN 60601-1, 2nd and 3rd editions
Recovery time following defibrillator discharge Less than or equal to 10 seconds

Flammable anesthetics
& WARNING Not suitable for use with

flammable anesthetics.

Degree of protection provided by the enclosure with respect IPX1 Protection against vertically falling drops of water
to harmful ingress of liquids

Height Standard chassis: 6.3 in. (16.1 cm )
Extended chassis: 6.5 in. (16.6 cm ) with Braun

Extended chassis: 6.4 in. (16.6 cm ) with SureTemp

Width Standard chassis: 9.2 in. (23.4 cm )
Extended chassis: 11.7 in. (29.8 cm ) with Braun

Extended chassis: 11.7 in. (29.8 cm ) with SureTemp

Depth Standard chassis: 2.3 in. (5.8 cm)
Extended chassis: 4.4 in. (11.0 cm ) with Braun

Extended chassis: 4.2 in. (10.6 cm ) with SureTemp
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Protection classifications, all monitor configurations

Weight (including battery)

Standard chassis: 2.91b (1.3 kg )
Extended chassis: 3.7 Ib (1.7 kg ) with Braun

Extended chassis: 3.5 b in. (1.6 kg ) with SureTemp

Graphical display resolution

Dimensional outline

6.5in. (W) x4.1in. (H)x 0.13in. (D) (164.9 mm [H] x 103.8
mm [W] x 3.40 mm [D])

Active area

B6.11in. (W) x 3.4 in. (H) (154.08 mm [W] x 85.92 mm [H])

Resolution

800 x 480 pixels

Pixel arrangement

RGB (red, green, blue)

Pixel size 63.2 pm (W) x 179 pm (H)
Luminance 530 cd/m2
Speaker volume

Minimum Output sound pressure

60 dB at 1.0 meter

Alarm and pulse tones

per |EC 60601-1-8

Pulse frequency (fg)

150 — 1000 Hz

Number of harmonic components in the range 300 Hz to
4000 Hz

minimum of 4

Effective pulse duration (ty)

high priority: 75200 ms
medium and low priority: 125 — 250 ms

Rise time (t;) 10—-20% of ty
Fall time "(t;) <t —t
Note The range of the relative sound pressure level of the harmonic components should be between a

minimum of at least 53 dBa and a maximum of at least 80 dBa at the pulse frequency.

"Prevents overlap of pulses

Environmental specifications

Operating temperature

50°F to 104°F (10°C to 40°C)

Storage temperature

-4°F t0 122°F (-20°C to 50°C)

Operating altitude

-1250 to 10,000 ft. (-381 m to 3,048 m)

Operating humidity

15% to 90% noncondensing
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Storage humidity

15% to 95% noncondensing

USB flash drive requirements

The multiple vendor technologies used in the manufacture of USB flash drives make
some of them incompatible with this monitor. Common issues that cause flash drives
not to function are NTFS formatting, proprietary drive security, and the need for
Windows drivers to run or access them.

The requirements for a USB flash drive to work with this monitor are the following:

e Linux compatibility
e Upto 32 GB storage
e FAT 32 formatting
e USB 2.0 compliant

Dimensions: Assuming the USB flash drive will be inserted in the APM, the length of the
stick does not matter. The size of the stick surrounding the USB metal head should be
no larger than 9.5 mm x 18.5 mm to fit in the USB port.

Welch Allyn recommends the following USB flash drive for use with the Connex Spot
Monitor and the APM work surface: Kingston DataTraveler SE9 32 GB drive, part number

DTSE9H/32GBZ.

Monitor radio

The monitor's radio operates on 802.11 networks.

Wireless network

IEEE 802.11 a/b/g/n

interface
Frequency 2.4 GHz frequency bands 5 GHz frequency bands
2.4 GHz to 2.483 GHz 5.15 GHz to 5.35 GHz, 5.725 GHz to 5.825Ghz
Channels 2.4 GHz channels 5 GHz
Up to 14 (3 non-overlapping); country- Up to 23 non overlapping; country-dependent
dependent,

Authentication/

Wireless Equivalent Privacy (WEP, RC4 Algorithm); Wi-Fi Protected Access (WPA); IEEE 802.11i

Encryption (WPA2); TKIP, RC4 Algorithm; AES, Rijndael Algorithm; Encryption Key Provisioning; Static (40-
bit and 128-bit lengths); PSK; Dynamic; EAP-FAST; EAP-TLS; EAP-TTLS; PEAP-GTC ! PEAP-
MSCHAPv2; PEAP-TLS;

Antenna Ethertronics WLAN_1000146

Wireless data rates

802.11a (OFDM): 6, 9, 12, 18, 24, 36, 48, 54 Mbps

802.11b (DSSS, CCK): 1,2, 5.5, 11 Mbps

802.11g (OFDM): 6, 9, 12, 18, 24, 36, 48, 54 Mbps

802.11n (OFDM,HT20,MCS 0-7): 6.5,13,19.5, 26, 39,52, 58.5, 72.2 Mbps
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Agency approvals

US: FCC Part 15.247 Subpart C, FCC Part 15.407 Subpart E

Europe: EN 300 328 (EDR) (v1.8.1), EN 300 328 (LE) (v1.8.1), EN 301 489-1 (v1.9.2), EN 301
489-17 (v2.2.1), EN 301 489-17 (v2.2.1), EN 62311:2008, EN 60950-1

Canada: (IC) RSS-210 standard. IC 3147A-WBA45NBT based on FCC testing
Singapore: Complies with IDS standard

Protocols

UDP, DHCP, TCP/IP

Data transfer
protocols

UDP/TCP/IP

Output power

39.8TmW typical, country-dependent

Ancillary IEEE
standards

802.11d, 802.11e, 802.11h, 802.11i, 802.1X

TOne time passwords are not supported.

Channel restrictions in the 5-GHz band are determined by country.
To ensure compliance with local regulations, be sure the correct country in which the
access point is installed is selected. This product can be used with the following

restriction(s):

Norway - Does not apply for the geographical area within a radius of 20 km from the
center of Ny-Alesund.

France - Outdoor use is limited to 10 mVW EIRP within the band 2454 to 2483.5 MHz.

Note Effective Isotropic Radiated Power (EIRP).

Note Some countries restrict the use of 5-GHz bands. The 802.11a radio in the
monitor uses only the channels indicated by the access point with which
the radio associates. The hospital IT department must configure access
points to operate with approved domains.

Bluetooth® module

Category Feature Implementation
Wireless Bluetooth 2.1 +EDR
specification

Frequency 2.402 - 2.480 GHz

Maximum transmit power

Class 1
+8 dBm from antenna

Receive sensitivity

-89 dBm

Range Circa 100 meters
Data rates Up to 3 Mbps (over the air)
Host interface USB Full speed USB 2.0
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GPIO Four configurable lines
(1.8V/3.3V configurable by VDD_PADS

Operational modes  HCI Host Controller Interface over USB
HID proxy mode Human Interface Device

EEPROM 2-wire 64K bits

Coexistence 802.11 (WiFi) Three wire CSR schemes supported

(Unity-3, Unity-3e, and Unity+)

Supply voltage Supply 5V +£10%

Power consumption Current Idle mode ~5 mA
File transfer ~58 mA

Antenna option Internal Multilayer ceramic antenna with up to 41% efficiency

Physical Dimensions 8.5x 13 x 1.6 mm (BT800 module)

16 x 43 x 11 (BT820 USB dongle)

Environmental Operating -30°Cto 85°C
Storage -40°Ct085°C
Miscellaneous Lead free Lead-free and RoHS compliant
Warranty 1 year
Approvals Bluetooth Controller subsystem approved

FCC/IC/CE All BT800 series
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Factory defaults

Device

Connex® Spot Monitor

Note Factory defaults are the settings in the device when it comes off the
manufacturing floor. Customized configuration files modify these defaults
based on preferences for specific sites. Restoring default settings on a
device returns it to its manufacturing floor defaults, not the custom

configuration.

Settings Default value
Active Config file name Factory

Device location displayed Yes

First-time startup screen displayed Yes
Touchscreen lockout interval 2 minutes

Auto sleep mode allowed Yes

Sleep mode duration 2 minutes

Auto shutdown allowed Yes

Auto shutdown timeout 15 minutes
Display brightness 5

Touchscreen calibration

55, 57, 4003, 3993, 193, 3910, 200, 3900
(array of 8 integers)

Splash screen

Welch Allyn logo

Load new software on power cycle enabled No

Load new software to device Greyed out
Screen off allowed Yes
Screen off timeout 1 minute
Power line frequency 60’

1 Power line frequency can be modified in the Configuration Tool to support specific parameters like Masimo Sp02. With

both new and existing configurations, follow these steps:

1. Navigate to the Progress Summary page.

2. Scroll down to Section: Biomed (Required) at the bottom of the page and click General Device

Settings.
3. Select Custom.
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Settings

Default value

4. Scroll down to Other on the General Device Settings page and select the desired Power Line Frequency.

5. Click DONE at the bottom of the page.
6. Click SAVE AND CONTINUE.

Data management

General alarms

Settings Default value
Date format MM/DD/YYYY
Prevent date and time changes No

Display date and time Yes

Daylight savings time (DST) enabled No

Device time zone offset (minutes) 0

Configured language English

Office profile option enabled Yes

Intervals profile option enabled Yes

Spot Check profile option enabled Yes

Profile Spot Check
Automatically send confirmed readings on Save No

Delete confirmed readings after successful send No
Automatically send uncomfirmed interval readings No

Settings Default value
Alarm volume Medium

Audio pause time

120 seconds

Minimum alarm volume Low
Alarm condition priority to activate Nurse call Medium
Allow global audio off (Note: Must be enabled in configuration file for No

option to be available,)
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Settings Default value

Alarm audio on and Alarm audio off controls available

Yes (if "Allow global audio off" is enabled
in configuration)

Allow alarms to be disabled Yes
Patient and Clinician information
Settings Default value
Patient
Default patient type Adult
Name format Full name
Primary label Name
Secondary label Patient ID
Require patient ID to save readings No
Clear patient information on manual save Yes
Patient ID match required for save No
Search/Query by patient ID No
Clinician
Clinician ID display format Clinician ID
Require clinician ID to save readings No
Require clinician ID match to save readings No
Retrieve clinician information from clinician 1D No
Require password to save readings No
Clear clinician information on manual save No
Require entry of "required modifiers" to save readings No
Require prescribed login No
NIBP
Settings Default value

Systolic upper limit enabled Yes
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Settings

Default value

Systolic: Upper limit

Adult: 220 mmHg (29.3 kPa)
Pediatric: 145 mmHg (19.3 kPa)

Neonate: 100 mmHg (13.3 kPa)

Systolic lower limit enabled

Yes

Systolic: Lower limit

Adult: 75 mmHg (10.0 kPa)
Pediatric: 75 mmHg (10.0 kPa)

Neonate: 50 mmHg (6.7 kPa)

Diastolic upper limit enabled

Yes

Diastolic: Upper limit

Adult: 110 mmHg (14.7 kPa)
Pediatric: 100 mmHg (13.3 kPa)

Neonate: 70 mmHg (9.3 kPa)

Diastolic lower limit enabled

Yes

Diastolic: Lower limit

Adult: 35 mmHg (4.7 kPa)
Pediatric: 35 mmHg (4.7 kPa)

Neonate: 30 mmHg (4.0 kPa)

MAP upper limit enabled

No

MAP: Upper limit

Adult: 120 mmHg (16 kPa)
Pediatric: 110 mmHg (14.7 kPa)

Neonate: 80 mmHg (10.7 kPa)

MAP lower limit enabled

No

MAP: Lower limit

Adult: 50 mmHg (6. 7 kPa)
Pediatric: 50 mmHg (6.7 kPa)

Neonate: 35 mmHg (4.7 kPa)

Advanced

Default view sys_dia_map
Tube type 2 tubes

Unit of measure mmHg
Algorithm default SureBP

Cuff inflation target (step algorithm)

Adult 160 mmHg (21.3 kPa)
Pediatric 140 mmHg (18.7 kPa)
Neonate 90 mmHg (12.0 kPa)
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Settings Default value
Maximum cycle pressure
Adult Automatic
Pediatric Automatic
Settings Default value
Time between each Automatic interval 15 minutes
Intervals profile default intervals mode Automatic

Office profile intervals mode

Averaging (fixed)

Selected interval parameter NIBP

Automatic mode time interval 15 minutes
Settings Default value
Sp02 upper limit enabled Yes

Upper limit

Adult: 100%
Pediatric: 100%

Neonate: 100%

Sp02 lower limit enabled Yes

Lower limit Adult: 90%
Pediatric: 90%
Neonate: 90%

Default view % Sp02

Advanced

Sp02 alarm condition delay 10 seconds

SatSeconds™ (Nellcor only) 25 seconds
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Settings

Default value

Temperature upper limit enabled

No

Upper limit 101 °F(38.3 °C)
Temperature lower limit enabled No

Lower limit 94 °F (34.4 °C)
Advanced

Unit of measure

°F (Fahrenheit)

Manual parameters

Display temperature conversion Yes
Default SureTemp Plus site Oral
Braun antitheft time undocked before alarm 2 hours
Braun temperature conversion enabled Yes
Braun timer icon enabled Yes
Braun technique compensation algorithm enabled Yes
Braun °F or °C hardware switch enabled (in the battery compartment) Yes
Braun unadjusted mode enabled No
Settings Default value
Custom Score feature active No
Display height Yes
Display weight Yes
Display pain Yes
Display respiration Yes
Display BMI No
Height units in
Weight units Ib
Enable manual override NIBP Yes
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Settings Default value

Enable manual override Pulse rate Yes

Enable manual override Temperature Yes

Enable manual override Sp02 Yes

Settings Options Selections Default value

ESSID selection

Alphanumeric entry (32)

com.welchallyn

Radio mode a/b/g/n, a/b/g, a/n, a only a/b/g/n

Radio enabled Yes /No Yes

Radio alarms enabled Yes /No No

Ethernet MAC address MAC address 00:1A:FA:FF:FC:00
Wireless MAC Alphanumeric entry (18)

Authentication/Encryption
type

Open, WPA Personal(TKIP),
WPA Enterprise(TKIP),
WPA2-Personal(AES/
CCMP), WPA2-
Enterprise(AES/CCMP),
WEP n(could be 64(40),
128(104) specific)

WPA2-Personal

Authentication/Encryption
method

Alphanumeric entry (64)

1234567890ABCDEF123456
7890ABCDEF1234567890A
BCDEF1234567890ABCDEF

Enhanced Auth Protocol

TLS, TTLS, PEAP-

PEAP-MSCHAPv2

(EAP) type MSCHAPv2, PEAP-GTC,

PEAP-TLS, EAP-FAST
Enhanced Auth Protocol Alphanumeric entry (32) vitalsigns
(EAP) identity
Enhanced Auth Protocol Alphanumeric entry (32) password
(EAP) password
Dynamic Frequency Yes /No Yes
Selection
Roaming type PMK Caching, OKC, CCKM 0KC
Server validation eanbled ~ Yes / No No
Auth server type Type 1, Type 2 Type 2
Inner EAP setting type Auto, PAP Auto
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Settings Options Selections Default value
PAC provisioning field Auto, Manual Auto
Active WEP Key number 1,2,3,4 1
WEP Key 1 0123456789

Alphanumeric entry (26)

or

0123456789ABCDEF012345
6789

WEP Key 2
Alphanumeric entry (26)

0123456789
or

0123456789ABCDEF012345
6789

WEP Key 3
Alphanumeric entry (26)

0123456789
or

0123456789ABCDEF012345
6789

WEP Key 4
Alphanumeric entry (26)

0123456789
or

0123456789ABCDEF012345
6789

Network Connectivity Host IP, NRS, DNS, DHCP DNS
Method
Host IP Host IP address 127.0.0.1
Port 281
NRS Network rendezvous service 0.0.0.0
(NRS) IP address
(### #HH )
Port (####) 7711
DNS Network rendezvous service WANRS
DNS name
Port (####) 7711
DHCP DHCP vendor class welchallyn-nrs
identifier
Port (####) 7711

NRS IP addresses (multiple)

Those network rendezvous
service (NRS) IP addresses
used by your organization

Bluetooth
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Settings Options Selections Default value
MAC address for Bluetooth 00:1A:FA:FF:FC:00
pairing
Bluetooth configuration Yes /No Yes
allowed
Pairing new laptop allowed Yes/No No

Name of device as shown
on a paired laptop

######## 1S unique based
on serial #

WACSM - ########

Install the Nurse Call cable

Use this drawing and the following table as a reference for the Nurse Call cable and
wiring a Nurse Call system.

Cable connector

Wires (terminate according to
manufacturer's specifications)

Tip (red wire)

Normally open wire (red)

Barrel (black wire)

Arm wire (black)

Center (white wire)

Normally closed wire (white)
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Troubleshooting

This section provides the following tables to help troubleshoot the device.

Interpreting log file output: The tables and sample calculations in this topic show
you how to parse and interpret error log messages.

Symptoms and solutions: This simple table lists symptoms you might observe,
possible causes, and suggested actions that might eliminate the problem.

Technical alarm messages: These tables list messages generated by the device
software when a problem is detected. The tables explain possible causes and
suggest actions that can resolve the problem. Compare to the Symptoms and
solutions table, these tables are much more exhaustive.

These tables can help you diagnose and fix a problem. They do not replace basic
troubleshooting skills. You must still trace the source of the problem to the board or
module level to decide the best course of action. Welch Allyn does not support
component-level repair to the board or module. For available replacement parts, see
“Field Replaceable Units.”

& WARNING Do not perform troubleshooting on a device that is emitting
smoke or exhibits other signs of excessive overheating. Disconnect the
device from AC power and call Welch Allyn Technical Support immediately.

& CAUTION Replace parts, components, or accessories only with parts
supplied or approved by Welch Allyn. The use of any other parts can lead to
inferior device performance and will void the product warranty.

Interpreting log file output

The device supports saving log files to a USB flash drive. You can then read saved log
files on a PC to assist in analysis. This method allows access to the log files without
having to connect the device to a PC.

Save log files

Complete the following steps to save a log file to a USB flash drive:

1.

ok wn

Insert a compatible USB flash drive into the USB port of the monitor or the APM
work surface if one is configured for your device.

Access Advanced settings.

Navigate to Service > Log file.

Touch Save to USB. A "Save successful' message appears after a successful save.
Remove the USB flash drive from the USB port.

Access log files

Complete the following steps to access and start working with log files saved to a USB
flash drive:

1.
2.

Insert the USB flash drive into a USB port on your PC.

Open the USB flash drive and identify the saved log files. Look for .zip files that
resemble this example, with the first set of numbers being a datestamp in the
YYYYMMDD format:

logfiles 20150108 193903 179.zip
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3. Open the .zip file, and then open the desired messages .zip file. Multiple messages
files might be saved on the USB drive, so check the datestamp in the filename to
select the desired .zip file. For example,

messages_2015 01 _08.zip
The available log files appear onscreen. The largest file is the latest file of the day.
The filenames resemble this example:

messages_2015_01_08_0000000008

4. Right-click on the desired log file, select Open, and then select WordPad as the
program to open the file.
The log file opens and is ready for analysis.

Log message format

Knowing how to interpret log file output can help you to troubleshoot issues on the
device. All log messages follow this format:

<PRI>ISODATE (sp) MSGHDR: (sp) MSG (new-line)

The following table defines each element of the log message.

<PRI> The facility number and the severity number concatenated into an 8-bit value.

Note The PRI values and calculations performed with them are useful primarily to
Welch Allyn engineers. Most biomeds and service personnel can focus on the
other details of log messages to complete their analysis.

ISODATE The date and time at which the message was generated in the ISO 8601 compatible standard
timestamp format (yyyy-mm-ddThh:mm:ss.mmm+-ZONE). This is picked up from the CSM device
system time.

MSGHDR Message header: The name and the PID of the program or process that sent the log message in

PROGRAMIPID]: format. It includes a trailing whitespace.

MSG The text of the log message from the sending program or process. This is a free-format text string,
terminating with a new-line character.

(sp) A single-space character.

(new-line) A new-line character.

Sample log messages:
<13>2014-09-26T12:18:45.000+00:00 wa_nibpd[1326]:
NibpManualBpCancelState->Enter

<150>2014-09-08T05:55:00.000+00:00 wa_spo2nonind[1521]: Code 1,
SPO2 sensor not connected

As noted above, the calculations performed using PRI values have little significance for
most users but are valuable for Welch Allyn engineers. Therefore, the following
instructions for calculating facilty and severity numbers target Welch Allyn engineers.
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To obtain the facility number, divide the PRI value by 8 (dropping the fraction from the
result). The facility number is one of the following:

Facility Number Description

0 Kernel messages

1 User-level messages

2 Mail system

3 System daemons

4 Security/authorization messages (auth)
5 Messages generated interally by syslogd
6 Line printer subsystem

7 Network news subsystem

8 UUCP subsystem

9 Clock daemon

10 Security/authorization messages (authpriv)
1 FTP daemon

12 NTP subsystem

13 Log audit

14 Log alert

15 Clock daemon (cron)

16 BioMed messages (aka local-0)

17 Manufacturing messages (aka local-1)
18 Service messages (aka local-2)

19 Engineering messages (aka local-3)

20 Not Used (aka local-4)

21 Not Used (aka local-5)

22 Not Used (aka local-6)

23 Not Used (aka local-7)
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To obtain the severity number, subtract the (facility times 8) value from the PRI value.

The severity number is one of the following:

Severity Number Severity Name

Description

0 EMERG

1 ALERT

2 CRITICAL
3 ERROR

4 WARNING
5 NOTICE

6 INFO

7 DEBUG

A panic condition

A condition that should be corrected immediately
Critical conditions, such as hard device errors

Error messages

Warning messages

Conditions that are not errors but may require attention
Information messages

Debug messages

Sample calculation/interpretation

For each of the sample error logs presented, we can determine the following:

<13>2014-09-26T12:18:45.000+00:00 wa_nibpd[1326] :

NibpManualBpCancelState->Enter

<PRI>=13

ISODATE = 2014-09-26T12:18:45.000+00:00
MSGHDR = wa_nibpd[1326]:

MSG = NibpManualBpCancelState

Facility = <PRI> = 8 = 13 + 8 = 1.625 = 1 when rounded down = User-level messages
Severity = <PRI> — (Facility x 8) =13 — (1 x 8) = 13— 8 =5 = NOTICE

<150>2014-09-08T05:55:00.000+00:00 wa_spo2nonind[1521]: Code 1,

SPO2 sensor not connected

<PRI> =150

ISODATE = 2014-09-08T05:55:00.000+00:00
MSGHDR = wa_spo2nonind[1521]:

MSG = Code 1, SPOZ2 sensor not connected

Facility = <PRI> = 8 = 150 + 8 = 18.75 = 18 when rounded down = Service messages (aka local-2)
Severity = <PRI> — (Facility x 8) = 150 — (18 x 8) = 150 — 144 = 6 = INFO
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Symptom

Possible cause

Suggested action

General

The device does not power up.

A new battery was installed.

Connect AC power to wake up
the battery.

The battery is discharged.

Connect AC power to charge the
battery.

The power switch is defective.

Replace the power switch.

The power supply is defective.

Check the output voltage on the
power supply. The voltage should
be 15V £ 0.45V DC. If it is not,
replace the power supply.

The battery is dead or defective.

Charge the battery for 5 hours. If
the battery icon on the display
still shows an empty battery
symbol, replace the battery.

The main board is defective.

Replace the main board.

The touchscreen is unresponsive.

Touchscreen needs calibration.

Calibrate the touchscreen.

Run the Host Calibration
Sequence from the Service Tool.

Replace the LCD / touchscreen.

Replace the main board.

The device does not signal alarm
conditions for the Nurse Call
option.

Alarm limit settings are set too high or too low.

Adjust the alarm limit settings.

Audio alarms have been silenced.

Turn on audio alarms.

A hardware component has failed.

Run the Host Calibration
Sequence from the Service Tool.

Replace the main board.

The device is powered on but the
display is blank.

The device is in Sleep mode.

Touch the screen.

A hardware component has failed.

Run the Host Calibration
Sequence from the Service Tool.

Replace the LCD / touchscreen.

Replace the main board.

Bluetooth®

The monitor cannot connect with a A pairing issue occurred.

Bluetooth device.

Pair the monitor to the device.
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Symptom Possible cause

Suggested action

Ensure that the monitor and the
device are within range.

The Bluetooth device driver has
not been installed properly.

PC Service for the device has not
started.

Perform a Bluetooth radio
functional check.

Update the device software.

Replace the Bluetooth radio.

Replace the main board.

A connectivity issue occurred.

Configure monitor to network
settings.

Verify local network settings.

Ensure that the monitor and the
device are within range.

Perform a Bluetooth radio
functional check.

Update the device software.

Replace the Bluetooth radio.

Replace the main board.

A hardware component has failed.

Perform a Bluetooth radio
functional check.

Replace the Bluetooth radio.

Replace the main board.

The software has failed.

Update the software.

Replace the Bluetoath radio.

Replace the main board.

Wireless radio

The monitor cannot connect with a A connectivity issue occurred.
Wireless network.

Configure monitor to network
settings.

Verify local network settings.
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Symptom

Possible cause

Suggested action

Ensure that the monitor and the
device are within range.

Perform a Newmar radio
functional check.

Update the device software.

Replace the Newmar radio.

Replace the main board.

A hardware component has failed.

Perform a Newmar radio
functional check.

Replace the Newmar radio.

Replace the main board.

The software has failed.

Update the software.

Replace the Newmar radio.

Replace the main board.

Attempt to upgrade the software
failed.

The hardware or software between the Host and

the Newmar radio is incompatible.

Retry software update.

Replace Newmar radio.

Replace main board.

The monitor lost communication with the
network or a timing issue occurred during the

upgrade.

Retry software update.

Replace Newmar radio.

Replace the main board.

The Newmar radio malfunctioned.

Update the software.

Replace Newmar radio.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

Ethernet

The monitor cannot connect to the A connectivity issue occurred.

network.

Verify local network settings.

Verify that the port on the
network is configured and
functional.
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Symptom

Possible cause

Suggested action

Perform an Ethernet functional
check.

Update the software.

Replace the main board.

A hardware failure occurred.

Perform an Ethernet functional
check.

Replace the main board.

A software failure occurred.

Update the software.

Replace the main board.

Attempt to upgrade the software
failed.

The hardware or software between the Host and
the Ethernet module is incompatible.

Retry software update.

Replace the main board.

The monitor lost communication with the
network or a timing issue occurred during the
upgrade.

Retry software update.

Replace the main board.

The Ethernet module malfunctioned.

Update the software.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

NIBP

Blood pressure readings are
inaccurate.

Incorrect cuff size, improperly placed cuff, or
incompatible cuff.

Determine correct cuff size by
measuring patient's arm
circumference midway between
the elbow and the shoulder. Then
use a properly sized cuff.

Use reference markings on the
cuff to place it properly.

Use only Welch Allyn cuffs.

Patient's arm is not positioned properly or moves
during blood pressure cycle.

Ensure patient's arm is resting on
a surface at heart level.

Keep arm still to reduce artifact.

Blood pressure cuff is placed over clothing.

Take blood pressure on a bare
arm.

The patient is experiencing arrhythmia.

Check for regularity of heart rate
(palpate pulse or check device).
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Symptom Possible cause

Suggested action

There is a leak in the pneumatic system.

Ensure all cuff attachments are
tight. Carefully check for leaks in
blood pressure cuff and tubing
attached to the device.

Replace the cuff.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The NIBP module needs calibration.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The single or dual lumen switch failed.

Ensure that the cuff is the
properly sized.

Clean the cuff connections.

Replace the cuff and tubing.

Replace the main board.

The NIBP cuff does not inflate. There is a leak in the pneumatic system.

NIBP is not functioning.

Ensure all cuff attachments are
tight. Carefully check for leaks in
blood pressure cuff and tubing
attached to the device.

Replace the cuff.

Update the software.
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Symptom

Possible cause

Suggested action

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The main board malfunctioned.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

The single or dual lumen switch failed.

Ensure that the cuff is the
properly sized.

Clean the cuff connections.

Replace the cuff and tubing.

Replace the main board.

The NIBP module needs calibration.

Update the software.

Perform NIBP functional checks.

Perform NIBP calibration checks.

Replace the pump assembly.

Replace the main board.

Attempt to upgrade the software
failed.

The hardware or software between the Host and

the Ethernet module is incompatible.

Retry software update.

Replace the main board.

The monitor lost communication with the
network or a timing issue occurred during the

upgrade.

Retry software update.

Replace the main board.
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Symptom

Possible cause

Suggested action

Temperature

Temperature measurements are
inaccurate.

Probe is placed improperly.

Ensure that the probe is properly
placed in the measurement site.
For oral temps, place the probe in
the most posterior sublingual
pocket.

The probe malfunctioned.

Replace the probe.

Perform temperature functional
checks.

The probe cover is faulty or incorrectly attached.

Verify the condition of the probe
cover and that it covers the probe
completely.

Replace the probe cover.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The temperature module malfunctioned.

Update the software.

Replace the temperature module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

Temperature measurements are
not displayed.

The probe is disconnected from the monitor.

Ensure that the temperature
probe is connected and seated in
the probe well before taking a
measurement.

Probe is placed improperly.

Ensure that the probe is properly
placed in the measurement site.
For oral temps, place the probe in
the most posterior sublingual
pocket.

The probe malfunctioned.

Replace the probe.

Perform temperature functional
checks.

The temperature module malfunctioned.

Update the software.

Replace the temperature module.

Replace the main board.

A software issue occurred.

Update the software.
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Symptom

Possible cause

Suggested action

Replace the temperature module.

Replace the main board.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The main board malfunctioned.

Update the software.

Replace the main board.

Attempt to upgrade the software
failed. Braun failures

The hardware or software between the Host and

the Ethernet module is incompatible.

Retry software update.

Replace the temperature module.

Replace the main board.

The monitor lost communication with the
network or a timing issue occurred during the

upgrade.

Retry software update.

Replace the temperature module.

Replace the main board.

The temperature module malfunctioned.

Update the software.

Replace the temperature module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

The thermometer is not in the cradle.

Placed the thermometer in the
cradle.

The thermometer contacts are dirty.

Clean the thermometer contacts.

Replace the thermometer.

Replace the thermometer
module.

The thermometer batteries are dead.

Place the thermometer in the
cradle to charge.

Clean the thermometer contacts.

Replace the thermometer
batteries.

Replace the thermometer.
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Symptom Possible cause Suggested action

Replace the thermometer
module.

The thermometer malfunctioned. Place the thermometer in the
cradle to charge.

Clean the thermometer and
module contacts.

Clean the probe or window.

Replace the probe cover.

Perform temperature functional
checks.

Update the software.

Replace the thermometer
batteries.

Replace the thermometer.

Replace the thermometer
module.

Replace the main board.

The temperature module malfunctioned. Perform temperature functional
checks.

Update the software.

Replace the temperature module.

Replace the main board.

The probe or the window is dirty or Clean the probe or window.
contaminated.

Perform temperature functional
checks.

Replace the probe.

The main board malfunctioned. Update the software.

Replace the main board.

Sp02
Sp02 measurements are not The sensor is faulty or incorrectly attached. Connect the sensor to the patient
displayed. and the device.

Replace the sensor.
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Symptom

Possible cause

Suggested action

Perform Sp02 functional checks.

The sensor is contaminated or dirty.

Clean the optical area of the
sensor.

Replace the sensor.

Perform Sp02 functional checks.

The Sp02 module malfunctioned.

Perform Sp02 functional checks.

Update the software.

Replace the Sp02 module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

Sp02 measurements are
inaccurate.

The sensor is faulty or incorrectly attached.

Connect the sensor to the patient
and the device.

Replace the sensor.

Perform Sp02 functional checks.

The sensor is contaminated or dirty.

Clean the optical area of the
sensor.

Replace the sensor.

Perform Sp02 functional checks.

The Sp02 module malfunctioned.

Perform Sp02 functional checks.

Update the software.

Replace the Sp02 module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

Attempt to upgrade the software
failed.

The hardware or software between the Host and
the Sp02 module is incompatible.

Retry software update.

Replace the Sp02 module.

Replace the main board.
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Symptom Possible cause Suggested action
The monitor lost communication with the Retry software update.
network or a timing issue occurred during the
upgrade. Replace the Sp02 module.

Replace the main board.

The temperature module malfunctioned. Update the software.

Replace the Sp02 module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Technical alarm and information messages

This section presents tables of technical alarm and information messages to help you
troubleshoot issues on the monitor.

When the monitor detects certain events, a message appears in the Device Status area
at the top of the screen. Message types include the following:

¢ Information messages, which appear on a blue background.

e Very low-priority alarms, which appear on a cyan background.

e |ow- and medium-priority alarms, which appear on an amber background.

e High-priority alarms, which appear on a red background.

Technical alarm messages are low or very low priority unless noted in the Message
column.

Alarm logs are not viewable by clinicians. However, all logs are transferred to Welch
Allyn on a regularly scheduled basis. In the event of an unplanned power failure, all
information, including device logs and patient data, are retained on the system.

You can dismiss a message by touching the message on the screen, or, for some
messages, you can wait for the message to time out.

To use these tables, locate the message that displays on the monitor in the left column
of the table. The remainder of the row explains possible causes and suggests actions
that can resolve the issue.

If you cannot resolve the issue, use the service tool to read the error log files or to
perform a functional test on the module reporting the message.

Note Performing functional tests on modules requires the service tool, Gold
edition.
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Message

Possible cause

Suggested action Alarm priority

User cancelled NIBP
reading.

The NIBP measurement was

cancelled by user

Clear the alarm and retry NIBP. Information

NIBP not functional.
050002

The NIBP measurement is not

available

Internal malfunction. If the problem  Medium
persists, replace the module.

Unable to determine
NIBP; check
connections; limit
patient movement.
050003

The NIBP measurement may be
inaccurate, patient motion
occurred, or the settings for
patient readings obtain might not

be accurate

Make sure the NIBP settings/patient Medium
mode is appropriate. If the problem
persists, replace the module.

Unable to determine
NIBP; check
connections; limit
patient movement.
050004

Excessive artifact, no blood
pressure parameters could be

calculated

Unable to determine blood pressure. Medium
Check connections; restrict patient

movement. If problem persists,

replace module

Unable to determine
NIBP; check inflation
settings. 050005

Low inflation on blood pressure

measurement attempt

Make sure the NIBP settings/patient Medium
mode is appropriate. If the problem
persists, replace the module.

Unable to determine

NIBP; check connections

and tubing for kinks.
050006

The NIBP tubing has a kink, or
there is a NIBP transducer

calibration failure

Internal malfunction. If the problem  Medium
persists, replace the module.

Unable to determine
NIBP; check
connections; limit
patient movement.
050007

The blood pressure measurement

dumped too soon

Make sure the NIBP settings/patient Medium
mode is appropriate. If the problem
persists, replace the module.

Unable to determine
NIBP; check
connections; limit
patient movement.
050008

There were not enough steps on
the measurement attempt

Unable to determine blood pressure. Medium
Check connections; restrict patient
movement.

Unable to determine
NIBP; check inflation
settings. 050009

There is invalid patient
information for the selected mode

Make sure the NIBP settings/patient Medium
mode is appropriate. If the problem
persists, replace the module.

Unable to determine
NIBP; check
connections; limit
patient movement.
05000A

The re-inflation was too late on
the measurement attempt

Unable to determine blood pressure. Medium
Check connections; restrict patient
movement.

Unable to determine
NIBP; check inflation
settings. 050008

There were many re-inflate
attempts on the measurement

attempt

Unable to determine blood pressure. Medium
Check connections; restrict patient
movement.

Unable to determine

NIBP; check connections

and tubing for kinks.
05000C

Couldnt bleed pressure below
safe venous return pressure

Unable to release cuff pressure. Medium
Check tubing for kinks and
connection integrity.




Service manual

Appendix 163

Message

Possible cause

Suggested action

Alarm priority

No display

The safety check failed on the

Internal malfunction. If the problem

measurement attempt persists, replace the module.
Unable to determine The NIBP pressure is not stable ~ The NIBP pressure is not stable and  Medium
NIBP; check and the transducer zero value the transducer zero value cannot be
connections; limit cannot be set set. If problem persists, replace
patient movement. module.
05000F
NIBP not functional. WACP message CRC mismatch on Internal malfunction. If the problem  Very low
050105 NIBP module persists, replace the module.
NIBP not functional. This message is not implemented Internal malfunction. If the problem  Very low
050201 by the NIBP module persists, replace the module.
NIBP not functional. This message is not supported by Internal malfunction. If the problem  Very low
050202 the NIBP module persists, replace the module.
NIBP not functional. The NIBP module has run out of  Internal malfunction. If the problem  Very low
050203 memory persists, replace the module.
NIBP not functional. The NIBP module has received a  Internal malfunction. If the problem  Very low
050205 invalid parameter persists, replace the module.
NIBP not functional. The parameter provided by the Internal malfunction. If the problem  Very low
050206 NIBP module is outside of the persists, replace the module.

allowable range for the specified

message
NIBP not functional. The NIBP module message Internal malfunction. If the problem  Very low
050207 requires an object, but did not persists, replace the module.

contain one
NIBP not functional. The NIBP module object provided Internal malfunction. If the problem  Very low
050208 with the message could not be persists, replace the module.

deserialized
NIBP not functional. The NIBP module object could not  Internal malfunction. If the problem  Very low
050209 be serialized persists, replace the module.
NIBP not functional. The NIBP module message is Internal malfunction. If the problem  Very low
05020A performing a request or action persists, replace the module.

when the module state prohibits

the request or action.
NIBP not calibrated. Factory EEPROM checksum error  Internal malfunction. If the problem  Very low
050503 on NIBP. Units internal persists, replace the module.

configuration was corrupted
NIBP not functional. User EEPROM checksum error. Calibrate the NIBP Module. If Very low
050504 Configuration data which can be  problem persists, replace module.

set in the user's configuration

menu was damaged or lost on

NIBP
NIBP not functional. Post failure of A/D convertor Internal malfunction. If the problem  Very low

050505

persists, replace the module.
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Message Possible cause Suggested action Alarm priority
NIBP not calibrated. NIBP module calibration failure,  Calibrate the NIBP module. Very low
Calibrate the module. the calibration signature is zero
050509
Invalid algorithm. Select Invalid NIBP Algorithm. NIBP Verify the algorithm. If the problem  Very low
correct algorithmand ~ component software tried to persists, replace the module.
retry. 05050A configure the sensor in an illegal

manner
NIBP not functional. Invalid NIBP initiation code Internal malfunction. If the problem  Very low
050513 persists, replace the module.
Invalid patient mode. Invalid patient mode on NIBP. The Verify correct patient mode. If the ~ Very low
Select correct patient  NIBP component software tried to  problem persists, replace the
mode and retry. 050514 configure the sensor inan illegal  module.

manner
NIBP not functional. Invalid module configuration for  Internal malfunction. If the problem  Very low
050515 NIBP persists, replace the module.
NIBP not functional. NIBP module malfunction Internal malfunction. If the problem  Very low
050516 persists, replace the module.
Ambient temperature  Ambient temp out of range on Restore device to normal Very low
out of range. Clear error NIBP temperature ranges and try again.
and retry. 050517
Low battery. Pluginto  The NIBP module power rail is too Plug device into an AC outlet to Very low
outlet. 050518 low charge the battery.
Battery overcharged. The NIBP module power rail is too Battery is overcharged. Remove from Very low
Disconnect from outlet. high. NIBP was calibrated without charging source. Charge battery and
050519 A/C connected or battery too low. initialize NIBP module and

recalibrate with A/C connected.
NIBP not calibrated. NIBP failed to load safety Calibrate the NIBP module. If the Very low
Calibrate the module.  processors calibration record from problem persists, replace the
050601 EEPROM module.
NIBP not functional. NIBP safety processor failed ROM Internal malfunction. If the problem  Very low
050602 checksum persists, replace the module.
NIBP not calibrated. NIBP safety processor not Calibrate the NIBP module. If the Very low
Calibrate the module.  calibrated, missing calibration problem persists, replace the
050603 signature module.
Cuff pressure limits NIBP system failure. Overpressure Restrict patient movement. Medium
exceeded. 050604
Premature auto cycle  NIBP auto cycle skipped, SVRP Cuff pressure is not below safety Very low
skipped. 050605 requirement not satisfied return pressure long enough to allow
a cycle to occur.

Cuff pressure too high.  NIBP cuff pressure above SVRP for Verify cuff connections. If the Medium

Clear error to retry.
050606

to long

problem persists, replace the
module.




Service manual

Appendix

Message Possible cause Suggested action Alarm priority
NIBP not functional. NIBP cannot clear the failsafe Internal malfunction. If the problem  Very low
050607 alerts persists, replace the module.
NIBP not functional. NIBP safety processor has stopped Internal malfunction. If the problem  Very low
050608 responding persists, replace the module.
Stat mode requested too NIBP excessive stat mode time.  Internal malfunction. If the problem ~ Very low
soon. Clear to retry. The time between readings is less persists, replace the module.
050609 than one minute and the readings

plus time between readings result

in the device taking over 15

minutes to complete the averaging

cycle.
Unable to determine NIBP transducers are not matched The transducer are above 5 mmHg ~ Medium
NIBP; check connections and the difference in pressure is
and tubing for kinks. greater than 40 mmHg. Check cuff
05060A for pinched or obstructed tubing. If

the problem persists, replace the
module.

NIBP not calibrated. Factory EEPROM checksum error  Calibrate the NIBP module. If the Very low
Calibrate the module.  on NIBP. Units internal problem persists, replace the
050608 configuration was corrupted module.
NIBP not functional. NIBP command not implemented  Internal malfunction. If the problem  Very low
05060C persists, replace the module.
NIBP not functional. NIBP wrong data count Internal malfunction. If the problem  Very low
05060D persists, replace the module.
NIBP not functional. NIBP data range error Internal malfunction. If the problem  Very low
05060E persists, replace the module.
NIBP not functional. NIBP no POST error to clear Internal malfunction. If the problem  Very low
05060F persists, replace the module.
NIBP not functional. NIBP cannot clear this POST error  Internal malfunction. If the problem  Very low
050610 persists, replace the module.
NIBP not functional. NIBP command not command type Internal malfunction. If the problem  Very low
050611 persists, replace the module.
NIBP not functional. NIBP communication timeout Internal malfunction. If the problem  Very low
050612 persists, replace the module.
NIBP not functional. NIBP response header wrong Internal malfunction. If the problem  Very low
050613 persists, replace the module.
NIBP not functional. NIBP response checksum wrong  Internal malfunction. If the problem  Very low
050614 persists, replace the module.
NIBP not functional. Too much NIBP data was received Internal malfunction. If the problem  Very low
050615 persists, replace the module.
NIBP not functional. NIBP FPROM erase error Internal malfunction. If the problem  Very low

050616

persists, replace the module.
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Message Possible cause Suggested action Alarm priority
NIBP not functional. NIBP FPROM programming error  Internal malfunction. If the problem  Very low
050617 persists, replace the module.
NIBP not functional. Invalid NIBP target pressure Internal malfunction. If the problem  Very low
050618 persists, replace the module.
Check cuff inflation Cuff inflation target was Change cuff inflation target or Information
settings. overridden due to max pressure  maximum pressure so that the cuff

being too low inflation target is at least 20 mmHg

lower than maximum pressure.

Tube type does not Switching to step BP Change tube type to dual lumen or  Information
match device change the algorithm configuration
configuration. to step BP
NIBP not functional. Unrecognized WACP parameter  Internal malfunction. If the problem ~ Very low
05FFO1 received from sensor persists, replace the module.
NIBP not functional. Timeout waiting for sensor Internal malfunction. If the problem  Very low
05FF02 response persists, replace the module.
NIBP not functional. Error deserializing the WACP Internal malfunction. If the problem  Very low
05FF03 message received from the sensor persists, replace the module.
NIBP not functional. WACP stack send message failure Internal malfunction. If the problem  Very low
05FF04 persists, replace the module.
NIBP not functional. Timeout waiting for asynchronous Internal malfunction. If the problem  Very low
05FF05 Sensor message persists, replace the module.
NIBP not functional. One or more undetermined Check connections. Restrict patient ~ Very low
05FF06 numerics when reading status movement.

indicates OK
NIBP not functional. Unrecognized sensor reading Internal malfunction. If the problem  Very low
05FF07 status code persists, replace the module.
NIBP not functional. Sensor power up failure Internal malfunction. If the problem  Very low
05FF08 persists, replace the module.
NIBP not functional. WACP rendezvous failure Internal malfunction. If the problem  Very low
05FF09 persists, replace the module.
NIBP not functional. Application firmware retrieval Internal malfunction. If the problem  Very low
05FFOA error during POST persists, replace the module.
NIBP not functional. Upgrade .pim file is corrupt Internal malfunction. If the problem  Very low
05FFOB persists, replace the module.
NIBP not functional. Configured upgrade firmware Internal malfunction. If the problem  Very low
05FFOC directory cannot be accessed persists, replace the module.
Device configuration Configured parameter (NIBP or Use configured parameters for Very low
issue. 05FFOD Sp02) used in Intervals is missing  Intervals
NIBP not functional. The NIBP sensor unexpectedly Clear the error and try again Very low

05FFOE

reset
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Message

Possible cause

Suggested action

Alarm priority

NIBP not functional.
05FFOF

The NIBP sensor firmware failed

to upgrade

Internal malfunction. If the problem  Very low
persists, replace the module.

Tube type does not
match device
configuration.

The tube type settings and the
actual tube type do not match

Change the tube type setting to Information

match the actual tube type.

Sp02 messages

General SpO2 messages

Message

Possible cause

Suggested action

Alarm priority

Sp02 not functional.
044800

The Sp02 power on self test

failed

Internal hardware malfunction in
Sp02 module. Replace the module.

Very low

Sp02 Module is
rebooting. 044900

The Sp02 module is rebooting

Informational error.The host software Very low
is attempting to clear an error by

rebooting the Sp02 module. No

action required.

Sp02 Module is
rebooting. 044901

The Sp02 module has stopped

sending data

Informational error. The host
software is attempting to clear an
error by rebooting the Sp02 module.
No action required.

Very low

Sp02 Module is
rebooting. 044902

Sp02 received a packet with bad

CRC from module

Informational error. The host has
recieved a packet with bad CRC from
the Sp02 module. The packet in
question is ignored. No action
required.

Very low

Sp02 Module is
rebooting. 044903

The Sp02 power on self test

failed

Internal hardware malfunction in
Sp02 module. Replace the module.

Very low

Sp02 Module is
rebooting. 044904

The Sp02 power on self test

timed out

Internal hardware malfunction in
Sp02 module. Replace the module.

Very low

Masimo messages

Message

Possible cause

Suggested action

Alarm priority

Sensor not connected.
Clear to retry. 040600

The Sp02 cable is not connected

Connect Sp02 cable. If the problem  Very low
is still present, replace the Sp02

sensor. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

Replace the Sp02 cable. The Sp02 cable life has expired

040700

Replace the Sp02 cable. If the
problem is still present, verify
module functionality by replacing the
sensor with an applicable Sp02

Very low
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Message

Possible cause

Suggested action Alarm priority

tester. If the message persists,
replace the module.

Replace the Sp02 cable.
040800

The Sp02 cable is incompatible
with the monitor

Replace the Sp02 cable. If the Very low
problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists,

replace the module.

Replace the Sp02 cable.
040900

The Sp02 cable is not recognized
by the monitor

Replace the Sp02 cable. If the Very low
problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists,

replace the module.

Replace the Sp02 cable.
040a00

The Sp02 cable is defective

Replace the Sp02 cable. If the Very low
problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists,

replace the module.

Sensor not connected.
Clear to retry. 040b00

The Sp02 sensor is not connected
to the monitor

Connect Sp02 sensor. If the problem  Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

The sensor has expired.
Replace the Sp02
sensor. 040c00

The Sp02 sensor has expired

Replace Sp02 sensor. If the problem Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

Incompatible sensor.
Replace the Sp02
sensor. 040d00

The Sp02 sensor is not recognized
by the monitor

Replace Sp02 sensor. If the problem  Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

Incompatible sensor.
Replace the Sp02
sensor. 040e00

The Sp02 sensor is not recognized

Replace Sp02 sensor. If the problem Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.
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Message

Possible cause

Suggested action Alarm priority

Replace the Sp02
sensor. 04000

The Sp02 sensor is defective

Replace Sp02 sensor. If the problem  Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

Replace the Sp02
sensor. Replace the
Sp02 cable. 041000

There was a fault with the Sp02
sensor and cable.

Check the sensor and cable
connection. If the problem is still
present, replace the Sp02 sensor. If
the problem is still present, replace
the cable. If the problem is still
present, verify the module
functionality by replacing the sensor
with an applicable Sp02 tester. If the
message persists replace the
module.

Very low

Sensor not connected.

Clear to retry. 041100

An adhesive Sp02 sensor is not
connected

Connect Sp02 sensor. If the problem  Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

The sensor has expired.

Replace the Sp02
sensor. 041200

The adhesive Sp02 sensor is
expired

Replace Sp02 sensor. If the problem
is still present, replace the Sp02
cable. If the problem is still present,
verify the module functionality by
replacing the sensor with an
applicable Sp02 tester. If the
message persists, replace the
module.

Very low

Incompatible sensor.
Replace the Sp02
sensor. 041300

The adhesive Sp02 sensor is
incompatible

Replace Sp02 sensor. If the problem
is still present, replace the Sp02
cable. If the problem is still present,
verify the module functionality by
replacing the sensor with an
applicable Sp02 tester. If the
message persists, replace the
module.

Very low

Incompatible sensor.
Replace the Sp02
sensor. 041400

The adhesive Sp02 sensor is not
recognized

Replace Sp02 sensor. If the problem
is still present, replace the Sp02
cable. If the problem is still present,
verify the module functionality by
replacing the sensor with an
applicable Sp02 tester. If the
message persists, replace the
module.

Very low

Replace the Sp02
sensor. 041500

The adhesive Sp02 sensor is
defective

Replace Sp02 sensor. If the problem
is still present, replace the Sp02
cable. If the problem is still present,
verify the module functionality by
replacing the sensor with an

Very low
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Message Possible cause
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applicable Sp02 tester. If the
message persists, replace the

module.
Sp02 initializing. 041600 None None.! Very low
Searching for pulse Sp02 pulse search Pulse search is part of normal High

signal. 041800

operation, and does not have an
associated corrective action.

Low perfusion index.
Clear to retry. 041a00

There is marginal Sp02 pulse
quality or artifact.

Reapply the sensor to the patient. If ~ Very low
the problem is still present, replace

the Sp02 sensor. If the problem is

still present, replace the cable. If the

problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists

replace the module.

Demo Mode active. The Sp02 parameter isindemo  None.2 Very low
Restart the device. mode

041b00

Sensor not connected.  Check the Sp02 sensor connection Check the sensor and cable Very low

Clear to retry. 041¢00

connection. If the problem is still
present, replace the Sp02 sensor. If
the problem is still present, replace
the cable. If the problem is still
present, verify the module
functionality by replacing the sensor
with an applicable Sp02 tester. If the
message persists replace the
module.

Sp02 not functional.
041d00

There is an Sp02 raw queue
overrun

A malfunction is detected. There are Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 04ef00 There is an Sp02 raw queue
overrun

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low
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Message Possible cause

Suggested action

Alarm priority

Sp02 rebooting. 041f00 There is an Sp02 hardware failure

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 042000 There is an Sp02 MCU failure

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 042100 There is an Sp02 watchdog failure

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 not functional. There is an invalid Sp02 board
042200 type

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 042300 There is an invalid Sp02 master
control state

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended

Very low
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Message Possible cause
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that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042400 There is an Sp02 SRAM transfer

failure

A malfunction is detected. There are  Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042500 There is an Sp02 SRAM task

queue overrun

A malfunction is detected. There are  Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042600 There is an Sp02 database failure

A malfunction is detected. There are Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042700 There is an invalid Sp02 flash
memory device

A malfunction is detected. There are Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042800 There is a problem with the Sp02

analog ground

A malfunction is detected. There are Very low
two possible causes of these

failures. First, the power provided to

the board is out of specification. In

this case, the failure may be cleared

once the underlying cause is
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Message Possible cause Suggested action Alarm priority

removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042900 There is a problem with the Sp02 A malfunction is detected. There are  Very low

digital ground two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042a00 There is a problem with the Sp02 A malfunction is detected. There are  Very low

LED ground two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042b00 There is a problem with the Sp02 A malfunction is detected. There are  Very low

reference voltage two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042c00 There is a problem with the Sp02 A malfunction is detected. There are  Very low

DSP core voltage two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042d00 There is a problem with the Sp02 A malfunction is detected. There are  Very low
filtered input voltage two possible causes of these
failures. First, the power provided to
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the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042e00 There is a problem with the Sp02
DSP 1/0 voltage

A malfunction is detected. There are  Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 042f00 There is a problem with the Sp02
positive detector voltage

A malfunction is detected. There are  Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 043000 There is a problem with the Sp02
negative detector voltage

A malfunction is detected. There are Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 043100 There is a problem with the Sp02
positive LED Voltage

A malfunction is detected. There are Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.
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Message Possible cause

Suggested action

Alarm priority

Sp02 rebooting. 043200 There is a problem with the Sp02
LED drive voltage

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 043300 There is a problem with the Sp02
positive preamp voltage

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 043400 There is a problem with the Sp02
Sensor ID

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 043500 There is a problem with the Sp02
thermistor

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Very low

Sp02 rebooting. 043600 There is a problem with the Sp02
LED current

A malfunction is detected. There are
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended

Very low
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that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 043700 There is a problem with the Sp02
preamp

A malfunction is detected. There are  Very low
two possible causes of these
failures. First, the power provided to
the board is out of specification. In
this case, the failure may be cleared
once the underlying cause is
removed. Second, the board has an
actual hardware failure and recovery
is not possible. It is recommended
that the Sp02 module be replaced,
and if problem is still present replace
the monitor's main board.

Sp02 rebooting. 044200 The Sp02 module received a bad  There is an internal software Very low
packet malfunction in the main PCBA.
Update the software. If the problem
persists, replace the module.
Sp02 rebooting. 044300 The Sp02 module received an There is an internal software Very low
invalid command malfunction in the main PCBA.
Update the software. If the problem
persists, replace the module.
Sp02 rebooting. 044400 The Sp02 module received a There is an internal software Very low
command that would result in malfunction in the main PCBA.
more output than the baud rate Update the software. If the problem
can support persists, replace the module.
Sp02 rebooting. 044500 The Sp02 module received a There is an internal software Very low
command that requires an malfunction in the main PCBA.
application that is not present Update the software. If the problem
persists, replace the module.
Sp02 rebooting. 044600 The Sp02 module received a There is an internal software Very low

command while still locked

malfunction in the main PCBA.
Update the software. If the problem
persists, replace the module.

"This is a normal part of the SpO2 module startup and does not have a corrective action.

2Demo mode is reported when you plug a Masimo demo tool into the patient cable connector. This tools
simulates a patient being connected, and is only used in a development environment. Because this tool
simulates a patient without a patient actually being connected, it should NEVER be present in a clinical setting.

Nellcor messages

Message Possible cause

Suggested action Alarm priority

Sensor not connected.
Clear to retry. 043800

The SpQ2 sensor is not connected

Connect Sp02 sensor. If the problem Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.
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Message

Possible cause

Suggested action Alarm priority

Searching for pulse
signal 043900

None

None! High

Sp02 interference
detected. Clear to retry.
043b00

Sp02 module interference
detected.

Reapply the sensor to the patient. If Very low
the problem is still present, replace

the Sp02 Ssensor. If the problem is

still present, replace the cable. If the

problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists,

replace the module.

Sp02 rebooting. 043¢00 Sp02 module hardware error A module hardware error is Very low
detected. Replace module.

Sp02 rebooting. 043d00 Sp02 module hardware error A module hardware error is Very low
detected. Replace module.

Sp02 rebooting. 043e00 Sp02 module software error A module hardware error is Very low

detected. Replace module.

Sp02 rebooting. 043f00

The Sp02 module received a bad
message

This error indicates a bug in the main Very low
board software. Call for service.

Sp02 rebooting. 044000

The Sp02 sensor is defective

Replace the Sp02 sensor. If the
problem is still present, replace the
Sp02 sensor. If the problem is still
present, replace the cable. If the
problem is still present, verify
module functionality by replacing the
sensor with an applicable Sp02
tester. If the message persists,
replace the module.

Very low

Sp02 rebooting. 044100

The Sp02 module received a bad
message

This error indicates a bug in the main Very low
board software. Call for service.

TPulse search is a normal part of operation and does not have an associated corrective action.

Nonin messages

Message

Possible cause

Suggested action Alarm priority

Sensor not connected.
Clear to retry. 040100

The SpQ2 sensor is not connected

Connect Sp02 sensor, if the problem Very low
is still present, replace the Sp02

cable. If the problem is still present,

verify the module functionality by

replacing the sensor with an

applicable Sp02 tester. If the

message persists, replace the

module.

Searching for pulse
signal. 040200

None

None! High
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Sp02 interference The Sp02 interference detected.  Reapply the sensor to the patient. If ~ Very low
detected. Clear to retry. the problem is still present, replace
040400 the Sp02 Sensor. If the problem is

still present, replace the cable. If the

problem is still present, verify

module functionality by replacing the

sensor with an applicable Sp02

tester. If the message persists,

replace the module.
Low Sp02 perfusion Sp02 marginal pulse quality or Reapply the sensor to the patient. If ~ Very low
index. Clear to retry. artifact the problem is still present, replace
040500 the Sp02 Sensor. If the problem is

still present, replace the cable. If the
problem is still present, verify
module functionality by replacing the
sensor with an applicable Sp02
tester. If the message persists,
replace the module.

TPulse search is a normal part of operation and does not have an associated corrective action.

Temperature messages

SureTemp messages

Message Possible cause Suggested action Alarm priority
Temperature not functional. WACP message CRC  Internal malfunction. If the problem Very low
30105 mismatch on persists, replace the module.

temperature module
Temperature not functional. This message is not Internal malfunction. If the problem Very low
30201 implemented by the persists, replace the module.

temperature module
Temperature not functional. This message is not Internal malfunction. If the problem Very low
30202 supported by the persists, replace the module.

temperature module
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30203 module has run out of  persists, replace the module.

memory.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30205 module received a persists, replace the module.

invalid parameter
Temperature not functional. The parameter provided Internal malfunction. If the problem Very low
30206 by the temperature persists, replace the module.

module is outside of

the allowable range for

the specified message.
Temperature not functional. The temperature Internal malfunction. If the problem Very low

30207 module message
requires an object, but

did not contain one.

persists, replace the module.
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Temperature not functional. The temperature Internal malfunction. If the problem Very low
30208 module object provided persists, replace the module.

with the message could

not be deserialized.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30209 module object could not persists, replace the module.

be serialized.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3020A module message is persists, replace the module.

performing a request/

action when the

module state prohibits

the request/action.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3020B module requested item persists, replace the module.

is not currently

available due to the

module state.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30503 module factory persists, replace the module.

settings, and

calibration information

is corrupt.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30504 module user settings  persists, replace the module.

are corrupt.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30509 module calibrationis  persists, replace the module.

not set.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3050C module error log is persists, replace the module.

corrupt.
Temperature not functional. A hardware Internal malfunction. If the problem Very low
30516 malfunction on the persists, replace the module.

temperature module

has been detected.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30518 module power rail is  persists, replace the module.

too low.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30519 module power rail is  persists, replace the module.

too high.
Temperature not functional. The temperature Internal malfunction. If the problem Very low

3051A

module reference
voltage circuit was
detected to be under
voltage or unstable.

persists, replace the module.
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Message

Possible cause Suggested action Alarm priority

Ambient temperature out of
range. Clear to retry. 30801

The temperature Verify conditions are greater than 50 °F or Very low
module measurement is 10 °C. If conditions are valid and the

below the allowable  problem persists, replace the probe. If the
temperature values and problem still persists, replace the module.

beyond the low

ambient or patient

limits.

Ambient temperature out of
range. Clear to retry. 30802

The temperature Verify conditions are less than 104 °For ~ Very low
module measurement is 40 °C. If conditions are valid and the

above the allowable  problem persists, replace the probe. If the
temperature values and problem still persists, replace the module.

beyond the high

ambient or patient

limits.

Temperature not functional.
30803

The temperature Very low
module internal
calibration resistor
(RCAL) on the board is
damaged or
contaminated (pulse

too long).

Internal malfunction. If the problem
persists, replace the module.

Temperature not functional.
30804

The temperature Very low
module internal
calibration resistor
(RCAL) on the board is
damaged or
contaminated (pulse

too short).

Internal malfunction. If the problem
persists, replace the module.

Temperature not functional.
30805

The temperature Internal malfunction. If the problem
module internal circuit  persists, replace the module.
validation resistor (PTB)

on the board is

damaged (value is

over).

Very low

Temperature not functional.
30806

The temperature Internal malfunction. If the problem Very low
module internal circuit  persists, replace the module.

validation resistor (PTB)

on the board is

damaged (value is

under).
Ambient temperature out of The temperature Verify conditions are greater than 50 °F or Very low
range. Clear to retry. 30807 module A/D 10 °C. If conditions are valid and the

measurement timed out problem persists, replace the probe. If the
problem still persists, replace the module.

Replace temperature probe. The temperature Probe malfunction. Replace the probe. If ~ Very low
30808 module probe was not  the problem persists, replace the module.
characterized/
calibrated
Insert correct color-coded probe  The temperature Insert the probe well Very low

well. 30809

module is missing the
probe well
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Temperature not functional. The temperature Internal malfunction. If the problem Very low
3080A module has a problem  persists, replace the module.

saving to the monitor

EEPROM in biotech

mode
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3080B module error detection persists, replace the module.

mechanism detected an

error
Replace temperature probe. The temperature Probe malfunction. Replace probe. If the  Very low
3080C module probe error problem persists, replace the module.

detection mechanism

detected an error
Temperature not functional. The temperature Probe malfunction. Replace probe. If the ~ Very low
3080D module log error problem persists, replace the module.

detection mechanism

detected an error
Temperature not functional. The temperature Probe malfunction. Replace probe. If the ~ Very low
3080E module calibration error problem persists, replace the module.

detection mechanism

detected an error
Connect temperature probe. The temperature Probe malfunction. Replace probe. If the ~ Very low
3080F module detected no problem persists, replace the module.

probe connected
Replace temperature probe. The temperature Probe malfunction. Replace probe. If the ~ Very low
30810 module cannot read the problem persists, replace the module.

probe EEPROM

correctly or the probe

left the factory without

being tested.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30811 module has an invalid  persists, replace the module.

events index
Temperature not functional. There is a problem Internal malfunction. If the problem Very low
30812 reading the persists, replace the module.

temperature module

EEPROM or saving to

the monitor EEPROM in

biotech mode.
Replace temperature probe. Code The temperature Probe malfunction. Replace probe. If the  Very low
30813 module has a problem  problem persists, replace the module.

reading the probe

EEPROM.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30814 module TEMP CONFIG  persists, replace the module.

ACQUIRE FAILURE
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Temperature not functional. The temperature Internal malfunction. If the problem Very low
30815 module TEMP CONFIG  persists, replace the module.

RELEASE FAILURE
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30816 module TEMP CONFIG  persists, replace the module.

INVALID PTR FAILURE
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30817 module internal error.  persists, replace the module.

EEPROM not initialized
Unable to detect new The temperature Probe malfunction. Replace probe. If the ~ Very low
temperature. Retry measurement. module heater problem persists, replace the module.
30818 indicates on when

turned off.
Unable to detect new The temperature Probe malfunction. Replace probe. If the  Very low
temperature. Retry measurement. module heater problem persists, replace the module.
30819 indicates off when

turned on.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3081A module HTR_Qison  persists, replace the module.

and HTRC is off but still

has voltage.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3081B module HTR_Q is tri-  persists, replace the module.

stated with HTRC

enabled and has heater

power.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3081C module turned Q&C on persists, replace the module.

and the heater voltage

is not high enough.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
3081D module heater persists, replace the module.

hardware failsafe

should have turned off

but did not.
Replace temperature probe. The temperature Probe malfunction. Replace probe. If the ~ Very low
3081E module probe is above problem persists, replace the module.

112°F or 43.3°C.
Replace temperature probe. The temperature Probe malfunction. Replace probe. If the ~ Very low
3081F module has excessive  problem persists, replace the module.

heater energy
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30820 module host interface  persists, replace the module.

error
Ambient temperature out of The temperature Verify conditions are less than 104 °For ~ Very low

range. Clear to retry. 30821

module over ambient
45 °C temp

40 °C. If conditions are valid and the
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Message Possible cause Suggested action Alarm priority
problem persists, replace the probe. If the
problem still persists, replace the module.
Ambient temperature out of The temperature Verify conditions are greater than 50 F or ~ Very low
range. Clear to retry. 30822 module under ambient  10°C. If conditions are valid and the
temp problem persists, replace the probe. If the
problem still persists, replace the module.
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30823 module has an invalid  persists, replace the module.
SureTemp algorithm
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30824 module is over max persists, replace the module.
battery volts
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30825 module is under min persists, replace the module.
battery volts
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30826 module battery volts  persists, replace the module.
not set
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30827 module predict persists, replace the module.
algorithm is not set
Temperature not functional. The temperature Internal malfunction. If the problem Very low
30828 module ambient temp  persists, replace the module.
is not set
Temperature not functional. The temperature Probe malfunction. Replace probe. If the ~ Very low
30829 module has a non- problem persists, replace the module.
responsive probe. The
thermistor has pulled
away from the tip or
the heater is broken.
Temperature not functional. The temperature Probe malfunction. Replace probe. If the ~ Very low
3082A module is experiencing problem persists, replace the module.
bad probe gain
Temperature not functional. The temperature Probe malfunction. Replace probe. If the ~ Very low
3082B module has a bad probe problem persists, replace the module.
response value
Temperature not functional. The temperature Internal malfunction. If the problem Very low
03C800 module is not persists, replace the module.
functional
Temperature not functional. Unable to deserialize  Internal malfunction. If the problem Very low
03C900 messages from the persists, replace the module.
temperature module
Temperature not functional. Unsupported message  Internal malfunction. If the problem Very low

03CA00

received from the
Temperature module

persists, replace the module.
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Braun 6000 messages

Message Possible cause Suggested action Alarm priority
Temperature not functional. Unable to send Internal malfunction. If the problem Very low
03CB00 message to the persists, replace the module.

Temperature module
Temperature not functional. Temperature module  Internal malfunction. If the problem Very low
03CC00 communication times  persists, replace the module.

out
Temperature not functional. Failed to upgrade the  Internal malfunction. If the problem Very low
03CD00 temperature module  persists, replace the module.
Temperature not functional. Unable to read PIM file Retry the device update. Very low
03CEQ0
Temperature not functional. Upgrade file directory  Retry the device update Very low
03CE01 could not be accessed
Direct mode reading timed out ~ None None Information
Tissue contact lost. Lost tissue contact Check the tissue contact and try the Information

while attempting to measurement again.

acquire a temperature

measurement or

acquired measurement

was performed with

limited tissue contact.
Temperature module reset. Temperature sensor None Very low
03D000 reset unexpectedly

Alarm

Message Possible cause Suggested action priority
Temperature not functional. WACP message CRC  Internal malfunction. If the problem Very low
3F0105 mismatch. persists, replace the module.
Temperature not functional. This message is not Internal malfunction. If the problem Very low
3F0201 implemented by the persists, replace the module.

module.
Temperature not functional. This message is not Internal malfunction. If the problem Very low
3F0202 supported by the persists, replace the module.

module.
Temperature not functional. The module has run out Internal malfunction. If the problem Very low
3F0203 of memory. persists, replace the module.
Temperature not functional. No parameter provided Internal malfunction. If the problem Very low
3F0204 for the specified persists, replace the module.

message.
Temperature not functional. The parameter provided Internal malfunction. If the problem Very low

3F0205

is invalid for the
specified message.

persists, replace the module.
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Message Possible cause Suggested action priority
Temperature not functional. The parameter provided Internal malfunction. If the problem Very low
3F0206 is outside of the persists, replace the module.

allowable range for the

specified message.
Temperature not functional. The message requires  Internal malfunction. If the problem Very low
3F0207 an object, but did not  persists, replace the module.

contain one.
Temperature not functional. The object provided Internal malfunction. If the problem Very low
3F0208 with the message could persists, replace the module.

not be deserialized.
Temperature not functional. The object could not be Internal malfunction. If the problem Very low
3F0209 serialized. persists, replace the module.
Temperature not functional. The message is Internal malfunction. If the problem Very low
3F020A performing a request/  persists, replace the module.

action when the

module state prohibits

the request/action.
Temperature not functional. The requested item is  Internal malfunction. If the problem Very low
3F020B not currently available  persists, replace the module.

due to the module

state.
Temperature not functional. The factory settings,  Internal malfunction. If the problem Very low
3F0503 and calibration persists, replace the module.

information is corrupt.
Temperature not functional. The user settings are  Internal malfunction. If the problem Very low
3F0504 corrupt. persists, replace the module.
Temperature not functional. The calibration is not  Internal malfunction. If the problem Very low
3F0509 set. persists, replace the module.
Temperature not functional. The error log is corrupt. Internal malfunction. If the problem Very low
3F050C persists, replace the module.
Temperature not functional. A hardware Internal malfunction. If the problem Very low
3F0516 malfunction has been  persists, replace the module.

detected
Temperature not functional. The module power rail  Internal malfunction. If the problem Very low
3F0518 is too low. persists, replace the module.
Temperature not functional. The module power rail  Internal malfunction. If the problem Very low
3F0519 is too high. persists, replace the module.
Temperature not functional. The reference voltage  Internal malfunction. If the problem Very low
3F051A circuit was detected to  persists, replace the module.

be under voltage or

unstable.
Temperature not functional. The ambient Verify conditions are less than 104°For  Very low

3F0821

temperature is too high

40°C. If conditions are valid and the
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Alarm
Message Possible cause Suggested action priority
problem persists, replace the probe. If the
problem still persists, replace the module.
Temperature not functional. The ambient Verify conditions are greater than 50°F or  Very low
3F0822 temperature is too low 10°C. If conditions are valid and problem
persists, replace the probe. If the problem
still persists, replace the module.
Temperature not functional. The battery is over the  Internal malfunction. If the problem Very low
3F0824 maximum voltage persists, replace the module.
Temperature not functional. The sensor not Internal malfunction. If the problem Very low
3F0833 functional persists, replace the module.
Temperature not functional. Low battery Recharge the battery. If the problem Very low
3FOE04 persists, check the battery.
Unable to detect new No temperature If a measurement should have been Information
temperature. Retry measurement. measurement was available, retry the measurement. If
available from the problem the persists, replace the module.
thermometer at the
time it was docked.
Thermometer might be docked ~ Communication failure  The thermometer might be docked Information
improperly. Check contacts and  with docked Braun improperly. Check contacts and
connections. connections. If problem the persists,
replace the module.
Temperature not functional. Unrecognized WACP Internal malfunction. If the problem Very low
3FFFO1 parameter received persists, replace the module.
from sensor
Temperature not functional. Timeout waiting for Internal malfunction. If the problem Very low
3FFF02 Sensor response persists, replace the module.
Temperature not functional. Error deserializing Internal malfunction. If the problem Very low
3FFFO3 WACP message persists, replace the module.
received from sensor
Temperature not functional. WACP stack send Internal malfunction. If the problem Very low
3FFF04 message failure persists, replace the module.
Re-dock Braun. 3FFF05 Anti-theft timer expired Re-dock the thermometer after takinga ~ Very low
measurement.
Patient and clinician data messages
Alarm
Message Possible cause Suggested action priority
Unable to identify Clinician authentication failure Information status message; press OK button Information

clinician. No provider
configured at host.

to dismiss.
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Alarm

Message Possible cause Suggested action priority
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. Security to dismiss.
provider error.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. User not to dismiss.
found.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. Invalid ID or to dismiss.
system password.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. Account to dismiss.
disabled/expired.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. Password to dismiss.
expired/reset required.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. Group to dismiss.
membership error.
Unable to identify Clinician authentication failure Information status message; press OK button Information
clinician. to dismiss.
Touch Clear to delete all
data.
Unable to identify Patient authentication failure Information status message; press OK button Information
patient. to dismiss.
Touch Clear to delete all
data.
Database schema out of The database was cleared due to  Information status message; press OK button Information
data; recreating. a schema update to dismiss.
Database is unreadable The database was unreadable Press OK button to dismiss. Very low
during startup; during startup
recreating. 1F0001
Error accessing PDM Database corrupted when device  Press OK button to dismiss. Very low
database; restarting is in operation
PDM. 1F0002
Maximum number of Data was deleted as it contained Information status message; press OK button Information
patient records + Oldest more than 400 records to dismiss.
record overwritten.
No data saved. A manual save is not allowed Information status message; press OK button Information

to dismiss.
Save successful. A manual record was saved Information status message; press OK button Information

to dismiss.
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Alarm
Message Possible cause Suggested action priority
Patient ID requiredto A Patient ID is required to save ~ Information status message; press OK button Information
save data. data to dismiss.
Patient ID required to A Patient ID is required to start ~ Information status message; press OK button Information
start intervals. intervals to dismiss.
Clinician ID required to A Clinician ID is required to save  Information status message; press OK button Information
save data. data to dismiss.
Clinician ID required to A Clinician ID is required to start ~ Information status message; press OK button Information
start intervals. intervals to dismiss.
Patient ID required to A Patient ID match is required to ~ Information status message; press OK button Information
save data. save data to dismiss.
Patient ID required to A Patient ID match is required to  Information status message; press OK button Information
start intervals. start intervals to dismiss.
Clinician D required to A Clinician ID match is required to Information status message; press OK button Information
save data. save data to dismiss.
Clinician ID required to A Clinician ID match is required to Information status message; press OK button Information
start intervals. start intervals to dismiss.
Unable to auto save. The device was unable to auto Information status message; press OK button Information
save to dismiss.
Barcode scan not Barcode Scanning is not available Information status message, press OK button Information
accepted. to dismiss.
Invalid NIBP interval ~ An invalid interval parameter was Information status message; press OK button Information
parameter during detected. to dismiss.
interval capture.
Save successful. The auto save is successful in Information status message; press OK button Information
Office Profile to dismiss.
Unsent records: N of M There are unsent records waiting  Information status message; press OK button Information
when the device is powered down to dismiss.
Barcode scanning is not  Barcode scanning is not available. Information status message; press OK button Information
available. Enter patient  Enter patient information to dismiss.
information manually. ~ manually.
Invalid Sp02 interval An invalid interval parameter was If Sp02 intervals are enabled and Sp02 clip  Information

parameter during
interval capture.

detected.

was removed, either stop the intervals or
reattach the Sp02 clip. Information status
message; press OK button to dismiss.
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Message

Possible cause

Suggested action

Alarm
priority

Radio not functional.

350001

Deserialization failure. There is a
software communication issue
between the host and the radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350002

Permissions. There is an internal
software error on the radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350003

Unsupported operating system.
There is an internal software error

on the radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350004

Unknown. There is an internal
software error on the radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350006

Invalid authentication. There is an
internal software error on the

radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350008

Unknown SDC Error. There is an
internal software error on the

radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350009

Invalid SDC configuration. There is
an internal software error on the

radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

35000a

Invalid SDC profile. There is an
internal software error on the

radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Invalid radio
configuration.
Reconfigure and try
again. 35000b

Invalid SDC WEP type. There is an
internal software error on the
monitor. Attempt to configure
settings that don't apply in current
authentication mode on radio

Check the radio configuration. If the
problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.

Very low

Invalid radio
configuration.
Reconfigure and try
again. 35000c

Invalid SDC EAP type. There is an
internal software error on the
monitor: attempt to configure
settings that don't apply in current
authentication mode on radio

Check the radio configuration. If the
problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.

Very low

Invalid radio
configuration.
Reconfigure and try
again. 35000d

Invalid SDC parameter. The Laird
SDK rejects a parameter being

configured.

Check the radio configuration. If the
problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.

Very low

Radio not functional.

35000e

Unrecognized. There is a version
compatibility error if the radio or
the monitor adds new features
and software upgrade of the radio
fails after the monitor successfully

updates

Check for a software update and apply it.
If still present, replace the radio.

Very low
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Alarm

Message Possible cause Suggested action priority
Radio not functional. No statistics file. There is an Check for a software update and apply it. Very low
35000f internal software error on the If still present, replace the radio.

radio indicating a Linux kernel

error
Radio not functional. Missing interface. There is an Check for a software update and apply it. Very low
350010 internal software error on the If still present, replace the radio.

radio indicating a Linux kernel

error or failure to initialize the

network interface
Radio not functional. Unknown interface. There is a Check for a software update and apply it. Very low
350011 software communication issue If still present, replace the radio.

between the host and the radio
Invalid radio Invalid WEP key length. WEP keys Check the radio configuration. If the Very low
configuration. should be 10 or 26 characters problem is still present, reset the radio to
Reconfigure and try long. factory defaults. If the problem persists,
again. 350012 check for software update and apply it. If

still present, replace the radio.

Invalid radio Not in EAP mode. There is an Check the radio configuration. If the Very low
configuration. internal software error on the problem is still present, reset the radio to
Reconfigure and try monitor: attempt to configure factory defaults. If the problem persists,
again. 350013 settings that don't apply in current check for software update and apply it. If

authentication mode on radio still present, replace the radio.
Invalid radio Invalid inner EAP method. There is Check the radio configuration. If the Very low
configuration. an internal software error on the  problem is still present, reset the radio to
Reconfigure and try monitor: attempt to configure factory defaults. If the problem persists,
again. 350014 settings that don't apply in current check for software update and apply it. If

authentication mode on radio still present, replace the radio.
Radio not functional. Out of memory. There is an Check for a software update and apply it. Very low
350015 internal software error on the If still present, replace the radio.

radio
Radio not functional. Invalid log level. There is a Check for a software update and apply it. Very low
350016 software communication issue on  If still present, replace the radio.

the radio
Radio not functional. Certificate path too long. There is  Check for a software update and apply it. Very low
350017 an internal software error on the  If still present, replace the radio.

radio. The radio has a fixed path

length
Invalid radio Missing client certificate. The Check the radio configuration. If the Very low
configuration. radio attempted to configure for  problem is still present, reset the radio to
Reconfigure and try an EAP mode that requires a client factory defaults. If the problem persists,
again. 350018 certificate and no certificate is check for software update and apply it. If

installed still present, replace the radio.
Invalid radio Missing CA certification. The radio Check the radio configuration. If the Very low

configuration.
Reconfigure and try
again. 350019

attempted to enable server
validation and CA certification is
missing

problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.
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Message

Possible cause

Suggested action

Alarm
priority

Radio not functional.

35001e

MAC request failed. There is an
internal software error on the
radio indicating a Linux kernel
error or a failure to initialize the
network interface

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

35001f

Invalid power mode. There is an
internal software error on the
radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350020

Post results missing. There is an
internal software error on the
radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350021

Post results format. There is an
internal software error on the
radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350025

Unrecognized component. There is
a version compatibility error if the
radio or the monitor adds new
features and software upgrade of
the radio fails after the monitor
successfully updates

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350027

Missing release file. There is an
internal software error on the
radio with a missing file

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

350028

Not ready. Displays when logging
verbosity is turned on

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

Disconnected. There is a software

Check for a software update and apply it.

Very low

350029 communication issue between the If still present, replace the radio.
host and the radio. Socket
connection is down
Invalid radio Invalid parameter. There is a Check the radio configuration. If the Very low

configuration.
Reconfigure and try
again. 35002a

software issue on the monitor
while trying to configure radio

problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.

Radio not functional.

35002b

Timeout. There is a software
communication issue between the
host and the radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.

35002c

The device cannot communicate
with the radio through the internal
radio IP address

Navigate to Advanced Settings >
Service > Radio Status. Approximately
3-4 minutes after the error code appears,
a Mac Address text field appears on this
tab. Communicate with Welch Allyn for
assistance in entering the correct Mac
address.

If still present, replace the radio card.

Very low
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Message

Possible cause

Alarm

Suggested action priority

Radio not functional.

35002e

Cannot parse DHCP lease. There is
an internal software error on the
radio (error reading and converting
DHCP lease file)

Check for a software update and apply it. Very low
If still present, replace the radio.

Invalid radio
configuration.
Reconfigure and try
again. 350032

Invalid certificate password. The
radio is misconfigured with a
password that does not match the
certificate.

Check WAST certificate files, generate a Very low
new .pim file using the correct password

for the client.p12 file, and reload the

certificate. If the problem persists,

generate a new client.p12 file using your

preferred certificate creation method.

Using the WAST, generate a new .pim

file and reload the certificate.

Radio not functional.

350033

Serialization failure. There is an
internal software error on the
radio or the monitor

Check for a software update and apply it. Very low
If still present, replace the radio.

Radio not functional. Missing PAC file. There is a Check the radio configuration. If the Very low
350034 misconfiguration of the radio problem is still present, reset the radio to
(configured for EAP-FAST and factory defaults. If the problem persists,
manual PAC but none supplied)  check for software update and apply it. If
still present, replace the radio.
Invalid radio Invalid PAC file password. There is Check the radio configuration. If the Very low

configuration.
Reconfigure and try
again. 350035

a misconfiguration of the radio
(configured for EAP-FAST and
manual PAC but password for PAC
is incorrect)

problem is still present, reset the radio to
factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.

Radio not functional.

350036

Invalid BSSID format. There was
an internal software error on the
radio (related to AP scan feature,
may not occur with current Laird
software)

Check for a software update and apply it. Very low
If still present, replace the radio.

Radio not functional. Unknown certificate ID. There is ~ Check the radio configuration. If the Very low
350037 an internal software error on the  problem is still present, reload the
monitor: attempt to query a certificate. If the problem is still present,
certificate status for a certificate  reset the radio to factory defaults. If the
that does not exist problem persists, check for software
update and apply it. If still present,
replace the radio.
Radio not functional. Certificate information absent. Check the radio configuration. If the Very low
350038 The device queries certificate problem is still present, reset the radio to
status for a certificate that isn't  factory defaults. If the problem persists,
installed on the radio. check for software update and apply it. If
still present, replace the radio.
Radio not functional. Invalid sequence number. The Check the radio configuration. If the Very low
350039 device queries certificate status  problem is still present, reset the radio to
fragment that does not exist. factory defaults. If the problem persists,
check for software update and apply it. If
still present, replace the radio.
Invalid radio CCKM not allowed. There is an Check the radio configuration. If the Very low

configuration.

attempt to use CCKM when not in

problem is still present, reset the radio to
factory defaults. If the problem persists,
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Message

Possible cause

Suggested action

Alarm
priority

Reconfigure and try
again. 35003c

\WPA-Personal or WPA2-

Enterprise modes

check for software update and apply it. If
still present, replace the radio.

Radio not functional.
35003d

Send failure. The radio failed to
send a message to the host

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.
35003e

Unable to store global

configuration settings to the

backup file

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.
35003f

Configuration hookup. There is an
internal software error on the

radio

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.
350041

Unable to configure DHCP 60 on

the radio

Check the radio configuration. If the
problem is still present, reset the radio to

factory defaults. If the problem persists,

check for software update and apply it. If
still present, replace the radio.

Very low

Radio not functional.
350042

DHCP option corrupt. The DHCP
option file is not in the expected

format

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.
350043

Cannot delete file. There is an
internal software error on the
radio (occurs for Option 60 upload

and factory default)

Check for a software update and apply it.
If still present, replace the radio.

Very low

Radio not functional.
350046

Invalid SDC value. There is a
software issue on the when trying

to configure the radio.

Check for a software update and apply it.
If still present, replace the radio.

Very low

Unable to establish
network

communications. Radio

out of network range.
350100

No IP address after 30 seconds.

Unable to associate.

Check ESSID and radio mode settings.

Very low

Invalid radio
configuration.
Reconfigure and try
again. 350200

No IP address after 30 seconds.
Unable to authenticate

Check radio security settings.

Very low

Radio card DHCP
timeout. 350300

No IP address after 30 seconds.
Unable to obtain DHCP address.

Check DHCP server settings.

Very low

Lost network

communications. Radio

out of network range.
350400

Radio lost association

Ensure the access point is still powered
on and in range.

Very low

Radio not functional.
350500

POST failure

Power cycle the device and re-enable the
radio. If the problem persists, replace the
radio.

Very low

Radio software upgrade The radio software upgrade failed. Restart the monitor.

failed. 350600

Information




194 Appendix

Connex® Spot Monitor

Connectivity messages

Alarm
Message Possible cause Suggested action priority
Certificate load The radio customer certificate was None. Information
successful. successfully loaded from the host
Certificate load failed. ~ The radio customer certificate was Try again. Information
not loaded

Alarm
Message Possible cause Suggested action priority
Unable to obtain wired  No wired connection Verify DHCP functionality and configuration. ~ Very low
device IP address.
210000
Network not found; Lost ethernet DHCP address Check wired connection into device then Very low
check network cable verifiy DHCP functionality and configuration.
connection. 210100
Unable to communicate Cannot communicate with NRS  Verfiy NRS IP configuration and functionality. Very low
with NRS. 360000
Communication error ~ Communication timeout failure  Verify the external host services are loaded ~ Very low
with host. 1A0000 with external Host and started on the server. If the problem

persists, check for available software
upgrades of the monitor or the system.

Data rejected. CRC The WACP stack has detecteda  Check the data and try again. If the problem  Very low
mismatch. TA0001 CRC mismatch in the message persists, contact your system administrator.
Data rejected. External Host NACK - The host Check the monitor and try again. If the Very low
Unsupported message.  does not support the message/  problem persists, contact your system
1A0002 object. administrator.
Data rejected. Invalid ~ The message has an invalid Check the data and try again. If the problem  Very low
parameter. 1A0003 parameter. persists, contact your system administrator.
Data rejected. The monitor failed to deserialize  Check the data and try again. If the problem  Very low
Deserialize the object.  the object. persists, contact your system administrator.
1A0004
Data rejected. The host is in a state that cannot ~ Check the data and try again. If the problem  Very low
Unsupported message.  accept the message. persists, contact your system administrator.
1A0005
Data rejected. Patient ID The message has a missing Add the patient ID to the record. Very low
required. TA0006 patient ID
Data rejected. Clinician  The message is missing a clinician Add the clinician ID to the record. Very low
ID required. 1A0007 ID
Data rejected. Time The message has a mismatched  Ensure that the clock on the monitor and the ~ Very low

mismatch. TA0008

time

server match.
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Alarm
Message Possible cause Suggested action priority
Unable to establish No network connection is Connect the device to an active network so  Very low
network available that the clinician ID can be imported.
communications.
1A0009
No connection for send. No connection for send. None Information
Send not successful. Send not successful. None Information
Error in record. Try again Connectivity NACK recieved for ~ NRS/ECS/CS/NCE NACK that is record Information

System messages

NRS/ECS/CS/NCE specific and can be fixed by a clinician in the
next record

Send successful. Data was successfuly sent over ~ None Information

USB/BT

Alarm

Message Possible cause Suggested action priority
000001 System failure Restart the monitor N/A
000002 System failure Restart the monitor N/A
000003 System failure Restart the monitor N/A
000004 System failure Restart the monitor N/A
000005 System failure Restart the monitor N/A
000006 System failure Restart the monitor N/A
Internal hardware The kernel image is corrupt, Replace the main PCBA. N/A

failure.

restart not possible

Internal hardware
failure.

The root file system is corrupted,
restart not possible

Restart the monitor. If the problem persists, N/A

replace the main PCBA.

Internal hardware
failure. 140100

EEPROM access failed. The device

boot is possible, but wired
communications are disabled

Reprogram the EEPROM. If the problem

persists replace the main PCBA.

Very low

Internal hardware
failure.

SPL memory test failure, the

monitor will sound an SOS pattern

Restart the monitor. If the problem persists, N/A

replace the main PCBA.

Internal hardware
failure. 1C1000

The monitor PIC communications
never starts or quits. The
communication won't reasonably
recover at startup or during
operation

Restart the monitor. If the problem persists, N/A

replace the main PCBA.
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Alarm
Message Possible cause Suggested action priority
Low battery 30 minutes  The battery power is low Connect the power supply to AC powerto  Very low
or less remaining. charge the monitor.
1C1005
Low battery 5 minutes  The battery power is extremely ~ Connect the power supply to AC powerto  High
or less remaining. low charge the monitor.
1C1006
Battery is critically low; The battery power is critically low Connect the power supply to AC power to ~ High
plug into outlet. Device charge the monitor.
is shutting down.
1C1007
Update unsuccessful.  The software update failed Restart the monitor. If the problem is still ~ Very low
Reboot and retry. present, replace the main PCBA.
1C1008
Host battery not The host battery is not charging  Restart the monitor. If the problem is still ~ Very low
charging. 1C100A present, check cable connections. If the

problem is still present, perform functional
checks for host. If the problem is still
present, replace battery. If the problem
persists, replace the main PCBA.

Factory default settings  The factory configuration settings The monitor has been configured to factory Very low

now active. 3A0001 are active defaults, any user settings have been reset.

Unable to read Unable to load file from the Retry the USB connection. If the problem is  Very low
configuration from USB. external USB memory device. still present, check for a proper format of

3A0002 the USB drive. If the problem is still

present, replace the USB device. If the
problem persists, replace the main PCBA.

Internal hardware Power supply issue. The PMIC is  Check the operating environment Very low
failure. Device will shut too hot temperature. Allow the monitor to cool
down. 1C100D down before operating again. If the problem

is still present, check the cable connections.
If the problem is still present, perform
functional checks for host. If the problem is
still present, replace the battery. If the
problem is still present, replace the main

PCBA.
Input voltage too low.  Power supply issue. The PMIC Check the operating environment Very low
Device will shut down.  input voltage is too low temperature. Allow the monitor to cool
1C100C down before operating again. If the problem

is still present, check the cable connections.
If the problem is still present, perform
functional checks for host. If the problem is
still present, replace the battery. If the
problem is still present, replace the main

PCBA.
Unexpected restart The monitor unexpectedly Continue normal operation High
occurred. 161012 restarted
Audio system not The speaker or audio codec is Replace speaker. If the problem is still Very low

functional 1D0100 faulty present, replace the main PCBA.
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Alarm
Message Possible cause Suggested action priority
CSM battery is not There is no battery in the monitor  Check the monitor for a battery and install ~ Very low
installed. 1C100E one if it is missing. If the problem is still
present, perform diagnostic checks on the
monitor. If the problem persists, replace the
main PCBA.
Device shutdown is not ~ System shutdown failure Monitor cannot perform an immediate Information
available at this time shutdown. Disconnect AC power and
remove battery.
No valid files found No valid files were found on the  Re-insert the USB flash drive with valid Information
USB flash drive files.
Firmware update The software successfully updated Information status message; press 0K Information
successful. button to dismiss.
Audio alarms are off. ~ The monitor alarm audio is off Information status message; press OK Information
button to dismiss.
Advanced settings The advanced settings are Confirm that no sensors are attached to the Information
unavailable. unavailable because the monitor  monitor, no alarms are active, and there is
is notin an idle state no unsaved data in the Spot or Intervals
profile.
USB accessory The USB device was disconnected Information status message; press 0K Information
disconnected. from the monitor button to dismiss
Advanced settings The Advanced settings code was  Information status message; Exit Advanced Information
entered correctly settings to dismiss.
Save not successful. The device configuration or logs  Information status message; press 0K Information
were not saved to the USB device button to dismiss
Save successful. The device configuration or logs  Information status message; press OK Information
were saved to the USB device button to dismiss
Software upgrade is The monitor is downloading a Information status message; press 0K Information
downloading. Do not software update button to dismiss
shutdown.
Factory reset successful. The monitor was reset to factory  Information status message; press OK Information
settings button to dismiss
Factory reset failed. The monitor factory reset has Information status message; Exit Advanced Information
Custom configuration  failed. settings to dismiss.
file not deleted.
Configuration upload The device configuration has Information status message; press OK Information
successful. successfully uploaded button to dismiss
Unable to load The device configuration was not  Information status message; Exit Advanced Information

configuration; using
factory defaults.

successfully uploaded

settings to dismiss.
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Software update messages

Alarm
Message Possible cause Suggested action priority
Software Update: The manifest file transfer timed  Verify the connection and retry. Information
Manifest transfer timed out or connection was lost during
out. Verify connection  download
and retry.
Software Update: The package file transfer timed ~ Verify the connection and retry. Information
Package file transfer out or connection was lost during
timed out. Verify download
connection and retry
Software Update: There was an invalid token file Verify and update the token file. Information
Invalid token file.
Software Update: The manifest file was not found  Verify the manifest file is on the server. Information
Unable to find manifest on the server
file on server.
Software Update: The manifest file signature Regenerate the software package and retry. Information
Unable to verify verification failed.
manifest file signature.
Software Update: The package file is corrupt, does  Regenerate the software package and retry. Information
Package file corrupted.  not have expected SHA256 hash
Regenerate package and
retry.
Software Update: The package file cannot be found  Verify the package file is on the server. Information
Unable to find package
file.
Software Update: At least one of the sub systems  Restart the monitor. Information
Installation failed. failed to install
Reboot and retry.
Software Update: The partition is running out of Free up adequate space needed to perform Information
Upgrade unsuccessful.  space the upgrade.
Insufficient disk space.
Software Update: The current firmware versionis  Try to update to an earlier software Information
Update unsuccessful.  lower than the one required by the package.
Incompatible firmware.  token file
Software Update: SWUP SWUP NIBP is not functional Information status message; click OK button Information
internal error to dismiss.
Software Update: The Software Update manager is  Information status message; click OK button Information
Manager internal error  not functional to dismiss.
Radio software upgrade The radio software was not Check for software update and apply it. If ~ Very low

failed. 350600 upgraded. message is still present, replace the radio.
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Alarm
Message Possible cause Suggested action priority
Bluetooth connection  The monitor failed to connect to  Verify a successful pairing of the device ~ Very low

failure. 370201

the Bluetooth device.

with the PC. If the problem is still present,
verify the EMR and the patient window are
running. If the problem is still present,
verify the Bluetooth device signal strength.
If the problem is still present, verify the PC
hardware and configuration. If the problem
is still present, verify the Bluetooth device
hardware.

Bluetooth not functional.

370001

The monitor detected a Bluetooth
device that is not functional

Reboot the monitor. If the problem persists, Very low
replace the Bluetooth radio. If the problem
persists, replace the main PCBA.

Bluetooth not functional.

370002

The monitor cannot detect a
Bluetooth module

Replace the Bluetooth radio. If the problem Very low
persists, replace the main PCBA.

N/A

The Bluetooth device failed to pair
with the monitor.

Verify a successful pairing between the
device and the PC. If the problem is still
present, verify the Bluetooth signal
strength. If the problem persists, verify
authentication code, verify the computer
hardware and configuration. If the problem
persists, verify if the computer has prior
pairing information for the monitor.

Very low

N/A

The Bluetooth device failed to pair
with the monitor.

Version of stack on the PC does not support Very low
simple secure pairing. The device requires
2.1+EDR Bluetooth stack on the host PC.

Bluetooth device The Bluetooth device connected ~ None. Information
connection successful
N/A The Bluetooth device did not BT device connection dropped due to N/A
connect with the monitor distance, application crash on host end.
OR
RF connection not possible
OR
RF connection possible, but cannot find
device
OR
BT connection was established, but WACP
connection not possible
Bluetooth device The Bluetooth disconnected None. Information

disconnected
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APM messages

Alarm
Message Possible cause Suggested action priority
APM not functional. The APM is detected as connected Restart the monitor and the APM. If the Very low
1C1001 but there is no communication problem is still present, check the cable
through the APM serial port connections from the monitor to APM. If the
problem still present, replace the APM. If the
message persists, replace the main PCBA on
the monitor.
APM not functional. The APM battery is installed, but  Perform diagnostic checks on the monitor. If ~ Very low
1C100B does not communicate with the  the problem is still present, replace the APM
monitor battery. If the problem still present, replace

the APM. If the message persists, replace
the main PCBA on the monitor.

APM battery is absent  The APM battery is not installed  Ensure than an APM battery is installed, and Very low
or faulty. 1C100F install one if it is missing. If the problem is

still present, perform diagnostic checks on

the monitor. If the problem is still present,

replace the APM. If the message persists,

replace the main PCBA on the monitor.

The APM is The APM is unplugged from the ~ Restart the monitor and the APM. If the Very low
disconnected. 1C1002  monitor while the monitor is problem is still present, check the cable
powered on connections from the monitor to APM. If the

problem still present, replace the APM. If the
message persists, replace the main PCBA on

the monitor.
USB cable is The APM USB hub is unplugged  Restart the monitor and the APM. If the Very low
disconnected. 11003 from the monitor while the problem is still present, check the cable
monitor is powered on connections from the monitor to APM. If the

problem still present, replace the APM. If the
message persists, replace the main PCBA on
the monitor.

APM is plugged in. The APM was plugged in while  Restart the monitor and the APM. If the Information
the monitor is powered on. problem is still present, check the cable
connections from the monitor to APM. If the
problem still present, replace the APM. If the
message persists, replace the main PCBA on
the monitor.

APM not functional. The APM USB hub is plugged in  Restart the monitor and the APM. If the Very low
1C1010 while the monitor communication  problem is still present, check the cable
cable is disconnected connections from the monitor to APM. If the
problem still present, replace the APM. If the
message persists, replace the main PCBA on

the monitor.
APM not functional. The APM PIC cannot communicate Restart the monitor and the APM. If the Very low
1C1004 with the accelerometer problem is still present, check the cable

connections from the monitor to APM. If the
problem still present, replace APM. If the
message persists, replace the main PCBA on
the monitor.

APM not functional. The APM PIC software update and Restart the monitor and the APM. If the Very low
1C1009 any retries have failed problem is still present, check the cable
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Message Possible cause

Alarm

Suggested action priority

connections from the monitor to APM. If the
problem still present, retry the software
update. If still present, replace the APM. If
the message persists, replace the main PCBA
on the monitor.

APM not functional.
1C100B

The APM battery is not recharging

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If the
problem still present, replace the APM. If the
message persists, replace the main PCBA on
the monitor.

Very low

APM not functional. The APM USB changes from
unplugged to plugged after

monitor startup

Restart the monitor and the APM. If the Information
problem is still present, check the cable

connections from the monitor to APM. If the

problem still present, retry the software

update. If still present, replace the APM. If

the message persists, replace the main PCBA

on the monitor.

Device is operating in
battery mode.

AC power cord has been
disconnected.

Information status message; press OK button Information
to dismiss.

Sleep mode is Sleep mode is not allowed when  Stop any active intervals. Information
unavailable. Intervals intervals are in progress

monitoring is in

progress.

Sleep mode is Sleep mode is not allowed when  Clear all active alarms. Information
unavailable. An alarm is alarms are active

active.

Display lock is Lockout is not allowed without Enter patient information Information
unavailable. Missing active patient information

patient context.

Power cable is The APM communication cable is  Restart the monitor and the APM. If the Very low

disconnected. 101011 plugged in while the APM USB

cable is disconnected

problem is still present, check the cable
connections from the monitor to APM. If the
problem still present, retry the software
update. If still present, replace the APM. If
the message persists, replace the main PCBA
on the monitor.

|dentifying the monitor and subsystems

This explanation of the monitor labeling is provided to assist you in identifying these
particular parts by serial number. The part numbers appearing on the labels are internal
part numbers and will not be found in the list of field replaceable units (FRUs) included in

this manual.

Future revisions of a part may not always be backward compatible with a legacy part. To
determine the correct replacement part for your unit always provide the serial number

and model when ordering.
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Monitor serial number and model label

Connex® Spot Monitor

The model number and serial number can be found on a label on the back housing.

O«

éﬂﬂﬂﬂﬂﬂﬂ;

- ="

Serial number and format code

Serial number

MMMMXXXXWWYY

MMMM Manufacturing plant
XXXX Sequential number
Ww Week of manufacture
YY Year of manufacture

Monitor circuit board and internal options label

Circuit board and internal option labels

PCBA identifier XXXXXX BOM Y DWG Z

XXXXXX Welch Allyn material number

Y Bill of material (BOM) revision

VA Assembly drawing version from current version of drawing

Circuit board and internal option labels

Serial number

XXXXWWYYID

XXXX Sequential number
Ww Week of manufacture
YY Year of manufacture

D Unique vendor identifier
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Note For more configuration options, including approved accessories, see the
accessories list in the Directions for use on the user documentation CD or
http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-
signs-devices/connex-spot-monitor/documents.html.

Note If options have been added to the device, the actual configuration will not

match the model description.

The device is available in multiple configurations. Use the following table to determine
available 7100, 7300, 7400, and 7500 model configurations. Model numbers include one

item from each column
Example: 75CE-B (North America)
Example: 71XE-4 (United Kingdom)

Model Parameter Power cord
Sp02 Temperature
71 =7100 Value series W =Welch Allyn / Nonin ~ E = Braun ThermoScan PRO A = Denmark
X =Blank / None 6000 IR B = North America
T = SureTemp Plus C = China
X =Blank / None G = Argentina
) . K = South Korea
73 =7300 BlueTooth series €= Covidien / Nellcor E = Braun ThermoScan PRO .
M =Masimo P = Thailand
W = Welch Allyn / Nonin T = SureTemp Plus T
X = Blank / None X =Blank / None
Y = Italy
- . Z = Brazil
4= 7400 WiFi-ready C = Covidien / Nellcor E = Braun ThermoScan PRO
series M = Masimo 6000 IR 2= Europe
3 =Israel

75 = 7400 WiFi series C = Covidien / Nellcor
M = Masimo

W = Welch Allyn / Nonin

T = SureTemp Plus
X =Blank / None

E = Braun ThermoScan PRO
6000 IR

T = SureTemp Plus
X =Blank / None

4 = United Kingdom

5 = Switzerland

6 = Australia/New Zealand
7 =South Africa

4S = Singapore



http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/documents.html
http://www.welchallyn.com/en/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/documents.html
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Interconnect diagram
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Connex® Spot Monitor

The following is the listing of tools and test equipment required to perform basic
functional verification checks, full functional verification checks and calibration, and
service and maintenance on the Welch Allyn Connex Spot Monitor. Please refer to the

device service manual for detailed instructions to service your device.

Note Tools and test equipment must also be readily available to complete Welch

Allyn Technical Service Training for this device.

Usage

Material no. Description Qty Full Basic
General test equipment
106270 Service test box 1 X
106275 Micro USB cable 1 X
N/A Wireless router, a/b/g or equivalent 1 X
N/A Ethernet cable 1 X
N/A PC running Windows XP SP3, Windows 7, or Windows 8 1 X X
web download  Welch Allyn Service Tool 1 X X
1001120 Welch Allyn Service Tool, Gold license 1 X
NIBP testing
407672 BP test volume repair fixture 113670 1 X X
N/A Pressure meter (must include at least two decimal points and be 1 X X

accurate to within £0.5 mmHg)
N/A Blood pressure Y-tube 1 X X
6000-30 Single tube blood pressure hose, 5 feet 1 X X
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Usage
Material no. Description Qty Full Basic
4500-30 Blood pressure hose, 5 ft. 1 X
620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 X X
Sp02 configuration testing
N/A Sp02 simulator 1 X X
DOC-10 Nellcor Sp02 extension cable 1 X X
SureTemp Plus configuration testing
06138-000 Cal-key, assembly, M630/692 1 X X

01802-110 Tester, calibration, 9600 Plus 3 X

Braun ThermoScan PRO 6000 configuration testing

01802-110 Tester, calibration, 9600 Plus 3 X

Notes:

e Allitems marked "N/A" in the Material no. column are OEM or off-the-shelf tools and equipment not available from
Welch Allyn. The remaining items are available through Welch Allyn or a Welch Allyn distributor.

e All items marked in the Full column are required for full functional verification checks and calibration. The Welch
Allyn Service Tool software and an active Gold license is also required to perform these checks. The Gold license is
obtained upon successful completion of Welch Allyn Technical Service Training.

e Allitems marked in the Basic column are required for basic functional verification checks. The Welch Allyn Service
Tool software Standard unlicensed edition can be used to perform the NIBP checks and SWF upgrades/updates.

Miscellaneous Tools

e Phillips #1 screwdriver
e T-10 Torx screwdriver
e 3mm hex key
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Installed Welch Allyn
service component

Required outhound network
Domain name

IP address
Port

Service feature description

Welch Allyn Service Tool

(via Windows service called
WelchAllynRSDSGateway)

welchallynsolutions.com
IP: 209.202.167.28

HTTP/HTTPS port: 80/443

Inbound - Used by customers to receive
software/device firmware upgrades.
Outbound - Used by customers to send device
service information.

IP: 12.38.86.181
TCP port: 5094/5095

Used to activate the Service Tool and enable
device feature licenses.

(This IP address does NOT respond to "ping.")

Connex Server

(via Windows service called
WelchAllynRSDSGateway)

welchallynsolutions.com
IP: 209.202.167.28

HTTP/HTTPS port: 80/443

Inbound - Used by customers to receive
software/device firmware upgrades.
Outbound - Used by customers to send device
service information.

Teamviewer Host

IP: mutliple depending on geographic
location

Default TCP port: 80/443
(can be configured to use TCP port 5938)

Used by Welch Allyn Service personnel to
access a customer's machine (with customer's
consent/permission) to address device issues.

ConnexDashboard

(a Welch Allyn service
dashboard web portal)

https://connexdashboard.com
IP: 209.202.186.109

HTTP port: 443

Used by customers to view the status of their
devices and deploy firmware upgrades and
device configurations. The portal requires prior
account setup.

File outhound types

Jlog, .xml, .zip, .txt

File inbound types

tar.gz, tar, .seq, .wsf, .pim, .xml, *.txt,
* pdf
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